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What is Database Oasis? 

Database Oasis is a central storage place for information. This can be anything that you need to keep 
track of, such as personal information, financial information, family records, business records, etc.  

The nice thing about Database Oasis is that everything is stored in one central place. Rather than having 
multiple applications that are all geared to different types of information, Database Oasis gives you a 
blank page where you can define the information you want to store, and then keeps all of the pages 
you’ve created together so you can easily view different types of information side-by-side. 

This is all accomplished without requiring you to have any technical knowledge of databases. Our goal 
is to provide many of the same advantages that IT professionals have with their ability to design custom 
databases to people who have not had any technical training. 
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Professional Edition vs. Basic Edition 

Database Oasis comes in either a Professional Edition, or a Basic Edition. Database Oasis 
Professional Edition has all of the features of the Basic Edition, plus additional functionality that is 
geared toward business users. In addition to features such as relational databases, a report designer, 
and enhanced security, one notable difference is that the Basic Edition is a single user database. 
Professional Edition includes a network server that allows multiple users to access the same database 
from different workstations.  

Understanding Multi-User Environments 
If you want to have more than one person sharing information in Database Oasis, you need to have 
the data stored in a central location on your network that everyone can access. For example, you may 
have three computers that are able to talk to each other over a network.  

Database Oasis needs to be installed on all three computers, but the data only needs to be installed 
on one of them. The other two computers will be told to use the data on that first computer. The 
computer where the data is installed is called the server. The other computers are called clients. 

 

 

Prior to installing Database Oasis, you decide which computer will be your server and which will be 
the clients. When selecting the server, keep in mind that it needs to be accessible over the network to 
all of the client computers, and it should be a computer that is left on most of the time as the clients 
will not be able to access the data when the server is turned off.  

The first time you log into a client, you will tell it where the data resides. After that point, there are 
very few differences between using Database Oasis on the server versus client installations. 
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Database Basics 

Even though you don’t need any experience or knowledge of databases to use Database Oasis, 
understanding some simple terms will help when reading this documentation and the help files. 

Databases are just collections of related data. That data is stored in records. For example, if you’re 
creating an address book, each person’s name and address information would be a separate record. 

Note 

 This is an extremely simplified explanation of 
databases.  

Each piece of data in the record is stored in a field. Using the address book example, you might have one 
field to contain each person’s name, and another field to contain their phone numbers. There are 
different types of fields available in Database Oasis: 

• Text Fields This is the most common type of field. It can contain characters, numbers, and 
symbols such as @ # {}. 

• Numeric Fields These are similar to text fields, except that they are limited to only containing 
numbers.  

• Auto Incrementing This is a numeric field that automatically increases by one for each new 
record.  

• Notes Fields This is very similar to a text field, except that you can enter multiple lines of 
data. Where you would use a text field to store someone’s name, you might use a notes field to 
keep a record of every time you talk to the person. 

• Date Fields This field type is used to store dates. A small calendar icon appears next to the 
field, allowing you to manually type in the date or select it from a popup calendar. 

• Check Boxes This field is displayed as a box:  and allows you to indicate a Yes or No 
answer to a question. A mark in the box means Yes. If the box is unmarked, it means No. 

• List Fields This lets you pre-configure a list of data entry options. When entering data in 
the field, you select from the list and the item is automatically filled into the field. 

• Picture Fields This is a placeholder for a graphic file. For example, if you’re storing 
information about your employees, you might put a picture of each person in his or her record. 

• Calculated Fields This is an advanced type of field. It lets you perform a calculation in a field 
instead of just displaying static data. For example, you might want to calculate sales tax on the 
value in a numeric field. 
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Displaying Data 
There are two common ways that data can be displayed. The most common is in a single record display. 
These displays are sometimes called forms, screens, or windows. In Database Oasis, we simply call 
them data displays: 

 

In the above example, all of the information you are looking at belongs to Mary Jones. If you click the 
right arrow button, you will scroll to the next record: 

 

In this example, Joe Smith’s information is now displayed. 
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The second way to view data is in a list view. This is a tabular view that shows each field as a column 
and each record as a row. For example: 

 

In the above example, the first row is a column heading row which describes the fields. The second row 
contains all of Mary Jones’ information. The third row contains all of Joe Smith’s information. This 
view allows you to see multiple records side-by-side. 

Relational Databases 

   Relational databases is an advanced feature that is only available in Database Oasis 
Professional Edition. 

Relational Databases are simply databases that contain tables that are linked together, or related, by a 
common value. They are used when multiple records share common information. The common data is 
stored in what is known as a “Parent” record and shared across one or more related “Child” records.  

This type of display is commonly used to track things like contacts at a company, purchases by a 
customer, visits by a patient, etc. 

In Database Oasis, the relationship is made by opening a display in the designer and adding a “child 
display” to it. This automatically ties that child display to its parent display.  

Note 

 In technical terms, Database Oasis uses what is 
known as a one-to-many relational database (i.e., one 
parent to many children). 
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Documentation Basics 

This file provides the documentation in a printable format. The same information is also available in the 
help files. You will probably find it easier to use the help file if you want to go directly to a specific 
topic for help on a particular area of the application.  

Throughout the documentation, if you need to press a key on your keyboard, the instructions will 
reference it by the name that appears on the key. For example, if you should press the escape key, you 
will be instructed to press Esc. If a key has a picture on it instead of a word, the key will be described. 

For example, the key that looks like this:  will be referred to as the right arrow key. Sometimes 
you will need to hold down two or more keys at the same time. In this case the key names will appear 
separated by a plus sign. Shift+End indicates that you should simultaneously hold down the Shift and 
End keys. 

If the documentation instructs you to click on something with your mouse, you should use the left mouse 
button unless specifically instructed to click with the right mouse button.  

If the documentation is referring to something on the screen by name, the item’s name will appear in a 
blue font. For example, a reference to the Work with Designer menu indicates that you should see the 
words “Work with Designer” on your screen. 

The documentation will generally provide a brief description of a feature, followed by step-by-step 
instructions on how to access and use the feature. Instructions will appear in this format: 

INSTRUCTION HEADING 

1 Step one of the instructions. 

2 Step two. 

3 Etc. 

Supplemental notes, warnings, and hints will appear in this format: 

Note 

 Note Text. 

The map pin icon:  indicates a general note. This is supplemental information you may find useful. 

The light bulb icon:  indicates a hint. This is a tip or trick that you might try.  

The lightning bolt icon:  indicates a warning. You should pay particular attention to this information. 
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This documentation covers both Database Oasis Professional Edition and Database Oasis Basic Edition. 
If a feature being discussed is only relevant to Professional Edition, you will see the following notation: 

   This feature is only applicable to Database Oasis Professional Edition. 

Windows® Basics 

If you’re not at all familiar with using software in the Windows operating system, you may find this 
section useful. It covers some basics such as using a mouse, the parts of a form, and some other 
Windows standards that may be referred to in the documentation. If you understand these basics, feel 
free to skip to the next chapter. 

Using Windows® Applications 
The Windows operating system opens each software application in a separate pane, or window. 
Generally, the window will contain a title bar and a menu bar above the main application work area. 

Title bar 
The title bar is the band at the top of a window or form that shows its name. It has buttons that let 
you minimize a window, control whether a window fills the full screen or can be sized (which 
toggles between the restore and maximize buttons), and close a window. 

 

When a window is maximized, it will be locked in its default maximum size. In Database Oasis, this 
means it will fill your monitor. You will not be able to move or change the size of the screen. If a 
window is maximized, you will see the restore button, as in the above illustration.  

Clicking the restore button will unlock the window and enable you to move and size it. To move the 
window, click on the title bar and drag the window. If the window is in this state, the restore button 

will be replaced with the maximize button: . Clicking maximize will return the window to the 
locked, full screen position. 

In addition to the main application title bar, every form that you open will have its own title bar.  

Note 

 These buttons may not be present on all forms. 
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Menu 
A menu is a list of options from which you may select. The menu bar is the area directly below the 
title bar. Each word on the menu bar is a menu pad. When you select a menu pad, a menu opens: 

 

The main application window has a menu, as do some forms within the application. For example, 
when you have a display open, you’ll find a second menu that provides options specific to the data in 
that display.  

Menus can also sometimes change in response to what you’re currently doing. For example, the 
Child Displays menu only appears on a display that has a child level. 

Form 
Forms are the screens where data is viewed and work is performed. Whenever you need to interact 
with the program, you will be presented with a form.  

The forms that you create in the display designer are referred to in the documentation and program 
as data displays or just displays. These displays allow you to view and modify your data. Since you 
design these, how they look is completely up to you. Any displays shown in the documentation are 
just examples of a possible display design and may or may not match any of your displays. 
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Other forms let you make selections before performing some action. For example, when you add a 
new data display, there’s a Display Properties screen that lets you select a name, background color, 
and a background wallpaper for the display: 

 

This type of screen will be referred to as screens or forms in the documentation. 

Most of the time when a form is open, other features of the application will be unavailable. You 
must close the current form in order to open another. There are some exceptions to this. For 
example, you can have more than one data display open at the same time. In this case, only one will 
be considered the active form. This is the form that gets affected when you type or otherwise interact 
with it. The active form will be in front of any other open forms. If you want to make a form the 
active form, simply click on it. 

As you work in a form, only one object at a time will be the currently active object. That object is 
said to have focus. The object with focus will be highlighted in some way, depending on the type of 
object. The highlight may be simply a cursor blinking in a field, or a highlight around a button. 

Some options on a form may be unavailable. This will occur if the option is not applicable at the 
current time. For example, the OK button in most forms will be unavailable until you have filled in 
the required data. In this case, the option will be dimmed with the text grayed out: 
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Following is a list of the objects you will encounter in forms: 

Field Names 

Field names tell you what to expect when you select an item or what information is contained in 
a field: 

 

Fields 

A field contains a single piece of data from a record: 

 

When a field has focus, it will contain a blinking cursor. 

To enter or edit text in the field, start typing. Text will appear at the cursor point. 

If you cannot edit a field, the background will appear grayed out:  

 

Drop-down lists  

Drop-down lists are fields where the possible valid entries for the field have already been 
established. You enter data into the field by selecting from the list: 

 

Drop-down lists appear highlighted when they have focus.  
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Check boxes 

Check boxes provide a True or False indication. If it is marked, the statement in the name is true. 
If it is not marked, the statement is false: 

 

The above example appears when adding a new field to a display. If the check box is marked (as 
in the picture), you are telling the program that it should show Employee Name on the display 
next to the field. If it is not marked, you are telling the program not to display the field name. 

When a check box has focus, it will appear with a dotted line around the prompt: 

 

Date Fields 

Date fields are used to contain dates. The field will only accept a valid date and formatting 
characters automatically appear in the field: 

 

When a date field has focus, it will appear highlighted. 

List Views 

A list view lets you view several records at the same time by displaying multiple fields from 
each record across rows: 

 

Each row is a record. Each column is a field in the record.  
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You can view more records by scrolling the list with the scrollbar: 

 

By clicking on the arrows at the top and bottom of the bar, you can move the list up or down by 
one record.  

The button in the middle of the bar is called a scroll box: 

 

You can click on it and slide it up or down to move directly to a particular spot on the list. For 
example, if you know the record you’re looking for is toward the end of the list, you can move 
the scroll box near the bottom of the bar, then scroll up or down as necessary until you locate the 
record. You can also scroll the list using the up and down arrow keys on your keyboard to move 
one record at a time, or the PgUp and PgDn keys to move a page at a time. 

If there is a horizontal scrollbar along the bottom of the list, there are more fields available than 
you can currently see. Use the scrollbar to view additional information on each record. 

A record in the list is selected when it is highlighted in blue and has an arrow pointing to it in the 
first column: 

 

In the above example, Joe Smith’s record is selected. The field that currently has focus will not 
appear highlighted unless the text in the field has been selected. In that case, just the text will 
appear highlighted. 
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Buttons 

Buttons are used to perform an action. They include text and/or a graphic that indicates what 
action is associated with the button: 

 

Activate a button by clicking on it with the mouse, or pressing Enter if the button has focus. If a 
button has focus, it will have a dotted blue border around the edges: 

 

Notes fields 

Most fields have a set number of characters that can be entered in them. Notes fields can contain 
unlimited amounts of text: 

 

If there is more text than can be displayed in the field, the scrollbar will become active. (See the 
List View item, earlier in this section, for a discussion of scrollbars.) 

When a notes field is active, a blinking cursor will appear in the field. Start typing at the cursor 
point to enter and edit text in the field. 

Radio buttons 

Radio buttons are used to select between a set of options. The radio button is a circle, followed 
by text indicating the option: 

 

Only one option in the set may be selected at a time. The selected radio button is filled in with a 
green  mark. In the example above, the Stretch/Shrink to Fit Frame option is selected. 

When an option has focus it will be surrounded by a dotted line: 

 

In the example above, Stretch/Shrink to Fit Frame has focus. Use the up and down arrow keys to 
move the focus between the radio buttons. 
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Using a Mouse 
A mouse is typically a device with a small ball in the bottom that pushes against sensors inside the 

mouse when you move it. These sensors are used to move the mouse pointer:  on your screen. This 
pointer is used to interact with the software. There are some variations on this design, such as touch 
pads, trackballs, and laser mice that use light instead of a ball, but the basic functionality of moving 
the pointer remains the same. 

On the top of the mouse are two buttons, a left and a right mouse button. The left-hand button is 
more commonly used. Whenever you are told to click or double-click with the mouse, you should 
use the button on the left. If you are supposed to use the button on the right, you will be told to right-
click. Some mice come with a third button or a wheel between the left and right mouse buttons. 
Refer to the documentation that came with your mouse for information on how this button is used. 
For the purposes of this documentation, we will only use the buttons on the far left and far right. 

Note 

 It is possible to configure the mouse in Windows to 
be more comfortable for left-handed people. In this 
case, the button functions are switched and the right 
button is more commonly used. If your mouse has 
been configured this way, use the button on the right 
when you are told to click or double-click, and the 
button on the left if you are told to right-click. 

The mouse is used to click buttons, open menus, enter a field so you can start typing, and select 
items in a list. To use the mouse, position the pointer over the item and click. 

Let’s look at an example screen: 
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You may be instructed to click the arrow next to the Existing Display field. Place your cursor over 
the arrow and click once with the left mouse button:  

 

From there you can select an item in the list by moving the mouse over your choice and clicking 
once with the left mouse button: 

 

If you are instructed to type something in a field, you can click in the field to bring focus to it. 
Position your mouse over the field. When your mouse is over a text edit region, it will change from a 
standard pointer to a text select bar: 

 

Click once with the left mouse button to put the focus in the field so you can start typing: 

 

If you are instructed to select a button, you should place your mouse pointer over the button and 
click once with the left mouse button:  
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If you are instructed double click on an object, position your mouse over your selection and quickly 
press twice on the left mouse button.  

Note 

 If you double click and nothing happens, it may be 
that you are not clicking fast enough or that you are 
moving the mouse slightly between clicks. It is 
possible to control how fast you have to click in your 
mouse configuration. Practice clicking faster, or refer 
to the documentation that came with your mouse for 
help with adjusting the double-click speed 

The mouse can also be used to highlight text. For example, if you wanted to highlight a selection of 
text in a field, you would position your mouse at one end of the text you wish to select, and move it 
to the opposite end of the text you wish to select while holding down your left mouse button. A blue 
highlight will appear on the text as you drag: 

 

Double clicking on a word will also highlight the entire word.  

Once you have a selection of text highlighted, you can press CTRL+C on your keyboard to copy it to 
your Windows clipboard. If you press CTRL+V on your keyboard, the copied text will be pasted at 
your current cursor location. This can be very useful if you need to enter the same data multiple 
times, or you wish to move data from one place to another. 

Another use for the mouse is drag and drop. Items that can be moved from one location to another 
are moved using this method. To drag and drop and item, first click on it with your mouse. Continue 
to hold down the right mouse button while you drag to the desired position. When you release the 
mouse button, the item will be dropped in the new location. 

Using the Keyboard 
Many options that can be accessed using a mouse can also be accessed using the keyboard. Move 
focus through a screen by pressing the Tab key. Once the desired object has focus, press Enter to 
select it. 

Note 

 For a complete discussion on identifying which object 
has focus, refer to the Form section earlier in this 
chapter. 

If you tab past the desired option, you can use Shift+Tab to tab back to the previous object. 

You will not be able to tab to a disabled object. If you find you cannot tab to an item that is not 
disabled, it is probably part of a set. For example, if there are radio buttons on a form, when you tab 
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to them only the first one will be selected. Pressing Tab again will move you to a different object. 
When this occurs, tab to the first item, then use either the left and right arrow keys (if the objects are 
aligned horizontally) or the up and down arrow keys (if the objects are aligned vertically) to move 
through the individual items in the set. 

The up and down arrow keys can also be used to scroll through the items in a drop-down list. Place 
focus in the list, then press the arrow key. Each item in the list will appear in the field in order. You 
can move quickly through the items in a drop-down list by typing the first character of the desired 
item. The list will jump to the first item that begins with that letter. You can then use the up and 
down arrow keys to scroll the list. 

If you would like to open a drop-down list, enter the field and press Alt+ the down arrow key. The 
entire list will appear. Use the up and down arrow keys to scroll the options on the list. 

If an object has a hot key, you can activate the object directly rather than tabbing to it and pressing 
Enter. A hot key is the underlined key on the name of an option. For example, the menus in Database 
Oasis all have hot key access: 

 

Hot keys are activated by holding down the Alt key on the keyboard at the same time you press the 
underlined letter. In the above example, I is the hot key for Import Design Template. To activate this 
menu option, you would press Alt+I on your keyboard. 

On the above example, you will also see that you can press Ctrl+O to open a display, Ctrl+N to add 
a new display, and Ctrl+E to edit an existing display. These control key combinations are also 
keyboard shortcuts. The difference between these option and a hot key is that you don’t need to have 
the menu open in order to use the control keys. The hot key allows you to activate an option you can 
currently see on the screen. The control key shortcuts provide quick access to the most common 
features from anywhere in the software. 

Note 

 When some screens are open, you must finish 
working with that screen before you can start another 
task. In this case, the control key shortcuts will not 
work until you close the screen. 
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Entering Data 
Most data is entered by simply typing in a field. If you make a mistake, press the Backspace key on 
your keyboard to remove one character to the left. The Delete key on your keyboard will remove one 
character to the right. To remove more than one character at a time, highlight it with your mouse and 
press delete, or simply type over it. 

Using Windows® Forms 
Database Oasis makes use of a number of standard Windows form, such as the Color Picker, the Font 
Selection screen, and the Open dialog box. If you use other Windows applications, chances are you will 
have already encountered these forms. If you are not familiar with these screens, use the following 
instructions when working with them. 

Windows Open/Save Dialog 
The Windows Open/Save dialog is used to either locate a file on your computer (Open), or to select 
a location to store a file on your computer (Save). The overall functionality of the screen is the same 
for both activities, but the options on the screen will change slightly depending on which task you 
are performing 

USING THE WINDOWS OPEN/SAVE DIALOG 

1 When the Windows Open/Save dialog first comes up, it will look something like this: 

 

What is actually displayed will vary based on how you accessed this screen. 
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2 If you are writing a file, such as a backup or an export, to an external location, the list 
at the top will say Save in: as it does in the above illustration. If you are locating a file 
that you will bring into Database Oasis, such as a graphic file, the list at the top will 
say Look in. In either case, this list is used to navigate through the data on your 
computer.  

When you open the list, it will look something like this: 

 

Alternatively, you can click the My Computer button in the left hand navigation pane 
to populate the window with this list, minus any network locations: 
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3 By default, the main hard drive on your computer is identified as [C:]. Everything that 
is stored on your computer will be under that drive. You may also have one or more 
external drives. For example, if your computer can read and write to floppy disks, you 
will have a floppy drive, usually [A:]. If your computer can read and/or write to CDs, 
you will have a CD drive, usually [D:]. If you plug in an external data device, such as 
a memory stick, your computer will automatically assign it the next available drive 
letter during the time it is connected. This will also appear on this list. 

Note 

 Even though floppy drives and CD drives are built 
into your computer, they are still considered external 
devices. 

4 Click on the drive that contains the folder you are trying to read from or write to. 
Unless you are trying to access an external device or are working on a network, this 
will be the Local Disk [C:] option.  

5 The box below the drop down list displays everything in the selected location. If you 
have selected your local disk, this will show any files and folders that are stored 
directly in c:\.: 
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6 Double click on the desired folder name. The contents of that folder will open. Most 
folders contain subfolders. These are used to help organize your files. Double clicking 
on a folder in this box will show all of the subfolders under it. Continue double 
clicking on folders until you have drilled down to the desired location.  

For example, you may keep all of your work in a c:\work folder. Under that, you may 
have separate folders to contain information related to different types of work you 
perform, such as all financial information in one folder, and all customer related 
information in another. Using this example, if you were navigating to a graphic of a 
pie chart called chart.bmp in your financial folder, your path would be 
c:\work\financial\chart.bmp. Once you've selected the Local Disk [C:] option, the 
\work folder would appear in the box. Once you double click on the \work folder the 
box would populate with your \customer and \financial folders. Double clicking on 
\financial will open that folder. The chart.bmp file would now be displayed in the 
box. 

7 If you make an error, you can use the  button on the toolbar to go up one folder 
level. Alternatively, you can open the Save in/Look in list again to go directly to any 
folder in your current path or start completely over. 

Hint 

 Windows has designed the My Document folder to be 
a central repository for most of your files. If you store 
items in the My Documents folder, or a subfolder 
under My Documents, such as My Pictures, you can 
use the My Documents button in the left-hand 
navigation pane to quickly access this folder. 

8 Once you have navigated to the desired folder, do one of two things: 

• If you are saving a file, type a name for the file in the File name: field then 
click the Save button. If a file with that name already exists in the selected 
location, you will be asked if you would like to overwrite it. Click Yes to 
overwrite or No to return to the screen to select a different name or location. 

• If you are locating an existing file, click on the file in the window. It will 
appear in the File name: field. The Save button shown in the earlier 
illustration will appear as an Open button instead. Click Open to select the 
file. 
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Windows Color Picker 
In several places throughout the display designer, you are given the option to change the color of an 
item using the Windows Color picker. Following these instructions when working with this form. 

USING THE WINDOWS COLOR PICKER 

1 When the Windows Color picker first opens, it will look like this: 

 

The Basic Colors section provides 48 of the most common colors.  

2 To select a color, simply click on the box showing the desired color. A dotted line 
will appear around the color, indicating it is selected. In the above illustration, the 
color black in the lower-left corner is selected. 
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3 To select a color that is not among the basics, click Define Custom Colors. The 
screen will expand to include the custom color options: 

 

4 The rainbow hued box at the top-right is a color matrix. When you expand the screen, 
it will default to the color selected in the Basic Colors section. You can fine tune the 
basic color by selecting nearby color options from the matrix, or by using the vertical 
band next to the color matrix to control the intensity of the color.  

The Color/Solid box will display the currently selected color. If you click on any of 
the basic colors, or click on the color matrix, this box will update to reflect the 
change. 

The Hue, Sat, and Lum fields provide the numeric values of the hue, saturation (the 
strength of the color in the specified hue), and luminosity (lightness or darkness of 
the color) of the currently selected color. 

The Red, Green, and Blue fields provide the numeric value of a color based on the 
amount of red, green, and blue found in the color. When trying to match colors, 
knowing the red/green/blue values is the easiest way of ensuring an exact match. 

5 Use the color matrix to define a color that you like. If you are not certain of a color, 
you can click the Add to Custom Colors button to add the color to the Custom Colors 
section. This will save that particular color so you may return to it later, if desired. 

6 When you are satisfied with your color selection, click OK. Whatever color is 
currently showing in the Color/Solid box will be selected. 
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Windows Font Selector 
In several places throughout the display designer, you are given the option to change the font of an 
item using the Windows Font selector. Following these instructions when working with this form. 

USING THE WINDOWS FONT SELECTOR 

1 When the Windows Font selector first opens, it will look like this: 

 

2 The Font list will display all of the fonts that you currently have installed on your 
computer. Use the scroll bar to locate the font you would like to use and click on it in 
the list. 

3 The Font Style section allows you to apply style changes to the font. You can make it 
italic, bold, or bold italic by clicking on the desired item in the list. 

4 The Size list allows you to control how large the characters appear in your chosen 
font. A smaller number means a smaller text size. For example, a 9 point font is smaller 

than a 14 point font. 

5 The Effects section allows you to apply additional effects to your font. Strikeout will 
place a line through the text like this. Underline will place a line under the text like 
this. 

6 Click the arrow next to the Font list to select a color for the text. 
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7 Many fonts have different scripts to accommodate different languages. If your text 
will be in English, leave the Western setting selected in the Scripts drop down list. If 
your data will be in a different language, select the appropriate script from the list. 

8 The Sample text will display how all of your settings will look together. When you 
are satisfied with your font selection, click OK. 

Technical Support 

Database Oasis offers complimentary technical support to registered users via e-mail at 
Support@DatabaseOasis.com. 

If you are not a registered user and have a pre-sales support question, you may contact us at 
Sales@DatabaseOasis.com. 
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CCHHAAPPTTEERR  22  

IINNSSTTAALLLLAATTIIOONN  

System Requirements 

Before installing Database Oasis, you should verify that your computer meets the recommended system 
requirements. 

Operating System 
Database Oasis is compatible with Windows operating systems including Windows XP and later. 
You must have the latest service packs available from Microsoft® installed on your computer. 

RAM 
You will need a minimum of 256MB of RAM to operate Database Oasis. It is recommended that 
you have 512MB of RAM. 

Screen Resolution 
Your screen resolution must be set to at least 800x600. Setting your resolution to 1024x768 or 
greater is recommended. 

Hard Drive Space 
The Database Oasis application will initially require 30 MB to install. You will need additional hard 
drive space as you use the software and add data. You are able to store up to 4TB (Terabytes) of data 
in Database Oasis. 
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Installation 

There are three different types of Database Oasis installations: 

• Basic Edition is a single-user product that is installed and used on one computer. 

• Professional Edition is a multi-user product. The database is installed on one computer on the 
network, then accessed by other computers over the network. This primary installation is called 
the server. 

• Professional Edition clients are installed on each machine that needs to use Database Oasis. They 
are exactly like the server, except that the database isn’t installed locally. Instead, they access the 
database located on the server. 

If you will be using Database Oasis - Basic Edition, you will simply need to install the software on the 
computer you will be using to work with your data. 

If you will be using Database Oasis - Professional Edition, you will need to select where you want to 
install the server. 

Selecting where to Install the Professional Server 

   This feature is only applicable to Database Oasis Professional Edition. 

If you will be using Database Oasis - Professional Edition, chances are you will need to access the 
software from more than one computer. In this case, you need to decide which computer will host 
the data. When choosing where to install the data server, keep the following points in mind: 

• The computer where the data resides will need to be accessible on your network to all of the 
computers that will be using Database Oasis. 

• The computer where the data resides will need to be turned on and logged into Windows 
when other people want to use the software. 

Once you’ve decided where to install the server, you can perform the client installation on any other 
computers that will need to access Database Oasis. 

Hint 

 If you do not want the data on the same computer as 
Database Oasis, you can move it to another location 
after installation. 
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Installing Prerequisites 
Database Oasis requires version 4 of the Microsoft .NET Framework from Microsoft© Technologies 
and version 3.1 or later of the Windows Installer. These applications are typically included with the 
Windows operating system, but older Windows installations may have earlier versions of these 
applications.  

The Database Oasis installer checks your system for these prerequisites on launch. If the required 
versions are not installed, the Prerequisites Wizard will launch to walk you through the installation. 

INSTALLING PREREQUISITES  

1 If you have not already done so, download the Database Oasis installation using the 
download link on the www.databaseoasis.com website. 

2 Launch the DBOasisSetup.exe file that you downloaded.  

3 If Microsoft .NET Framework 4 and Windows 3.1 are not already installed on your 
computer, the Prerequisites Wizard will appear: 
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4 Click Next to access a list of the missing prerequisites.  

 

5 Click Next to begin installation of the prerequisites. If the .NET Framework is the 
only missing prerequisite, skip to step 9. If you do not have Windows Installer 
version 3.1 or later installed, the Software Update Installation Wizard for the installer 
will launch: 
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Note 

 As part of the Windows Installer you will be required 
to reboot your computer. Make sure all other 
applications are closed before proceeding. 

6 Click Next to begin the installation. The Software Update Installation Wizard will ask 
you to accept the end user license agreement, then launch the installation process. 
When it is complete, you will be promoted to restart your computer.  

7 Click Finish to complete the installation and reboot. 

8 When Windows reboots, launch the DBOasisSetup.exe file again to continue with the 
installation. The Prerequisite Wizard will launch to allow you to install the .NET 
Framework. 

9 Click Next in the Prerequisites Wizard to launch the .NET Framework 4 Setup. 
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10 You will be asked to accept the license agreement prior to download and installation: 

 

11 Read and accept the license agreement and click Install. The installation process will 
commence. When it is finished, you will receive a Setup complete screen. 

12 Click Exit to launch the Database Oasis installation process. 

Installing Basic Edition and Professional Edition Server 
The process to install Basic Edition and Professional Edition Server are identical. The edition is 
controlled based on the registration code that is entered after purchasing the software. 

INSTALLING BASIC EDITION AND PROFESSIONAL SERVER  

1 If you have not already done so, download the Database Oasis installation using the 
download link on the www.databaseoasis.com website. 
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2 Launch the DBOasisSetup.exe file that you downloaded. The setup files will be 
extracted and the following screen will appear: 

 

3 Click Next > to continue. The license agreement screen will open: 
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Note 

 If a Program Maintenance screen appears instead of 
the License Agreement screen, you already have this 
version of the software installed. 

4 Please read the license information carefully. If you do not accept the terms of this 
agreement, click Cancel to abort the installation. If you do accept the terms of the 
agreement, select the I Agree radio button and click Next > to continue. The 
Installation Type screen will appear: 

 

5 To install Basic Edition or Professional Edition Server, leave the Standard installation 
radio button selected. 

Note 

 If you have already installed a Professional Edition 
Server on another computer on your network and 
would like to install a client, refer to the Installing 

Professional Edition Clients section, below. 
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6 The Select Installation Folder page will open: 

 

7 This allows you to specify a location for your installation of Database Oasis. It is 
recommended that you install to the default location in the \Program Files folder. If 
you wish to install to a different location, click the Browse… button and select the 
target folder.  

8 Click Next > to continue. The Ready to Install screen will open: 
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9 Click Install to begin installing Database Oasis. A progress screen will appear as the 
software is installed: 

 

10 Once the installation process is complete, the following screen will appear: 

 

11 If you would like to launch Database Oasis, now, leave the Launch Database Oasis 
check box marked and click Finish to exit the wizard. (See Launching the Application 
in Chapter 3, Getting Started for instructions on opening the software.) 
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Installing Professional Edition Clients 

   This feature is only applicable to Database Oasis Professional Edition. 

Database Oasis Professional Edition lets users on the same network work together using the same 
database. 

If you want to have more than one person sharing information in Database Oasis, you need to have 
the data stored in a central location on your network that everyone can access. For example, you may 
have three computers that are able to talk to each other over a network.  

Database Oasis needs to be installed on all three computers, but the data only needs to be installed 
on one of them. The other two computers will be told to use the data on that first computer. The 
computer where the data is installed is called the server. The other computers are called clients. 

 

You should run the server installation first to install the data. During the client installation, you will 
need to select the path to the data that was previously installed on the server computer.  
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Configuration for Professional Client Access 
In a network environment, in order for the clients to access the data over the network, you will need 
to set up a network share to the data file. 

CREATING A NETWORK SHARE 

Note 

 There may be slight differences in the procedure for 
sharing data, depending on your operating system and 
security settings. These steps provide an overview of 
common configuration options, but do not cover all 
possible variables.  

 For comprehensive help with configuring a share in 
Windows XP, refer to the article 
http://support.microsoft.com/kb/304040.  

 For help in Windows Vista, refer to the article 
http://www.microsoft.com/technet/network/evaluate/v
ista_fp.mspx.  

 For help in Windows 7, refer to the article 
http://windows.microsoft.com/en-
us/windows7/Share-files-with-someone.  

1 On the computer where Professional Edition is installed, double click on the My 
Computer icon on your desktop: 
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2 The My Computer screen will open: 

 

3 Navigate to the Database Oasis data path. For operating systems prior to Windows 
Vista, the data is located in the path C:\Documents and Settings\All 
Users\Application Data\DBOData. In Windows Vista and Windows 7, the data is 
located in the path C:\ProgramData\DBOData\.  

Note 

 If you do not see the \DBOData folder, it is usually 
because it is hidden in Windows. To unhide the 
folder, right click on your Windows Start button and 
select Explore from the menu to open Windows File 
Explorer. Select Folder Options from the Tools menu, 
then select the View tab. Make sure that the Show 
hidden files and folders option is selected. 
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4 Right click on the \DBOData folder and select Sharing and Security or Share 
(depending on your version of Windows) from the right-click menu: 
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5 The Sharing tab of the Properties screen for the \DBOData folder will open: 

  

Note 

 Depending on your version of Windows, you may 
need to press the Advanced Sharing button on the 
Properties screen to access the sharing options. 

Note 

 If you have never created a network share, this screen 
will have a link to a wizard where you can set up file 
sharing. Follow the on-screen instructions in the 
wizard, if desired. 
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6 Select the Share this folder check box or radio button (depending on your version of 
Windows). This option will make the \DBOData folder accessible to clients on the 
network. 

WARNING! 

 If an outside user is able to access your network, any 
shared folders will be available. Make sure that you 
have security on your network to prevent outside 
access, especially if you are using a wireless network. 

7 Select the Security tab: 

 

Note 

 Depending on your version of Windows, you may 
need to click Edit to open a separate Permissions 
screen to change these settings. 
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8 Verify that there is a group named Everyone in the Group or user names list. If there 
is, skip to step 12. 

WARNING! 

  Selecting the Everyone group gives anyone who is 
able to access your network access to the folder. 
Configuring the Everyone group is the easiest way to 
ensure clients will be able to access the software 
when there is not a security scheme in place. If you 
have group security in place, it is recommended that 
you select groups and/or users that reflect your 
security configuration rather than using Everyone. 

9 If there is no Everyone group, click Add. The Select Users or Groups screen will 
open: 

 

10 In the Enter the object names to select box, type Everyone. 

11 Click OK to save the group and return to the Security tab. 

12 Highlight the Everyone group in the Group or User Names list and select the Full 
Control check box in the Permissions for Administrators box. 

13 Click OK to save the changes and close the Properties screen. 
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Testing the Folder Share 
Once you’ve configured your share, it is recommended that you test it outside of Database Oasis by 
trying to access that folder in Windows Explorer from the client computer.  

TO TEST THE PERMISSIONS: 

1 On the client computer, right click on the Windows Taskbar’s Start button and select 
Explore from the menu. 

2 In the Folders list, select Network or My Network Places (depending on your version 
of Windows). 

3 Navigate to your Database Oasis server computer and make sure you can see the 
Database Oasis data folder in the list.  

Note 

 To navigate to the computer in Windows XP, select 
Entire Network, then Microsoft Windows Network 
under the My Network Places link. 

4 Click on the Database Oasis data folder and make sure you can open it. 

5 With the folder selected, right click in the files section on the right and select New, 
Text Document from the menu and verify it allows you to create a text file in the 
folder. (You may delete the text file if desired.) 

If you are unable to access the folder and create a new file in the folder, clients will not be able to access 
the Database Oasis data. In this case, check the following: 

• On the Database Oasis server computer, verify in Windows that the Guest account is turned on. 
(Refer to Microsoft Windows help for instructions on turning on the Guest account in your 
version of Windows.) 

• Verify that the folder share has been correctly configured using the above instructions.  

Note 

   If you are able to access an existing folder share that is 
working, compare its settings with the new share to 
determine the differences. 

• Depending on the version of Windows and internal security settings, Windows may not allow 
you to grant full access to the default data path. In this case, you may need to move the 
\DBOData folder directly under the C:\ drive. 
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Client Installation 
Once you are able to access the data on the server from the other computers on your network, you are 
ready to install the client. 

RUNNING THE PROFESSIONAL CLIENT INSTALL 

1 If you have not already done so, download the Database Oasis installation using the 
download link on the www.databaseoasis.com website. 

2 Launch the DBOasisSetup.exe file that you downloaded.  

3 Follow the installation steps using the guidelines under Running the Basic Edition 

and Professional Server Install, above. After you accept the license agreement, the 
Installation Type screen will appear: 

 

4 To install a Professional Edition client, select the Client Installation radio button and 
click Next. 
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5 The Server Data Path screen will appear: 

 

6 Click the Browse button and navigate to the network share containing the Database 
Oasis data file on your Database Oasis server computer. 

7 Click Next to proceed with the installation following steps 6 through 11 under 
Running the Basic Edition and Professional Server Install. The client software will 
install and connect to the data specified in step 6 above. 
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Installing an Upgrade 

Prior to upgrading, please review the following: 

• Before running an upgrade, make sure to back up your existing installation using the Backup 
option on the Tools menu. 

• If you are upgrading Database Oasis - Professional Edition: 

o Make sure all clients are logged off before proceeding.  

o Make sure all clients are upgraded prior to trying to connect to the server.  You will 
not be able to log on from a client that has not been upgraded. 

Note 

 If you upgrade a client before upgrading the server, 
the database will be automatically upgraded when you 
first log on from the client. At that point, you will not 
be able to log on from the server until it has also been 
upgraded. 

• If you are upgrading from a version of Database Oasis prior to version 3.0 

o The version 2.x to version 3.x upgrade requires an upgrade license key. Once you 
upgrade, your installation will become unregistered until you enter an upgrade key. 

WARNING! 

 Be sure to have a backup of your current installation 
before proceeding. When you install version 3.x, 
changes are made to the database that make it 
incompatible with version 2.x. The only way to revert 
to version 2.x once you’ve upgraded is to uninstall 
version 3.x, reinstall version 2.x and restore your pre-
upgrade backup. 

o There is no direct upgrade path to version 3.x from any version prior to version 2.8. If 
you have a prior version, you must first upgrade to version , then to version 3.x. For 
version 2 download files and upgrade instructions, please visit 
http://databaseoasis.com/downloadsv2.aspx.  
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Running the Upgrade 
If you have an older version of Database Oasis and would like to upgrade to a newer version, simply 
run the install as you would for a new installation. Database Oasis will detect your existing 
installation and perform the upgrade. 

UPGRADING DATABASE OASIS  

1 If you have not already done so, download the Database Oasis installation using the 
download link on the www.databaseoasis.com website. 

2 Launch the DBOasisSetup.exe file that you downloaded. The setup files will be 
extracted and the following screen will appear: 

 

Note 

 If the Prerequisite screen appears before the Welcome 
screen, refer to Installing Prerequisites, earlier in this 
chapter. 
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3 Click Next > to continue. The license agreement screen will open: 

 

Note 

 If a Program Maintenance screen appears instead of 
the License Agreement screen, you already have this 
version of the software installed. 

4 Please read the license information carefully. If you do not accept the terms of this 
agreement, click Cancel to abort the installation. If you do accept the terms of the 
agreement, select the I Agree radio button and click Next > to continue.  
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5 If you are upgrading within the same major version number (for example, from 
version 3.0 to version 3.1), the upgrade will proceed. If you are upgrading from 
version 2.97 or earlier to version 3.x, you will see the following screen: 

 

6 The upgrade from version 2.x to version 3.x requires a license key. If you do not 
already have an upgrade key, make sure you read this page carefully and understand 
that your installation will become unregistered. If that is acceptable, click Install to 
start the upgrade. 
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7 Once the installation process is complete, the following screen will appear: 

 

8 If you are upgrading a Basic Edition or Professional Edition server, the database 
update will be completed when you launch Database Oasis. If you would like to 
launch Database Oasis, now, leave the Launch Database Oasis check box marked and 
click Finish to exit the wizard.  

9 If you have upgraded a Professional Edition client, the software will launch. If you 
have upgraded a Basic Edition or Professional Edition server, when Database Oasis 
launches, it will detect that it must upgrade the data and the following message will 
appear: 
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10 Click OK to update your database. Once the data upgrade has completed, the 
following message will appear: 

 

11 Select Enter Registration Key and enter the registration information you were sent 
when you purchased your Version 3.x upgrade key. If you have not yet purchased the 
upgrade key, select Buy Now to be directed to a purchase page, or Cancel to exit 
Database Oasis. 

Installing Professional Edition Clients 

   This feature is only applicable to Database Oasis Professional Edition. 

If you are using Database Oasis Professional Edition, you should install the software on any client 
machines that will need to access Database Oasis. 

RUNNING THE PROFESSIONAL CLIENT INSTALL 

1 If you have not already done so, download the Database Oasis client installation from 
http://www.databaseoasis.com/dboasisclientinstall.exe.  
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2 Launch the DBOasisClientInstall.exe file that you downloaded. The installation files 
will be extracted and the Setup wizard will launch to guide you through the 
installation. 

3 Follow the installation steps using the guidelines under Running the Basic Edition 

and Professional Server Install, above. 

4 Click Close to exit the wizard. (See Clients & Users in Professional Edition for help 
with client configuration.) 

Registering Your Software  

In order to allow you to evaluate the Database Oasis software prior to making a purchase decision, the 
software is initially installed unregistered. The unregistered version is a 15 day trial. In order to use the 
software beyond the 15 days, you must purchase and register it.  

Note 

 Professional Editions are registered at the Server (the 
machine where the data is installed). You do not need 
to register a Professional Edition client. 

PURCHASING DATABASE OASIS 

1 Select Buy Now from one of the following places: 

• Select the Click here to buy now link on the Database Oasis screen that opens 
when you first launch the software. 
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• Select the Buy Now menu option on the Help menu: 

 

• Click the Buy Now button on the Purchase Information screen that comes up 
when you exit the software: 

 

• Go to www.DatabaseOasis.com and select any of the Buy Now links. 
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2 A secure shopping cart will open where you can enter your payment information. 

Once you have purchased the software, you will be sent an e-mail that contains a registered user name 
and a registration key. This information will be used to register the software. 

REGISTERING THE SOFTWARE 

1 Register the software using one of the following methods: 

• From the Database Oasis screen that comes up when you launch the software, 
select the I have a registration number radio button and click OK. 

 

• From the Help menu, select Enter Registration Key. 
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• From the Purchase Information screen that comes up when you exit the software, 
select Enter Key: 

 

2 The Enter Registration Key screen will open: 

 

3 When you purchased the product, you provided the name under which it should be 
registered. This name was used to generate the registration key. The key and the name 
must match for the registration information to be accepted. The registration name can 
be found in the e-mail you received that contained your purchase confirmation and 
the registration key. Either copy and paste the registration name from that e-mail, or 
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type it in the Registration Name field exactly as it appears in the e-mail. This entry is 
case sensitive (upper and lower case letters must match). 

4 As soon as you have entered a Registration Name, the Registration Key field will 
become available. This is the key that was provided when you purchased the 
software. It is divided into four separate sections. Enter the code for each section in 
the boxes.  

5 The OK button will become available once you have entered the complete registration 
information. Click this button to register the software.  

6 If you are currently in a trial of the edition you are registering, you can continue to 
work with the software. If you are in a trial of the other edition, or you have not yet 
selected an edition, Database Oasis will close to allow the proper edition to launch. 
Reopen the software to continue. 

Upgrading From Basic Edition to Professional Edition 
Database Oasis - Basic Edition is designed to provide a very easy-to-use, database solution that is 
accessible to users of all technical levels. Database Oasis - Professional Edition is designed for users 
who need more advanced functionality. The products use the same installed file, but some of the 
advanced features have been hidden from Basic Edition users. To upgrade to Professional Edition, 
you only need to enter a registration code that unlocks the advanced features. 

UPGRADING TO PROFESSIONAL EDITION 

1 Open Database Oasis - Basic Edition. 

2 From the Help menu, select Enter Upgrade Key. 

 

3 The Enter Registration Key screen will open.  

4 The registration name can be found in the e-mail you received that contained your 
upgrade confirmation and the registration key. Either copy and paste the registration 
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name from that e-mail, or type it in the Registration Name field exactly as it appears 
in the e-mail. This entry is case sensitive (upper and lower case letters must match). 

5 As soon as you have entered a Registration Name, the Registration Key field will 
become available. This is the key that was provided when you purchased the upgrade. 
It is divided into four separate sections. Enter the code for each section in the boxes.  

6 The OK button will become available once you have entered the complete registration 
information. Click this button to register the upgrade.  

7 A message will appear informing you that Database Oasis must close. Click OK to 
exit the software. When you launch it again, it will be a Professional Edition. 

Uninstalling the Software 

If you wish to uninstall Database Oasis, you may do so from the Windows Control Panel. 

Note 

 The uninstall will only remove Database Oasis. If you 
wish to remove the Microsoft .Net Framework, you 
must select to uninstall that option individually in the 
Control Panel. Because the framework will 
potentially be used by other Windows applications, it 
is not recommended that you uninstall it. 

UNINSTALLING DATABASE OASIS 

1 Click on the Start button on the taskbar in Windows to open the Start menu. 

2 Select Control Panel from the Settings menu. The Control Panel will open. 

3 Double click on the Add or Remove Programs icon. A list will open containing all of 
your installed programs. 

4 Locate Database Oasis on the list and click the Remove button. 

5 You will be asked to confirm your decision to remove the software. Click Remove to 
remove Database Oasis from your computer. 
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6 By default, the database is not uninstalled with the software to prevent accidental data 
loss. To remove the database, locate and delete the data folder. If you are using 
Windows Vista, the data is located in the path c:\ProgramData\DBOData.\ For all 
other operating systems, the data is located in the path C:\Documents and Settings\All 
Users\Application Data\DBOData.   
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Launching the Application 

When the software was installed, an icon was added to both your desktop and your program menu, 
providing two different ways to launch the software. 

LAUNCHING THE SOFTWARE FROM THE DESKTOP 

1 On the Windows desktop, locate the Database Oasis icon: 

 

2 Double click the icon. The application will launch. 

LAUNCHING THE SOFTWARE FROM THE PROGRAM MENU 

1 Click the Start button on your Windows Taskbar. The Start menu will open. 

2 Locate the Programs or All Programs option on the menu (depending on your version 
of Windows). 
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3 Locate the Database Oasis folder on the menu: 

 

4 Click on the Database Oasis folder to open a sub-menu: 

 

5 This menu provides a shortcut to launch the software. It also contains a 
Documentation submenu which provides access to the software’s documentation: 

 

• Help File – This is the main program help file that is accessible from within 
the software. This provides all of the information on how to use your 
software. 

• Quick Start Guide – This provides a brief overview of the software. This is a 
resource if you would like a little help getting started. You must have the 
Adobe® Reader to open the .pdf file. 

• User Guide – This provides the same information as the help file, but in a 
printable .pdf file format. You must have the Adobe® Reader to open the 
file. 

6 Click on the Database Oasis menu item: 
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7 The software will launch. 

Evaluating the Software 
The first time you launch the software, a Database Oasis screen will appear:  

 

If you are evaluating the software, this screen provides the ability to evaluate either Professional 
Edition or Basic Edition. This will come up every time you open Database Oasis until you register, 
allowing you to toggle back and forth between the two editions while making your decision. 

LAUNCHING THE SOFTWARE USING THE DATABASE OASIS 

SCREEN 

1 Launch Database Oasis. 

2 If you do not have a registration key and would like to evaluate the software, select 
either Basic Edition – single-user version focused on ease-of-use or Professional 
Edition – multi-user version with advanced functionality. If you select to evaluate 
Professional Edition, the software will open with Professional Edition features 
enabled. If you evaluate Basic Edition, Professional Edition features will not be 
visible. 

Note 

 If you would like to obtain a registration key, click 
the Buy Now button. If you have already purchased 
Database Oasis and would like to enter your 
registration information, select the Enter Key button. 
The Enter Registration Key screen will open. Follow 
the instructions under Registering Your Software in 
Chapter 2 for instructions. 

3 Click OK. The software will open with the features for the selected edition enabled.  
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Logging In   

   This feature is only applicable to Database Oasis Professional Edition. 

If you are using Database Oasis Professional Edition, you will be asked to log into the software 
when you launch. The first time you open the software, you will need to create a new user. The first 
user that is created will automatically be assigned administrative rights, meaning this user account 
will have full access to the software. You will not be able to delete the first user or remove 
administrative rights. 

LOGGING IN AND ADDING THE FIRST USER 

1 Launch Database Oasis using the instructions under Launching the Application, 
above. 

2 The Add a User screen will appear: 

 

3 In the User Name field, enter a unique name for the user. This name will be used to 
log into the software and to identify the user in the software. 

4 In the Password field, enter the password the user will use to log into Database Oasis. 
The password is case sensitive, meaning that if you use capital letters in the password, 
the same capitalization must be used when logging in. If you do not wish to use a 
password, leave this field blank. 
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WARNING! 

 Make careful note of the password. If a user forgets 
his password, he will not be able to log into Database 
Oasis.  

5 Retype the password entered in the Password field in the Confirm Password field. 
The two entries must match. 

Note 

 The first user will be created with administrative 
rights. Users with administrative rights are able to run 
backups, restore from backup, and add, edit, and 
delete users.  

6 Click OK to add the user and open Database Oasis. 

After you have created the first user, a standard login screen will appear when you launch the 
software. 

LOGGING IN AS AN EXISTING USER 

1 Launch Database Oasis using the instructions under Launching the Application, 
above. The Database Oasis Login screen will appear: 

 

2 Enter your user name in the User Name field. 

3 Enter the password associated with the user name in the Password field. The 
password is case-sensitive, meaning that if any capital letters were used when the 
password was created, they must be entered exactly as added. 

4 Click Login to log into the software as the selected user. 
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Exploring the Screen 

The main Database Oasis screen consists of a menu, a navigation pane, a work area, and the Welcome 
page. 

 

Welcome Page 
When you first open Database Oasis, you will see the Welcome To Database Oasis page. This page 
provides brief instructions on using the product and links to additional help options.  

This screen can be closed by clicking the red X on the title bar:  

 

As you’re familiarizing yourself with the software, it may be a good idea to leave this page open for 
quick access to help. Once you’re comfortable with using the product, unmark the Show this page on 
startup check box. The next time you come into Database Oasis, this screen will not appear. If you 
should need to access this screen again, you can open it by selecting Show Welcome Page on the 
File menu. 
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Work Area 
The main work that you will be doing in Database Oasis is interacting with your displays. Displays 
open in this main work area. Within that area, you can open multiple displays and move them around 
to arrange them: 

 

For a full discussion on how to open displays and arrange them in the work area, refer to Chapter 7, 

Working with Records in Data Displays. 

Navigation Pane 
The Navigation Pane provides quick access to the most commonly used features in Database Oasis. 
Each of the three sections in the Navigation Pane can be collapsed or expanded. 

Note 

 Depending on your security rights, not all sections 
may be visible. 
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COLLAPSING A SECTION OF THE NAVIGATION PANE 

1 Click on the double arrow at the top of the section: 

 

2 The section will collapse to a header and the double arrow will point down: 

 

3 Click on the double arrow a second time to expand the section. 

The Navigation pane appears by default when you first open the software. You may close and 
reopen this pane to adjust the amount of room available in the main work area. 

CLOSING THE NAVIGATION PANE 

1 From the File menu, select Show Navigation Pane: 

 

2 The check mark will disappear from the menu and the Navigation pane will close. 
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Note 

 If you close the Navigation Pane, it will not 
automatically appear the next time you open the 
software. You must reopen the Navigation Pane using 
the steps below. 

REOPENING THE NAVIGATION PANE 

1 From the File menu, select Show Navigation Pane. 

2 The check mark will appear on the menu and the Navigation pane will reappear. 

Following is a brief description of the options available on the Navigation Pane. Full documentation 
on each of these features can be found later in this documentation. 

Add a New Display 
Database Oasis comes with a selection of displays already built in to get you started. When you are 
ready to fully utilize the software, you will want to create your own displays. This section provides 
links to the three ways that you can add new displays. 

Design a New Display – This will let you start a brand new display from a blank page. 

Import Design Template – A design template is a file that contains a description of an empty 
display with no data. This option will allow you to locate a template file on your computer and 
add a new display from that template. Your installation of Database Oasis comes with a selection 
of templates that can be imported into your software. Templates are also available from the 
www.databaseoasis.com website, or may be shared between Database Oasis users. 

Copy Display Design – This option will allow you to make a copy of the design of any of your 
displays. You can then edit the copy without affecting the original display.  
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Work with Existing Displays 
The Work with Existing Displays box on the Navigation Pane allows you to access some of the 
functionality that is available around your existing displays.  

Note 

 Most of the options that are available for working 
with the data in your displays are accessible from the 
menu inside the displays.  

Edit or Delete a Display – This option allows you to open a display in the display designer where 
you can add or remove objects, or make other changes. 

Export Design Template – This option allows you to create a template file from one of your 
displays. This template file can then be imported into another installation of Database Oasis. 

Open a Display  
This list will show all of the displays you currently have installed. To open any of the displays in the 
list, simply double click on it or highlight it and click the Open Highlighted Display button. 

Menu Bar 
Much of the functionality in Database Oasis is specific to a particular display. For this reason, each 
display will have its own menu. The options selected from that menu will only impact that display. 
Any functionality that does not require that you open a specific display is accessible from the main 
menu bar. 

File 
This menu provides options that impact main Database Oasis screen. 

Show Navigation Pane – This will toggle whether the Navigation Pane appears. 

Show Welcome Page – If you have closed the Welcome To Database Oasis page that appears 
when you first launch the software, this option will reopen it. 

 Log in as Different User – If you are using Professional Edition, this will allow you to 
change the user who is currently logged in without exiting the software. 

 Change Password – If you are using Professional Edition, this will allow users who do 
not have administrative access to user maintenance to change their own passwords. 

 Set Host – This menu option will only appear if you are currently logged into a client 
installation of Professional Edition. When you first log onto a client, you select the Windows 
machine where the server installation of Database Oasis is installed. This option allows clients to 
select a different server. 

Exit – This option closes the software. 
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Displays 
This menu provides access to functionality around creating and working with displays. 

Open Display – This option will let you select and open any of the displays you have in your 
software. This provides the same functionality as the Open a Display section on the Navigation 
Pane. 

Add New Display – This will let you start a brand new display from a blank page. This provides 
the same functionality as the Design a New Display option on the Navigation Pane. 

Edit/Delete Existing Displays – This option allows you to open a display in the display designer 
where you can add or remove objects, or make other changes. This provides the same 
functionality as the Edit or Delete a Display option on the Navigation Pane. 

Copy Display Design – This option will allow you to make a copy of the design of any of your 
displays, without the data. You can then edit the copy without affecting the original display. This 
provides the same functionality as the Copy Display Design option on the Navigation Pane. 

Import Design Template – A template is a file that contains description of an empty display with 
no data. This option will allow you to locate a template file on your computer and add a new 
display from that template. This provides the same functionality as the Import Design Template 
option on the Navigation Pane. 

Export Design Template – This option allows you to create a template file from one of your 
displays. This template file can then be imported into another installation of Database Oasis.  

Export Data – This option allows you to copy the data from a display out to an external file 
where you can work with it in another application, such as a spreadsheet or word processor. This 
provides the same functionality as the Export Data option on the Navigation Pane. 

Note 

 This option is only available in registered installations 
of the software. 

Tools 
The Tools menu provides access to system maintenance tools. 

Note 

 The Tools menu will only appear in Professional 
Edition if the user who is currently logged in has 
administrative rights. 

Backup – This option allows you to make a safety copy of your installation of Database Oasis. It 
is recommended that you perform frequent backups, especially of critical information. (See 
Backing up Your Data, in Chapter 9, System Maintenance, for instructions.) 
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Restore – This option allows you to bring back a backed up copy of your installation. (See 
Restoring from Backup, in Chapter 9, System Maintenance, for instructions.) 

 Users – This option opens the following sub-menu: 

 Manage Users – This option opens the Manage Users screen where you can add, 
edit, and delete the list of users who have access to Database Oasis. 

 Enter Key for Additional Users – The number of users that can be added to 
Database Oasis Professional Edition is based on the number of user licenses that have 
been registered. This option opens the Enter Registration Key screen where you can 
register additional user licenses. 

Windows 
The Windows menu allows you to organize the main work area when you have multiple displays 
open at the same time.  

For example, you may have three different displays open simultaneously:  

 

The open displays will be layered based on the order in which they have been accessed. The 
currently active display will be in front. The display that has not been accessed for the longest 
amount of time will be in back. In this example, the Contacts display is the currently active display. 
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The Recipes display was active just prior to Contacts, so it appears just behind it. The Music Catalog 
display appears at the back. 

Cascade 
This option will stack all open displays, one on top of another, with the display that currently has 
focus on top. The display that was active most recently before the current display will be next, and 
so on. The displays will be arranged so that their title bars are accessible, so you can click on a title 
bar to bring a different display to the front.  

Using the above example, if you select to Cascade, your screen will look like this: 
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Tile Horizontal 
This option will arrange the displays so that they appear in horizontal rows. The currently active 
display will be in the top row in the upper left hand corner of the work area. The next display will 
appear below it, and so on:  

 

Note 

 When the work area is filled, it will start a second set 
of rows next to the first. The displays may overlap, 
hiding some displays from view. This option works 
best when there are fewer displays open. 
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Tile Vertical 
This option is similar to Tile Horizontal, except that it tiles the displays so that they are arranged in 
vertical columns. The active display will appear in the upper left hand corner of the work area. It will 
occupy the first vertical column. The next screen will be placed to the right of it, and occupy the 
second vertical column, and so on: 

 

Note 

 When the work area is filled, it will start a second set 
of vertical columns below the first. The displays may 
overlap, hiding some displays from view. This option 
works best when there are fewer displays open. 
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[Displays] 
At the bottom of the menu will be a list of any displays and list views you currently have open: 

 

The currently active display will have a check mark next to it. Clicking on a display on the menu 
will bring it to the front, making it active. 

Help 
This menu provides access to information about your software and documentation resources. 

Help – This opens the main program help files that provide full documentation on using your 
software. 

User Guide – This opens the user manuals in a .pdf file that can be printed. This file contains the 
same information as the help files in a printable format. 

Quick Start Guide – This opens a printable .pdf file that provides a brief overview of using the 
software. 

Online Demos – This provides a link to the databaseoasis.com website where you can run demos 
that illustrate how to create displays and work with your data. 

Contact Information – This option opens the Contact Information screen, which provides contact 
information for MKF Solutions, as well as links to support and sales: 
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About Screen – This opens the About screen which provides information on your software: 

 

This screen shows whether the installation is a Professional Edition or a Basic Edition, and provides 
the version number. If it is a Professional Edition, it also shows the number of registered users, the 
currently logged in user, and whether it is a client or the server. It also provides buttons to quickly 
access System Information related to your computer configuration, and Contact Information for 
technical support, sales questions, and other inquiries. In Professional Edition, there is also a Convert 
option that toggles the installation between a server and client.  

Note 

 It is strongly recommended that you contact 
Support@DatabaseOasis.com before using the 
Convert option. 
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   This entire chapter is only applicable to Database Oasis Professional Edition. 

Multi-User Network Access  

Database Oasis - Professional Edition allows more than one user to share data on a network. The data is 
located on one central computer (the Server), and everyone else who wants to share that data (the 
Clients) accesses it over the network. In order for this to work, you need to: 

• Set up users in Database Oasis. When people want to use the software, they must know a valid 
user name and password in order to log on. This keeps unauthorized people from accessing the 
data remotely. 

• Launch Database Oasis on each Client machine and tell it the path to where the data is stored. 
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Setting up Users 

Note 

 Access to manage users is subject to security. The 
login that you used to access Database Oasis must be 
an Administrative account. 

When you launch the software for the first time, you are prompted to add the first user. If any additional 
users will be accessing Database Oasis, you must create user accounts for each of them. 

ADDING USERS 

1 Log into Database Oasis as an Administrative user. (The first user that was added is 
automatically an administrator.) 

2 From the Tools menu, select Users, then select Manage Users: 
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3 The Manage Users screen will open: 

 

4 Select Create New User. The Add a User screen will open: 

 

5 Enter a unique name for the user in the User Name field. This name will be used to 
log into the software and to identify the user in the software. 
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6 Enter the password the user will use to log into Database Oasis in the Password field. 
The password is case sensitive, meaning that if you use capital letters in the password, 
the same capitalization must be used when logging in. If you do not wish to use a 
password, leave this field blank. 

Note 

 Make careful note of the password. If a user forgets 
his password, he will not be able to log into Database 
Oasis.  

7 Retype the password that was entered in the Password field in the Confirm Password 
field. The two entries must match. 

8 By default, new users have full rights to existing displays and the ability to add new 
displays, but they do not have rights to add and edit users or create or restore backups. 
If you would like to modify the user’s security rights, click the Security Access 
button. See the Security section, later in this chapter for details on modifying the 
user’s security access. 

9 Click OK to add the user. You will be returned to the Manage Users screen and your 
new user will appear in the Existing Users list. 

Registering Additional User Licenses 
Database Oasis – Professional Edition comes with three user licenses. This means that you can add 
up to three users in Manage Users. If you need to add more than three users, you can purchase 
additional user licenses from www.databaseoasis.com.  

When you purchase additional licenses, you will be sent a registration name and key via e-mail. You 
must enter the key to register the users before you can set up additional user accounts. 

ENTERING AN ADDITIONAL USER LICENSE KEY 

1 Enter the key using one of the following methods: 

• Select Enter Key for Additional Users from the Users menu: 

 



  Setting up Users 

Chapter 4 – Clients and Users in Professional Edition  ♦  Page 80 

• Select Enter Key for Additional Users from the Manage Users screen: 

 

2 The Enter Registration Key screen will open: 

 

3 The registration name can be found in the e-mail you received that contained your 
purchase confirmation and the registration key. Either copy and paste the registration 
name from that e-mail, or type it in the Registration Name field exactly as it appears 
in the e-mail. This entry is case sensitive (upper and lower case letters must match). 

4 As soon as you have entered a Registration Name, the Registration Key field will 
become available. This is the key that was provided when you purchased the users. It 
is divided into four separate sections. Enter the code for each section in the boxes.  

5 The OK button will become available once you have entered the complete registration 
information. Click this button to register the additional users. 



  Setting up Users 

Chapter 4 – Clients and Users in Professional Edition  ♦  Page 81 

6 A message will appear confirming the registration. You may now add additional 
users. 

Editing Users 
Once a user has been added, administrators can modify the user’s settings from the Manage Users 
screen. 

EDITING A USER: 

1 Open the Manage Users screen as described under Add a User, above. 

2 Highlight the user you would like to edit in the Existing Users list and click Edit 
User. The Edit Existing User screen will open: 

 

3 If you would like to change the user's name, enter the new name in the User Name 
field. This name is used to log into Database Oasis and to identify the user in the 
software. 

4 By default, new users have full rights to existing displays and the ability to add new 
displays, but they do not have rights to add and edit users or create or restore backups. 
If you would like to modify the user’s security rights, click the Security Access 
button. See the Security section, later in this chapter for details on modifying the 
user’s security access. 

5 If you would like to change the user's password, mark the Change Password check 
box. The password fields will enable.  

6 Enter the user's current password in the Current Password field for verification. 
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7 Enter the new password the user will use to log into Database Oasis in the New 
Password field. The password is case sensitive, meaning that if you use capital letters 
in the password, the same capitalization must be used when logging in. If you do not 
wish to use a password, leave this field blank. 

Note 

 Make careful note of the password. If a user forgets 
his password, he will not be able to log into Database 
Oasis.  

8 Retype the password that was entered in the New Password field in the Confirm 
Password field. The two entries must match. 

9 Click OK to save the changes to the user. 

Changing Your Own Password 
Even if you do not have administrative access to manage users, you can still change your own 
password. 

CHANGING YOUR PASSWORD 

1 From the File menu, select Change Password: 

 



  Setting up Users 

Chapter 4 – Clients and Users in Professional Edition  ♦  Page 83 

2 The Change Password for User screen will open: 

 

3 Enter your current password in the Current Password field for verification. 

4 Enter the new password you would like to use to log into Database Oasis in the New 
Password field. The password is case sensitive, meaning that if you use capital letters 
in the password, the same capitalization must be used when logging in. If you do not 
wish to use a password, leave this field blank. 

Note 

 Make careful note of the password. If you forget your 
password, you will not be able to log into Database 
Oasis.  

5 In the Confirm Password field, retype the password that you entered in the New 
Password field. The two entries must match. 

6 Click OK to set the password. The next time you log into Database Oasis, you will 
need to enter this new password. 

Deleting Users 
If a user no longer needs to access Database Oasis, you can delete him or her from the Existing 
Users list in Manage Users. Once a user has been deleted, that user account will no longer have 
access to the software. 
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DELETING A USER 

1 Open the Manage Users screen as described under Add a User. 

2 Highlight the user you would like to delete in the Existing Users list. The Delete 
button will enable: 

 

Note 

 If the Delete button does not enable, it means that the 
current user cannot be deleted. Since there must 
always be at least one user in Database Oasis, you 
cannot delete the user that is currently logged into the 
software. To delete the current user, log out and log in 
as a different user. 

3 Click Delete. 

4 You will be warned that deleting a user is permanent and asked to confirm your 
decision to delete. Click Yes to remove the user. 
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Security 

By default, users have full access to data and the ability to add and edit displays. Aside from the first 
user added, by default, new users do not have administrative rights, which include the ability to add and 
edit users and create or restore backups. 

You are able to modify the security access for new users. 

SETTING USER SECURITY 

1 Create or edit a user following the instructions in the Setting up Users section, earlier 
in this chapter. 

2 Click the Security Access button. 

Note 

 You will not be able to remove administrative rights 
from the user who is currently logged in. To change 
this user's security access level, log out and log in as a 
different user. 

3 The Security screen will open: 
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4 The User has Administrative Rights check box lets you grant administrative rights to 
the user. Users with administrative rights have full access to all displays and are 
additionally able to run backups, restore from backup, and add, edit, and delete users. 
If this is selected, the rest of the options on this screen are disabled. 

5 If the user is not an administrator, mark the User may add new displays check box if 
you would like to allow the user to create new displays. If this is unmarked, the user 
will not be able to access the Design a New Display, Import Design Template, or 
Copy Display Design options on the navigation pane or Displays menu. 

6 The Database Access section allows you to grant the access level for individual 
displays in your database. The first radio button set determines whether users are 
given access to new displays by default. Select from the following options: 

• If you would like the user to automatically have full access to new displays, select 
User has full access to new displays by default. This will grant the user rights to 
add and edit records and modify the display design for all new displays by 
default. (You may turn off access to specific displays, if desired.) 

• If you would like to restrict access to new displays by default, select User must be 
explicitly granted display access. New displays will not appear on the Open a 
Display list on the Displays menu and navigation pane unless an administrator 
accesses this screen and explicitly grants access. 

7 The User has access to: list shows all of your existing displays and lets you set the 
access level for each.  

8 Select the desired display and click in the column to the right to set the access level 
for that display. Options include: 

• Full Access – This is the default setting. It gives the user access to read and edit 
records, modify the display in the designer, and delete the display. 

Note 

 If the user is not granted full access to at least one 
display, the Work with Existing Displays section will 
not appear on the navigation pane. 

• Read / Edit Records – This gives the user full access to view add, edit, copy and 
delete records in the display, but not to edit the display in the designer or delete 
the display. If this is selected, the display does not appear in the Edit / Delete 
Display list, Export Design Template list, or the Copy Display list on the 
navigation pane or Displays menu. 
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• Read Only – This allows the user to open the display and to view records, but not 
add or edit records. If this is selected, only the navigation buttons on the display 
are available. The user will be able to view, but not edit records in list view. Also 
disabled are: 

Import 
Export 
Copy 
Create New Reports 
Manage Reports 
Save Lists 
Save Filters 
Save Sort 
Add, Delete, and Change in Links 

• No Access – This is the default setting if User Must be explicitly granted display 
access is selected. If this is selected, the display does not appear in the Open a 
Display list on the navigation pane or Displays menu, the Copy Display list, the 
Export Design Template list, or the Edit / Delete Display list.  

9 When you are satisfied with your selections, click OK to save the user’s security 
settings. 

Launching a Professional Edition Client 

When using Database Oasis Professional Edition, you are able to have more than one workstation 
sharing the same data. In this case, the machine where the data is stored is called the server. All of 
the other workstations connecting to that data are called clients. When Database Oasis is first 
installed, you select the computer where you want to install the data by designating it as the server. 
All other workstations are installed as clients, meaning they will share the data on the server instead 
of having data installed locally. 

Database Oasis Clients needs to know the path to where the data is installed in order to connect. The 
first time you log into a client, you will need to enter the path to the data file. You are also able to 
change the database a client installation is using by entering a different data path. 

Note 

 In order to connect to the data in the specified path, 
you will need to configure a file share in Windows. 
Refer to the heading Configuration for Professional 

Client Access, in the Installation chapter of this 
manual for more information.  
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Help Finding the Data Path 
When Database Oasis was installed, a default data folder named \DBOData was created. As part of 
installation, the administrator on the server computer must share the data folder so it is accessible to 
client computers. (Refer to the Configuration for Professional Client Access section in the 
Installation chapter for instructions.) 

If you are using Windows Vista or Windows 7, the data folder on the server computer is located in 
the path C:\ProgramData\DBOData. For all other operating systems, the data is located in the path 
C:\Documents and Settings\All Users\Application Data\DBOData.   

Note 

 If you don't see the data folder, it is usually because it 
is hidden in Windows. To unhide the folder, right 
click on your Windows Start button and select 
Explore from the menu to open Windows File 
Explorer. Select Folder Options from the Tools menu, 
then select the View tab. Make sure that the "Show 
hidden files and folders" option is selected. 

Hint 

 If you have trouble finding the path, you can search 
for the file dbmkSystem.vdb4 on the server machine. 

The C:\ in the path indicates that the files are on the local hard drive. When navigating to a machine 
on your network, the C:\ will be replaced with a machine designation. This is usually the machine 
name. If your network or Windows share is configured to use a designation other than the machine 
name, you will need to consult your network administrator to get the appropriate path information. 
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LAUNCHING THE SOFTWARE ON A CLIENT 

1 Launch Database Oasis from either the desktop or the program menu. 

2 The Locate Database Oasis Data Path screen will open: 

 

3 In the Data Path field, enter the path to the data file or press the ellipsis (…) button to 
open a Windows Browse for Folder screen where you can navigate to the path. 

4 Click OK. The Client installation will register the location of its server. Database 
Oasis will need to shut down. When you launch it again, the client will automatically 
open the database located in the specified path.  

Working with Clients 
There are very few differences between working on a Client and working on the Server.  

One major difference is that each time the client launches, it will check to make sure it can access 
the database located on the Server. This means that the computer where the database is installed 
should be left on so users will be able to access the database. 
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As long as Database Oasis is able to open the database, it will go straight into the software. If it 
cannot open the database, for example, if the Server computer is turned off, The Locate Database 
Oasis Data Path screen will reappear: 

 

If your Server has been moved to another computer, or the machine name has changed, you can 
enter a new machine name in the Data Path field. If the Server is just temporarily shut down, click 
Cancel to exit Database Oasis until the Server is back up. 

You can also change the Server in use with your Client at any time. This can be useful if you have 
information that you need to keep separated as it enables users working on Client installations to 
switch between Database Oasis databases.  

MANUALLY CHANGING THE SERVER 

1 Launch Database Oasis on the Client. 

2 Click on Select Server on the File menu: 
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3 The Locate Database Oasis Data Path screen will open: 

 

4 Enter the path to the data file in the Data Path field and click OK. 

5 Database Oasis will close. Relaunch the software to complete the connection. 
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Understanding New Display Options 

There are a number of different ways you can create new data displays, depending on what you’re trying 
to accomplish: 

• You can create a brand new display to contain your data. In this case, you start with a blank page 
and build your display by adding the elements you want to use. 

• You can import the design of a display someone else has created from a design template. A 
design template is a file that contains a description of a display. The software will read this file 
and create a display that matches the description. MKF Solutions has worked with people in 
different industries and with different interests to create a selection of sample displays for both 
professional and personal use. These displays are available as templates that can be imported into 
your installation of Database Oasis. Additionally, users of Database Oasis can create templates 
of their display designs that can be shared with other users. Once you’ve imported a design 
template, you can customize it to fit your needs. 

• You can copy the design of any of the displays in your system, including displays that were 
imported from templates and displays you’ve created yourself. This can be very useful if you 
have multiple displays that will contain similar data. 
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Hint 

 If a lot of your displays will store information about 
people, you might create a display that just contains 
contact information such as address and phone 
number fields. You can then save time by copying it 
when starting new displays. 

Creating a Display from a Blank Page 

If you could create a piece of software to contain any information you like, what would it look like? 
What types of information would you keep in it? Would it be straight-to-the-point-functional, or would 
you decorate it with graphics and creative fonts? 

Creating a display in Database Oasis is just that, designing a piece of software to fit your needs and 
personality. Of course, all of the technical parts of creating the software are handled for you. In just a 
few minutes you can go from a blank form to having a piece of software that is completely customized 
to you. 

CREATING A DISPLAY FROM A BLANK PAGE: 

1 Start a new display using one of the following methods: 

• From the Add a New Display section of the Navigation Pane, click Design a New 
Display: 

 

• From the File menu, select Add New Display. 

• Press Ctrl+N on your keyboard. 
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The Display Properties screen will open:  

 

2 Enter a unique name for your display in the Name field. This name will appear in the 
title bar of the form and in any display selection lists.  

3 The Background Color section controls the color of your display. The box will 
display the background color that is currently selected. The default color for displays 
is light gray. To select a different color, click the Change Color button. A Windows 
Color Picker screen will open. Select the desired color from the screen. (For more on 
using the Windows Color picker, see the Windows Basics section of Chapter 1.) 

4 The Wallpaper feature allows you to use a tiled graphic as the background of your 
display. If you would like to use wallpaper, click the Change Wallpaper button to 
open a Windows Open screen where you can select the picture you would like to use 
as your wallpaper. 

Warning! 

 Some graphics files can be very large. Every time you 
add or move something on your display, the system 
must redraw the graphic file. If you select a large 
graphic file, this can slow down work in the designer. 
If you find this happening, consider using a smaller 
graphic, or temporarily removing the background 
picture while you work in the display. 
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Note 

 If you select a wallpaper, the background color will 
only appear as the background color for boxes. 

5 If you have set a wallpaper and decide that you no longer wish to use it, click the 
Remove Wallpaper button to remove the picture from your display. The display will 
return to the selected background color. 

6 When you are satisfied with your selections, click Next > to proceed to the display 
designer where you will add the fields and other objects to your display. See 
Exploring the Display Designer, later in this chapter, for more information. 

Creating a Display from a Design Template 

In addition to the sample displays that were installed with Database Oasis, a number of additional 
templates that were available when you purchased the software were installed in the \Templates folder 
under your installation path (“c:\program files\database oasis” by default). A Templates.pdf file was also 
installed to that path, which gives a brief description of the templates that were included with your 
installation.  

New templates are also periodically released. These templates can be accessed from the 
www.DatabaseOasis.com web site. 

IMPORTING A DESIGN TEMPLATE 

1 Import a template using one of the following methods: 

• From the Displays menu, select Import Design Template.  
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• From the Navigation Pane, select Import Design Template: 

 

2 The Import Design Template screen will open: 

 

3 The Template File field displays the path and file name of the template you are 
importing. To populate this field, click the button to open a Windows Open dialog 
box where you can navigate to the desired template file. This will default to the 
\Templates folder under your installation path. If you have downloaded a template 
file to another location, navigate to that folder. Template files have the extension 
.mktx. Highlight the template file and click Open.  

Note 

 Templates created prior to version 3.0 have an 
extension .mkt. 

4 Click OK to import the selected template. There will be a pause as a new display is 
added from the template in the file. The new display will be given the same name as 
the original display from which the template was created. If there is already a display 
with that name, the name will be followed by (1) or the next available consecutive 
number. 

5 The display is now installed and ready to use. If you wish to make any modifications 
to the display, see Accessing Imported or Copied Displays in the Designer, later in 
this chapter, for instructions. 
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Creating a Display by Copying 

Copying a display design allows you to make a copy of the structure of your display, including the fields 
you have set up and the screen design. This is useful if you need to store data that is similar to what is 
stored in an existing display, but want to keep them separate. Once you have a copy of the display, you 
can modify it without impacting the original display. 

Note 

 This feature only copies the structure of the display, 
not the data contained in the display. 

COPYING A DISPLAY 

1 Copy a display using one of the following methods: 

• From the Displays menu, select Copy Display Design  

• From the Navigation Pane, select Copy Display Design: 
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2 The Copy Existing Display form will open: 

 

3 The Existing Display list will contain all of the displays you currently have set up. 
Select the display whose design you would like to copy from the list. 

4 Enter a unique name for the new display in the New Display Name field. 

5 Click OK to begin copying the selected display. There will be a pause as a new 
display is added.  

6 The display is now installed and ready to use. If you wish to make any modifications 
to the display, see Accessing Imported or Copied Displays in the Designer, below, for 
more information. 

Accessing Imported or Copied Displays in the 

Designer 

Once the display has been successfully copied or imported, you may wish to open it in the designer so 
you can make modifications. 

ACCESSING A DISPLAY IN THE DESIGNER 

1 Use one of the following methods to access your display in the designer: 

• From the main screen in Database Oasis, select Edit/Delete Existing Displays 
from the File menu. 

• Press Ctrl+E on your keyboard. 
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• If you have the Navigation Pane open, select Edit or Delete a Display from the 
Work with Existing Displays box: 

 

2 The Display Maintenance screen will open: 

 

3 Highlight your new display on the list and click the Edit button. 

Note 

 If you are in Basic Edition, you will not be able to 
edit a display that was created in Professional Edition 
if it includes Professional only functionality. 
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4 The display designer will open to the selected display. 

Exploring the Display Designer  

When you first open the display designer, you will be at the Designer Welcome screen: 

 

This screen provides a brief summary of how to use the designer, as well as links to more detailed 
information and demos. You must close this screen before proceeding to work in the designer. 
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CLOSING THE DESIGNER WELCOME SCREEN 

1 Click the Start Working with Your Display Now button or the red X in the upper 
right-hand corner of the screen to close the Designer Welcome screen. 

2 The next time you access the designer, this screen will appear again. If you do not 
wish it to appear, unmark the Display this page when opening the designer check box. 
If this check box is not marked, the Designer Welcome screen will not appear unless 
you open it. 

3 If you close the screen and wish to access it again, select Designer Welcome Form on 
the Work with Designer menu. 

Once the Designer Welcome screen is closed, you will be able to view the display designer. The display 
designer is the work area where you will create and edit your displays. It's broken up into four sections: 
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Display 
This is a visual representation of the display you are creating. The way the display looks in the 
designer is exactly how it will look when you actually use the display in working mode. 

Note 

 When the display is opened in working mode, a menu 
bar will appear at the top of the page. The display will 
be slightly larger to accommodate this menu. 

If you are designing a new display from a blank page, the only thing appearing on the display itself 
will be the standard set of buttons. These buttons will be used when you are not in the designer to 
work with the records in your display. They are shown in the designer to allow you to control 
elements of their appearance, including position on the screen, size, and text.  

You will build your display by adding items from the toolbox on the left. If you have added a new 
display by importing or copying, the items that were in the design template will appear on the new 
display. 

Work Area  
The work area is the blank area around your display that allows you to change the size of your 
display. See Sizing a Display in Working with Displays in the Designer section of Chapter 6 for 
instructions. 

Tools Pane 
The Tools pane gives you quick access to the options you will use most frequently in the designer.  

Note 

 This section provides quick reference for the options 
available in the Tools pane. Detailed instructions on 
each of these items are included in Chapter 6, 

Building and Editing Displays. 
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Each of the four sections in the Tools Pane can be collapsed or expanded. When you first enter the 
designer, the Work with Selected Objects section is collapsed by default. 

EXPANDING OR COLLAPSING A SECTION OF THE TOOLS PANE 

1 Click on the double arrow at the top of the section: 

 

2 If you expand a section, the double arrow will point up and the options in the section 
will appear. If you collapse a section, the section will collapse to a header and the 
double arrow will point down. 

 

In the example above, the Toolbox section has been collapsed and the Work with 
Selected Objects section has been expanded. 

Hint 

 This is particularly useful if you are running in 800 x 
600 screen resolution as it will allow you to collapse 
sections you are not currently using so you can view 
the tips section without scrolling. 

This pane appears by default when you first access the designer. You may close and reopen this pane 
to adjust the amount of room available in the work area. 
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CLOSING THE TOOLS PANE 

1 Select Show Tool Pane from the Work with Designer menu: 

 

2 The check mark will disappear from the menu item and the Tools pane will close. 

Note 

 If you close the Tools pane, it will not automatically 
appear if you exit and come back into the designer. 
You must reopen the Tools pane using the steps 
below. 

REOPENING THE TOOLS PANE 

1 From the Work with Designer menu, select Show Tool Pane. 

2 The tools pane will reappear. 

Toolbox 
The Toolbox contains the items you can add to the display. The tools available in the toolbox 
include: 

 Pointer - The pointer is the one tool that is not used to add an item to the display. Instead it is 
the tool that is used when you want to select objects on the display. It can also be used to click 
off another tool if you decide you do not want to add that item. 

 Logo - The Logo tool lets you decorate your display by adding pictures to the background of 
the display, such as a company logo. You can add as many pictures as you like, so this can also 
be used to add banners and other graphics to the display.  

 Box - The Box tool lets you draw a box on the display. This is most often used to help group 
common items together for a more organized display.  

 Label - The Label tool lets you put text on your display. This can be used to describe 
sections of fields or give instructions.  



  Exploring the Display Designer 

Chapter 5 – Creating New Data Displays  ♦  Page 105 

 Text Field – Fields are the elements of a display that will actually contain your data. Text 
Fields are the most common type of field you will have in your displays. They can contain 
letters, numbers, and symbols such as @ # {}.  

 Numeric Field - Numeric Fields are similar to text fields, except that they can only contain 
numbers.  

 Auto Incrementing Field – Auto Incrementing fields are numeric type fields that 
automatically increases by one for each new record. They are commonly used to assign a unique 
number to each record. 

 Notes - Notes Fields are also similar to text fields, except that you can enter multiple lines of 
data. Where you would use a text field to store a name, you might use a notes field to keep notes 
on conversations you have had with the person. 

 Date Field – Date fields are used to store dates. When entering data in the field, you can 
select the date from a calendar. Database Oasis will recognize the value as a date, allowing you 
to sort records chronologically, or filter and search for records based on the selected date. 

 Check Box - A Check Box is a Yes/No flag that is displayed as a box. A mark in the box 
means yes. If the box is unmarked, it means No. 

 List Field - List fields allow you to pre-configure a list of items that can be entered in the 
field. When users click on an arrow next to the field, the list appears. Selecting an option from 
the list places that item in the field, facilitating quick and consistent data entry. 

 Calculated Field - Calculated Fields are an advanced type of field. They let you perform a 
calculation in a field instead of just displaying static data.  

 Picture Field - Picture Fields let you have record-specific graphics. For example, you might 
have a display that contains a coin collection with a picture of the coin for each.  

  Child Rollup – If you have a child display set up in Professional Edition, you can have 
multiple child records associated with each parent record in this display. Child rollups allow you 
to view a table with information from the child level. As you scroll through your records, the 
information will update to reflect the children associated with the current parent record. 

Work with Selected Objects Box 
This set of tools provides quick access to some of the most common functions you will perform with 
objects on the display.  

Object Properties - When you first add an object, you will be able to set the object’s properties, 
such as whether or not to display field names and the size of the fonts. Object Properties allows 
you to get back into these settings for an existing object.  

Delete Object – This removes an object and any related data from your display.  

Bring to Front - This lets you move an existing item in front of any other items on the display.  

Send to Back – This option allows you to make sure an object appears behind any other objects 
on the display. This is especially useful for boxes and logos where you may want fields to appear 
on top of the item. 
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Center Vertically On Display – This is used to center an object or a group of objects relative to 
the height of the display.  

Center Horizontally On Display - This is used to center an object or a group of objects relative to 
the width of the display.  

Work with Child Displays Box 
This section provides access to adding and editing child displays. It is only available in Professional 
Edition. 

Create Child Display - This menu option appears in Professional Edition and allows you to 
create a sub-display that is linked to the current display. This allows you to have multiple child 
records attached to a single parent record. For example, this might be used to add jobs to a 
customer display, or individual payments to an invoice. (See the Creating Child Displays 
section, later in this chapter, for more information.) 

Edit/Delete Child Display - This menu option appears in Professional Edition and allows you to 
edit any child displays you’ve created for this parent display. 

Work with the Designer Box 
This box gives you access to the most common functions that are related to the display designer as a 
whole, rather than a selected object. 

Display Properties - When you first added your display, you were able to enter the name, and 
select a background color and wallpaper, if desired. Display Properties allows you to access 
those settings again and make any necessary changes. 

See Display Properties in the Working with Displays in the Designer section of Chapter 6 for 
more information on display properties. 

Save and Close - When you are done working in the designer, select Save and Close to save your 
changes and return to the main work area. 

Tips 
This section provides quick tips about the selected tool or highlighted button. As you click on tools 
or move your mouse over buttons, this information will update with tips for the current Tools object. 

Menu 
The designer menus appear at the top of the designer screen. They contain all of the options you can 
select when working with your displays. Many of these options are also included in the Tools pane.  

Note 

 This section provides quick reference for the options 
available on the menu. Detailed instructions on each 
of these items are included in Chapter 6, Building and 

Editing Displays. 
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Work with Designer Menu 
The Work with Designer menu items include:  

Set Tab Order – By default, the tab key on your keyboard will take you through the fields in your 
display in order from top to bottom / left to right. This option lets you set a different tab order. 

Display Properties – When you first added your display, you were able to enter the name, and 
select a background color and wallpaper, if desired. Display Properties allows you to access 
those settings again and make any necessary changes. 

Designer Welcome Form – The Designer Welcome screen is the page that comes up when you 
first launch the designer. This option allows you to reopen that screen if you have closed it or if 
you have elected to have it not appear when launching the designer. 

Show Tool Pane – This option will open and close the Tools Pane. 

Save Display – Depending on what you’re doing in the designer, Database Oasis may 
automatically save as you work. If you would like to manually save, you may select this option. 

Save and Close Designer – When you are done working in the designer, select Save and Close 
Designer to save your changes and return to the main work area. 

Layout Menu 
The Layout menu items include:  

Bring to Front – This lets you move an existing item in front of any other items on the display. 

Send to Back – This option allows you to make sure an object appears behind any other objects 
on the display. This is especially useful for boxes and logos where you may want fields to appear 
on top of the item. 

Center Horizontally on Display – This is used to center an object or a group of objects relative to 
the width of the display. 

Center Vertically on Display – This is used to center an object or a group of objects relative to 
the height of the display. 

Align Left Edges – This option is used make sure that the left edges of all selected objects are 
perfectly aligned in a vertical row. 

Align Right Edges – This option is used to make sure that the right edges of all selected objects 
are perfectly aligned in a vertical row. 

Align Top Edges – This option is used to make sure that the top edges of all selected objects are 
perfectly aligned in a horizontal row. 

Align Bottom Edges – This option is used to make sure that the bottom edges of all selected 
objects are perfectly aligned in a horizontal row. 

Align Vertical Centers – This option allows you to center objects in a vertical line based on the 
objects’ vertical centers. (If you drew a vertical line through the center of an object, this is the 
vertical center.) 

Align Horizontal Centers –This option allows you to center objects in a horizontal line based on 
the objects’ horizontal centers. (If you drew a horizontal line through the center of an object, this 
is the horizontal center.) 

Delete – This removes an object and any related data from your display. 
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Properties – When you first add an object, you will be able to set the object's properties, such as 
whether or not to display the prompt and the size of the fonts. Object Properties allows you to get 
back into the settings for an existing object.  

 Child Displays Menu 
The Child Displays menu items include:  

Create Child Display – This menu option appears in Professional Edition and allows you to 
create a sub-display that is linked to the current display. This allows you to have multiple child 
records attached to a single parent record. For example, this might be used to add jobs to a 
customer display, or individual payments to an invoice. (See the Creating Child Displays 
section, later in this chapter, for more information.) 

Edit Child Display – This menu option appears in Professional Edition and allows you to edit 
any child displays you’ve created for this parent display. 

Once you are familiar with the designer, you are ready to start building your display. 
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Working with Displays in the Designer 

When you first open the designer, your display will appear in the default size using the settings you 
selected in the Display Properties screen. The standard button set will appear at the bottom of the screen: 

 

You may adjust these settings at any time. 
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Sizing a Display 
The size of the display can be adjusted at any time to accommodate the objects you place on it. 

CHANGING THE SIZE OF A DISPLAY 

1 When you hover your mouse over the edge of a display, it will change to a double 
headed arrow. When the arrow appears, click and drag on the edges of the display to 
change the size.  

2 Drag on the right edge to make the display wider or narrower.  

3 Drag on the bottom edge to make the display taller or shorter.  

4 Click and drag on the small white box in the lower right corner of the display to size 
the display in both directions at once. 

Customizing the Buttons 
The basic button set appears on all new displays: 

 

These buttons will be used when you are not in the designer to work with the records in your display. 
They are shown in the designer to allow you to control elements of their appearance, including position 
on the screen, size, and text. (See the Working With Objects on the Display section, later in this chapter, 
for information about moving and sizing objects.) 

You can control the color and text of the buttons using Button Properties. 

CHANGING THE APPEARANCE OF BUTTONS 

1 Select the button whose properties you would like to change. 

2 Access button properties using one of the following methods: 

• Double click on the button on the display. 

• Select Object Properties from the Work with Selected Object section of the 
Tools pane. 

• Select Properties from the Layout menu. 

• Right click on the object and select Modify Object Properties from the right 
click menu. 
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3 The Button Properties screen will open for the selected button: 

 

4 If you would like to change the text that is displayed on your button, enter a new 
name in the Name field. 

Note 

 Changing the name will not change the functionality 
of the button. 

Note 

 If your entry is longer than the existing name, you 
may need to resize your button to accommodate it. 

5 If you would like to change the font style that appears on your button, click the Font 
button to open a font selection screen. The sample text will display what your font 
will look like. 

6 By default, buttons are the standard light gray in color. If you would like to use a 
different background color for your button, click the Color button to select a color 
from the Windows color picker. The box next to the Color button will display the 
background color of your button. 

7 Click the OK button to save the changes to your button. 

Display Properties 
Display Properties automatically come up when you first add your display. You can get back into these 
properties again at any time to adjust the initial settings you entered. 
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CHANGING THE DISPLAY PROPERTIES 

1 There are two ways to access Display Properties: 

• Select Display Properties from the Work with the Designer Box in the Tools 
pane. 

• Select Display Properties from the Work with Designer menu. 

The Display Properties screen will open: 

 

2 If you wish to change the display name, enter a new unique name for your display in 
the Name field. 

3 If you wish to change the background color of your display, click the Change Color 
button. A Windows color picker screen will open. Select the desired color from the 
screen. (For more on using the Windows Color picker, see the Windows Basics 

section of Chapter 1.)  

4 If you wish to add or change a wallpaper on the display, click the Change Wallpaper 
button to open a Windows Open screen where you can select the picture you would 
like to use as your wallpaper.  
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Warning! 

 Some graphics files can be very large. Every time you 
add or move something on your display, the system 
must redraw the graphic file. If you select a large 
graphic file, this can slow down work in the designer. 
If you find this happening, consider using a smaller 
graphic or temporarily removing the graphic while 
working in your display. 

Hint 

 Windows provides several graphics files for use as 
desktop wallpaper that can be used on your display. 
These are generally located in the c:\windows or 
c:\winnt\ directory on your computer, depending on 
your operating system.  

5 If you have set a wallpaper and decide that you no longer wish to use it, click the 
Remove Wallpaper button to remove the picture from your display. The display will 
return to the selected background color. 

6 When you are satisfied with your selections, click OK to return to the display 
designer. Your changes will be reflected in the display.  

Display Design  
As you are creating your displays and setting the background color or wallpaper, there are a few 
design elements that you should keep in mind: 

• It can be a lot of fun to play with bright colors, but if you will be spending a lot of time in a 
display, you may find that more muted tones will be easier on your eyes. 

• Making sure that the edges of your fields line up where possible will make a big difference in 
how your display looks. 

• If you are using both a background color and wallpaper, the background color will be used 
for boxes and the background of text objects, such as labels, check boxes, and the names of 
fields. 
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Looking at a sample display design, you may select the “River Sumida.bmp” file provided 
with Windows XP, which looks like this: 

 

If you select this as the wallpaper for a display, it will tile to look like this: 

 

Once you have selected the graphic file you would like to use, it is recommended that you find a 
background color that compliments the graphic. The background color will be used for boxes and 
text on the display.  

Looking at the above example, the standard gray could work with this background picture, however, 
a color with a little more blue will compliment it slightly better. For example, accessing Display 
Properties and entering the red/green/blue values red=215, green=217, blue=219 in the Windows 
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Color Picker's Define Custom Color section creates a color that compliments this graphic nicely. 
Using those color setting, boxes and text items added to the display will look like this: 

 

For this example, we also changed the button properties of each button to use the display's 
background color. (See Customizing the Buttons, earlier in this section, for instructions.) 

Adding Objects to a Display 

Once you are satisfied with your initial display settings, you are ready to start adding objects to your 
display. The objects that you can add to a display fall into two categories: 

• Design elements are used to customize the appearance of the display. These objects do not 
contain data, but rather help you organize and decorate the display. Design elements will be 
the same for every record in your display. Design elements include logos, boxes, and labels. 
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• Data elements are the objects that will contain your data. These objects are fields that appear 
on the display as an empty frame. The data that is placed in the field will be different for 
every record. Data elements include text fields, numeric fields, notes fields, calculated fields, 
check boxes, and picture fields.  

All of these objects are added using the Toolbox. 

Using the Toolbox 
The toolbox in the Tools pane provides access to all of the objects that you can add to a display.  

 

Hint 

 Use the scroll box to see additional tools. 

There are three ways you can add an item from the toolbox to a display: Double Click, Drag and 
Drop, and Click and Size. 

ADDING ITEMS FROM THE TOOLBOX USING DOUBLE-CLICK 

1 Use the scroll bar on the right side of the toolbox to locate the tool you would like to 
use. 

2 Double click on the tool for the item you would like to add to your display. The 
properties box for the item will open.  
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3 Set the properties for the item using the appropriate Setting Object Properties section, 
below. When you save the properties, the item will appear in the upper left corner of 
the display in the default size.  

4 Move the item to the appropriate location on the display and size as needed using the 
instructions under Working with Objects on the Display, later in this chapter. 

5 If you add multiple items in this fashion, they will be added on top of each other. You 
will need to click on each item and drag it into the desired position and size it if 
necessary. 

ADDING ITEMS FROM THE TOOLBOX USING DRAG AND DROP 

1 Use the scroll bar on the right side of the toolbox to locate the tool you would like to 
use. 

2 Click on the desired tool in the toolbox and hold down the left mouse button while 
you move the mouse to the desired position on the display. Your mouse will appear 
like this: 

 

When you release the mouse, the properties box will open.  

3 Set the properties for the item using the appropriate Setting Object Properties section, 
below. When you save the properties, the new item will appear where you dropped it 
in the default size.  

4 Size the item as necessary using the instructions under Working with Objects on the 

Display, later in this chapter. 

ADDING ITEMS USING CLICK AND SIZE 

1 Use the scroll bar on the right side of the toolbox to locate the tool you would like to 
use. 

2 Select a tool from the toolbox by clicking on it with a single click of the mouse.  

3 Draw the outline for the item on the display by clicking on the point in the display 
where you want the field to appear and holding the mouse button as you drag the item 
to the desired size. A box will appear where you drag, indicating the size that the item 
will be:  

 



  Adding Objects to a Display 

Chapter 6 – Building and Editing Displays  ♦  Page 118 

When you release the mouse, the properties box will open.  

Hint 

 If you click on the screen instead of dragging, the 
object will be placed where you click in the default 
size. 

4 Set the properties for the item using the appropriate Setting Object Properties section, 
below. When you save the properties, the new item will appear in the location and 
size of the box. 

Note 

 The height of text fields, numeric fields, and 
calculated fields is determined by the font that is used 
for the data in the field. The system will automatically 
adjust the field to the appropriate height to contain 
your data, but the width will remain the size that you 
specify. 

Setting Object Properties 
When you add items to your display from the toolbox, you will need to enter some basic information 
about the object, such as the name and font you would like to use. A properties box will open for 
each item you add, allowing you to fill in information relevant to that object. The following sections 
discuss each type of object you can add and provide instructions on completing the properties. 

Using Logos on Your Display 
The Logo tool allows you to place a picture, such as a logo, on your display. These differ from 
picture fields in that the same picture will appear on every record in your display. This tool can be 
used in many different ways. For example, you might use logos to place a company logo on a 
display: 
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The logo tool can also be used if you would like to use a background picture that fills the display, 
but do not want it to tile. For example, I may want to use this graphic as my background: 
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If this was selected as the wallpaper and the display was smaller than the graphic, the graphic would 
be cut off. If the display was larger than the graphic, the graphic would tile. To avoid this, I can use 
the logo control to size this graphic to fit my display and put it behind my fields: 

 

You can also use the logo tool to call attention to items on your display or to create your own 
decorative boxes and lines: 

 

In this sample, there are two graphics on the page, the bar between the sections and the multi-colored 
arrow. 

Many of the sample templates that were provided with your software or that are available for 
download from the www.databaseoasis.com website make use of the logo tool. You can review 
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these displays to help get additional ideas on using graphics on your displays. The graphics that were 
used with any of the displays that you have downloaded are all available to you in the “c:\program 
files\database oasis\graphics” folder, including a selection of horizontal and vertical lines that can be 
used on your display. 

Warning! 

 Some graphics files can be very large. Every time you 
add or move something on your display, the system 
must redraw the graphic file. If you select a large 
graphic file, this can slow down work in the designer. 
If you find this happening, consider using a smaller 
graphic. 

ENTERING LOGO PROPERTIES 

1 Add a logo to your display using one of the methods detailed in the Using the 

Toolbox section, above. The Logo Properties screen will open: 

 

2 From the Select Image field, enter the path and file name of the picture file you would 
like to use, or click the button next to the field to access a Windows Open dialog box 
where you can navigate to the file.  
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Note 

 Once a graphic has been added as a logo, it is stored 
in the database. If you make any changes to the 
graphic file, you will need to access Logo Properties 
and select the graphic again. 

3 The If Logo and Frame are Different Sizes radio buttons control how the picture 
should be handled if it does not fit within the frame that you have drawn for it.  

• The Resize to Fit, Maintaining Ratio option will resize the picture to fit the 
frame, while using padding to maintain the height to width ratio of the image 
so it does not distort the picture. The edge (horizontal or vertical) of the 
picture that is proportionally the largest in comparison to the frame will be 
stretched or shrunk to fit within the frame. The proportionally smaller edge 
will be padded. 

• Stretch/Shrink to Fit Frame will resize the picture to fit within the frame. If 
the picture is larger than the frame, it will be shrunk to fit. If the picture is 
smaller than the frame, it will be stretched to fit. If the dimensions of the 
picture are not proportional to the frame, the picture could be distorted when 
resized. 

• Show Center of Picture and Crop Edges will center the picture within the 
frame. If the picture is larger than the frame, the edges will be trimmed to fit. 
If the picture is smaller than the frame, it will be centered with space around 
the edges. 

Hint 

 Select this option if you are using one of the 
horizontal or vertical lines that provided in your 
“c:\program files\database oasis\templates\graphics” 
folder. 

• The Crop Right and Bottom Edges option is similar to center and crop, but 
instead of centering, the picture is anchored to the upper left corner of the 
frame. If the picture is larger than the frame, it will be trimmed at the bottom 
and right edges. If the picture is smaller than the frame, there will be space 
around the bottom and right edges. 
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4 The sample picture at the bottom of the screen will show roughly how the picture will 
look with the different options. This can be used to help select the best sizing option 
for your graphic.  

Note 

 Since this frame will not necessarily be of the same 
dimensions as the picture you are adding to the 
display, this is only an approximation. If the selected 
option does not work well with your display once 
you’ve saved the picture, you can access Logo 
Properties again by selecting Object Properties from 
the Tools Pane and adjust your settings. 

5 When you are satisfied with your settings, click OK. The graphic will be added to 
your display.  

 Using Boxes on Your Display 
Boxes are used to make separations between groups of related objects. For example, you may have a 
display that contains basic customer information in one section, and job details in another. In this 
case, you may want to place a box around each of the groups of fields to create a logical separation. 
This not only makes the display more aesthetically pleasing, but also helps to make it easier to use. 

ENTERING BOX PROPERTIES  

1 Add a box to your display using one of the methods detailed in the Using the Toolbox 
section, above. The Box Properties screen will open: 
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2 You have the option of having a title appear at the top of your box to identify the 
contents. If you would like to use a title, enter it in the Box Text field. If you would 
prefer to have a plain box, leave this field blank. A box with the text will look like 
this: 

 

A box without text will look like this: 

 

3 If you have entered a title for your box, and would like to change the font used for the 
title, click the font button to open a Windows Font selection screen. The sample will 
show the font that is currently selected. 

4 Click OK to add the box and return to the display. 

 Using Labels on Your Display 
Labels are on-screen text objects that are not attached to a field. They can be used to provide 
explanations, instructions, or to personalize your display.  

Hint 

 Field prompts have to be unique; labels do not. Most 
field type objects give the option to display a prompt 
with the field. If you would like to use the same 
prompt for multiple fields, you can elect to not 
display the prompt and create labels instead. 
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ENTERING LABEL PROPERTIES 

1 Add a label to your display using one of the methods detailed in the Using the 

Toolbox section, above. The Label Properties screen will open:  

 

2 Use the Label Text field to enter the text that you would like to appear in your label. 

Note 

 Labels will appear as a single line. If you need your 
label to wrap to multiple lines, break the text up into 
separate labels. 

3 If you would like to change the font used for the label, click the font button to open a 
Windows Font selection screen. The sample will show the font that is currently 
selected. 

4 Click OK to save your label. 

 Using Text Fields on Your Display 
Fields are used to store your data. Text fields are generally the most common objects used in most 
displays. Text fields allow you to enter any type of character, digit, or special character in the field. 
There are only four occasions when your data would not be stored in a text field: 

• If you need to store freeform notes with the ability to wrap the data to multiple lines. 
In this case, you would use a notes field. 

• If your data is a yes/no answer to a question, such as whether a customer will accept 
advertisement mailings. In this case, you could choose to use a text field and type 
“Yes” or “No” in the field, but it would be easier to use a check box instead. 

• If your data is a picture that you would like to display with the record. In this case 
you would use a picture field. 
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• If you need to store some types of numbers. In some cases, you should store numbers 
in a numeric field, rather than a text field.  

When thinking about whether to use a text field or a numeric field for numeric data, there are two 
things you need to consider: whether you might ever want to store anything besides numbers (such 
as special characters) in the field, and whether the numbers you will be storing should be read as a 
single number, or a series of digits.  

Take, for example, a phone number. You will generally want to use the ( ) and - formatting 
characters with a phone number. In this case, you will need to use a text field rather than a numeric 
field.  

Additionally, when you place numbers in a text field, the software reads them as a string of 
individual digits. For example, in a text field, 10 is read as one, zero. When you use a numeric field, 
the software recognizes the digits as one number. In this case, 10 will be read as ten. This becomes a 
factor when sorting the contents of the field.  

Again, using the phone number example, you would want the software to read and sort phone 
numbers as a series of digits. For example, (760) 555-1962 should be read as 7 6 0 5 5 5 1 9 6 2 
rather than 7,605,551,962 (seven billion, six hundred five million, five hundred fifty-one thousand, 
nine hundred sixty two). 

For an easy rule of thumb, unless you intend to do math calculations on the numbers contained in the 
field, consider using a text field. 

ENTERING TEXT FIELD PROPERTIES 

1 Add a text field to your display using one of the methods detailed in the Using the 

Toolbox section, above. The Text Field Properties screen will open: 

 

2 Enter a unique name that describes this field in the Name field.  

3 If you would like to include the name with the field on the display, mark the Show 
Name on Display check box. Unmark it if you do not want the name to display. If this 
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is unmarked, the name will not appear on the display, but will be used to identify the 
field in list view windows and anywhere else the field is referenced.  

For example, you may have an address that contains the street address on one line, 
and City, State, and ZIP on the next line. If you want City, State, and ZIP next to each 
other with no prompt in between, you could unmark Display Prompt on each of these 
fields and put a label next to the entire line instead: 

 

4 If you are displaying the name, the Font for Name setting controls the font that will 
be used for the name. If you would like to change the font, click on the button to 
select a font from the Font selection screen. The sample text will display the font that 
will be used. 

5 The Font for Data setting controls the font that will be used for the data you enter in 
your field. If you would like to change the font, click on the button to select a font 
from the Font selection screen. The sample text will display the font that will be used. 

6 The Background Color field lets you control the background color of the text field. 
(This is the area where you will type your text in the field.) The default color is white. 
If you would like to use a different color, click the button to open the Windows Color 
picker. The box on the screen will display the selected color. 

7 The Length setting controls how much text can be contained in your field. For 
example, if this is set to 30, you will only be able to enter up to 30 characters in the 
field. Field lengths are practically unlimited, but you should be aware that storage 
space will be reserved for the entire field length for each record, regardless of how 
much text is actually contained in the field. Additionally, if you enter more data in the 
field than can be contained in the display area, you will only be able to view all of the 
text if you click in the field and scroll to the right. 

Note 

 If you have fields that need to contain a lot of data, 
consider using a Notes Field instead. This type of 
field only reserves space for the actual data that’s 
contained in the field and it has the added advantage 
of wrapping data onto multiple lines, making it easier 
to view. 

8 Click OK to save your field and return to the display. 
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 Using Numeric Fields on Your Display 
Numeric fields are special fields that contain only numbers. The only exceptions are that you will be 
able to place a decimal point (.) in the field, and/or the dash (-) at the beginning of the field to 
indicate that a number is negative. Commas will also automatically appear in the field as thousands 
separators. 

Although you can place numbers in a text field, the software reads them as a string of individual 
digits. When you use a numeric field, the software recognizes the digits as one number. For example, 
in a numeric field, 10 will be read as ten. In a character field, 10 is read as one, zero. If you intend to 
do math calculations on the numbers contained in the field, you must use a numeric field. If you will 
need formatting characters with your number, such as the ( ) and - in a phone field, or the / in a date 
field, select a text type field instead. 

Note 

 For more information on whether to use a numeric or 
character field to contain numbers, refer to the Using 

Text Fields on Your Display section, above. 

ENTERING NUMERIC FIELD PROPERTIES 

1 Add a numeric field to your display using one of the methods detailed in the Using 

the Toolbox section, above. The Numeric Field Properties screen will open: 

 

2 Enter a unique name that describes this field in the Name field.  

3 If you would like to include the name with the field on the display, mark the Show 
Name on Display check box. Unmark it if you do not want the name to display. If this 
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is unmarked, the name will not appear on the display, but will be used to identify the 
field in list view windows and anywhere else the field is referenced.  

For example, you may have a column of similar numbers. In this case, you might 
choose not to display the name for each filed and use a label at the top of the column 
instead: 

 

4 If you are displaying the name, the Font for Name setting controls the font that will 
be used for the field name on the display. If you would like to change the font, click 
on the button to select a font from the Font selection window. The sample text will 
display the font that will be used. 

5 Font for Data controls the font that will be used for the data you enter in your field. If 
you would like to change the font, click on the button to select a font from the Font 
selection window. The sample text will display the font that will be used. 

Hint 

 The most common type of font is a proportional font. 
A proportional font spaces the characters based on the 
width of each character, so the letter i takes up less 
space than the letter w. A non-proportional font 
assigns the same amount of space to each character, 
regardless of the width of the character. Non-
proportional fonts are useful if you have columns of 
numbers you would like to line up. One of the most 

common non-proportional fonts is Courier New. 

6 The Background Color field lets you control the background color of the numeric 
field. (This is the area where you will type your number in the field.) The default 
color is white. If you would like to use a different color, click the button to open the 
Windows Color picker. The box on the screen will display the selected color. 
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7 The decimal place radio buttons allow you to specify how many decimal places your 
field should use. If you do not require a specific number of decimal places for the 
data in the field, leave the Use Variable Number of Decimal Places radio button 
selected.  

If this option is selected, the field will default to 0 with no decimal point. You will be 
able to place a decimal point in the field and have up to six decimal places following. 
For example, the field could contain 1, 1.5, or 1.25. Any zeros at the end of a decimal 
will be stripped off (e.g., if you enter 1.30, it will appear as 1.3).  

8 If you would like to force the data to have the same number of decimal places in all 
records, select the Use Fixed Number of Decimal Places radio buttons. Enter the 
number of decimal places you would like to use in the Number of decimal places 
field by clicking the up arrow button to increase the number, or the down arrow 
button to decrease the number.  

If this option is selected, the field will default to 0. and the number of decimal places 
selected, for example 0.00. Using the earlier example with two decimal places, your 
field would contain 1.00, 1.50, and 1.25. 

Hint 

 If you would like to limit the field to whole numbers, 
set the number of decimal places to zero. 

9 Click OK to save your field and return to the display. 

 Using Notes Fields on Your Display 
Notes fields can contain an unlimited amount of data. The data will wrap to multiple lines within the 
field. If there is more data than will display in the frame of the notes field, scroll bars will appear at 
the right edge of the field to allow you to scroll down through the data. 
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ENTERING NOTES PROPERTIES 

1 Add a notes field to your display using one of the methods detailed in the Using the 

Toolbox section, above. The Notes Properties screen will open: 

 

2 Enter a unique name for the field in the Name field.  

3 If you would like to include the name with the field on the display, mark the Show 
Name on Display check box. Unmark it if you do not want the name to display. If this 
is unmarked, the name will not appear on the display, but will be used to identify the 
field in list view windows and anywhere else the field is referenced. 

4 If you are displaying the name, the Font for Name setting controls the font that will 
be used for the name on the display. If you would like to change the font, click on the 
button to select a font from the Font selection screen. The sample text will display the 
font that will be used. 

5 The Font for Data setting controls the font that will be used for the data you enter in 
your notes field. If you would like to change the font, click on the button to select a 
font from the Font selection screen. The sample text will display the font that will be 
used. 

6 The Background Color setting controls the background color of the notes field. (This 
is the area where you will type your text in the notes field.) The default color is white. 
If you would like to use a different color, click the button to open the Windows Color 
picker. The box on the screen will display the selected color. 

7 Click OK to save your field and return to the display. 
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 Using Date Fields on Your Display 
Date fields are used to store dates. Date fields appear on the display with a calendar icon. When 
entering data in the field, users can either type in the date, or click on the icon to select the date from 
a popup calendar.  

Data in the field will be formatted using your Windows date settings. Database Oasis will recognize 
the value as a date, allowing you to sort records chronologically, or filter and search for records 
based on the selected date. 

ENTERING DATE FIELD PROPERTIES 

1 Add a date field to your display using one of the methods detailed in the Using the 

Toolbox section, above. The Date Field Properties screen will open: 

 

2 Enter a name that describes this date in the Name field. 

3 If you would like to include the name with the field on the display, mark the Show 
Name on Display check box. Unmark it if you do not want the name to display. If this 
is unmarked, the name will not appear on the display, but will be used to identify the 
field in list view windows and anywhere else the field is referenced. 

4 If you are displaying the name, the Font for Name setting controls the font that will 
be used. If you would like to change the font, click on the button to select a font from 
the Font selection screen. The sample text will display the font that will be used. 

5 The Font for Data setting controls the font that will be used for the dates you enter in 
your field. If you would like to change the font, click on the button to select a font 
from the Font selection screen. The sample text will display the font that will be used. 

6 The Background Color field lets you control the background color of the date field. 
(This is the area where you will enter the date in the field.) The default color is white. 
If you would like to use a different color, click the button to open the Windows Color 
picker. The box on the screen will display the selected color. 
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7 Click OK to save your date field and return to the display. 

 Using Check Boxes on Your Display 
Check boxes are true/false flags that you can add to a display. For example, you may place a check 
box on your screen stating “Customer accepts mailers”  

Check boxes appear as a small box on the display. When you click in the box, a mark appears. Using 
the above example, a mark would indicate that the customer does accept mailers. No mark would 
indicate that the customer does not accept mailers. 

ENTERING CHECK BOX PROPERTIES 

1 Add a check box to your display using one of the methods detailed in the Using the 

Toolbox section, above. The Check Box Properties screen will open: 

 

2 Enter the text that you would like to use to describe what the check box should be 
used for in the Name field. This text will appear next to the check box on the screen. 
The name should be worded in such a way that a mark in the check box will indicate 
that the statement is true and no mark will indicate that the statement is false. 

3 If you would like to change the font that is used for the check box name, click the 
Font for Name button to open a Font selection screen. The sample text will show 
what your font will look like. 

4 This Default to radio buttons let you specify whether or not the check box should be 
marked by default. If you select Checked, the check box will be marked for any new 
records that are added to your display. If you select Unchecked, the check box will be 
unmarked for new records. You can mark or unmark the check box for individual 
records. 
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Note 

 If you add a check box to an existing display, the 
check box will be unmarked for all existing records, 
regardless of this setting. 

5 Click OK to save your settings and return to the display. 

 Using List Fields on Your Display 
List Fields allow you to pre-configure a list of items that can be entered in the field. List fields 
appear on the display with a small arrow to the right of the field. When users click on the arrow, a 
list of data entry items appears. Selecting an option in the list places that item in the field, facilitating 
quick and consistent data entry. 

For example, you may have a field for how the customer heard of your company. If users sometimes 
enter Phone Book and sometimes enter Yellow Pages, the entries will not appear together when 
filtering and sorting. Using a list field lets you standardize on one of the options and ensure that the 
data is consistent.  

ENTERING LIST FIELD PROPERTIES 

1 Add a list field to your display using one of the methods detailed in the Using the 

Toolbox section, above. The List Field Properties screen will open: 
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2 Enter a name that describes this field in the Name field. 

3 If you would like to include the name with the field on the display, mark the Show 
Name on Display check box. Unmark it if you do not want the name to display. If this 
is unmarked, the name will not appear on the display, but will be used to identify the 
field in list view windows and anywhere else the field is referenced. 

4 If you are displaying the name, the Font for Name setting controls the font that will 
be used. If you would like to change the font, click on the button to select a font from 
the Font selection screen. The sample text will display the font that will be used. 

5 The Font for Data setting controls the font that will be used for the data you enter in 
your field. If you would like to change the font, click on the button to select a font 
from the Font selection screen. The sample text will display the font that will be used. 

6 The Background Color field lets you control the background color of the numeric 
field. (This is the area where you will type your number in the field.) The default 
color is white. If you would like to use a different color, click the button to open the 
Windows Color picker. The box on the screen will display the selected color. 

7 The Items for List section allows you to set up the items that will appear in the list 
when the field is used. To add an item to the list, enter it in the Add to List field and 
click the Add button. The option will appear in the Items in the List area. 

8 The Items in List box displays the options that will be available in the list when the 
field is used on the display. To remove an item from the list, highlight it in the Items 
in the List box and click the Remove button. The item will disappear from the list. 

9 The Select from List Only check box allows you to control whether users are able to 
type in the field, or must select from the list. If this check box is marked, users will 
not be able to manually type an entry in the field and must select from the list. If it is 
unmarked, users will be able to select from the list for faster data entry, but will also 
have the option of manually typing in the field if the desired data is not in the list. 

10 Click OK to save the field. 

 Using Picture Fields on Your Display 
Picture Fields allow you to include record-specific pictures with your display. For example, if you 
have a display that catalogues collectibles, you may include a picture of each item in your collection 
with its description. 
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ENTERING PICTURE FIELD PROPERTIES 

1 Add a picture field to your display using one of the methods detailed in the Using the 

Toolbox section, above. The Picture Properties screen will open: 

  

2 Enter a name that describes this field in the Name field. 

3 If you would like to include the name with the field on the display, mark the Show 
Name on Display check box. Unmark it if you do not want the name to display. If this 
is unmarked, the name will not appear on the display, but will be used to identify the 
field in list view windows and anywhere else the field is referenced. 

4 If you are displaying the name, the Font for Name setting controls the font that will 
be used. If you would like to change the font, click on the button to select a font from 
the Font selection screen. The sample text will display the font that will be used. 

5 When you add a picture field to a display, you draw a frame which sets the size of the 
picture. The pictures you add to your records may not be the exact size of the frame. 
The radio buttons on this screen control how pictures are adjusted to fit within the 
frame. 
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To demonstrate the options, we'll use two graphics of different sizes: 

         

With a frame that is this size: 

 

• The Resize to Fit, Maintaining Ratio option is similar to Stretch/Shrink to Fit 
Frame in that the picture will be resized, except that it will use padding to 
maintain the height to width ratio of the image so it does not distort the picture. 
The edge (horizontal or vertical) of the picture that is proportionally the largest in 
comparison to the frame will be stretched or shrunk to fit within the frame. The 
proportionally smaller edge will be padded. If it is short and long compared to the 
frame, it will be padded at the top and bottom edges: 

 

If the picture is tall and narrow compared to the frame, it will padded at the left 
and right edges: 
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• The Stretch/Shrink to Fit Frame option will resize the picture to fit within the 
frame. If the picture is larger than the frame, it will be shrunk to fit: 

 

If the picture is smaller than the frame, it will be stretched to fit: 

 

Note 

 If the dimensions of the picture are not proportional to 
the frame, the picture could be distorted when resized. 

• The Show Center of Picture and Crop Edges option will center the picture within 
the frame. If the picture is larger than the frame, the edges will be trimmed to fit: 

 

If the picture is smaller than the frame, it will be centered with space around the 
edges: 
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• The Crop Right and Bottom Edges option is similar to Show Center of Picture and 
Crop Edges, but instead of centering, the picture is anchored to the upper left 
corner of the frame. If the picture is larger than the frame, it will be trimmed at 
the bottom and right edges: 

 

If the picture is smaller than the frame, there will be space around the bottom and 
right edges: 

 

6 Click OK to save your selection and return to the display. 

 Using Calculated Fields on Your Display 
Calculated fields allow you to perform math on numeric fields, or string two fields together. For 
example, if you have a display that contains contact information, you may have separate fields for 
the first and last name and use a calculated field to display the full name. 

The results of your calculation will appear in the field on your display. You will not be able to 
directly modify the contents of the field.  

There are six different types of calculations you can build: 

• Math Calculation Using Two Numeric Fields 

• Math Calculation Using a Field and Another Number 

• Combine Two Fields  

• Combine a Field and Another Value 

• Sum or Average Numeric Fields 

• Date Calculation - Date Before or After 

• Date Calculation - Days Since 
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ENTERING CALCULATED FIELD PROPERTIES 

1 Add a calculated field to your display using one of the methods detailed in the Using 

the Toolbox section, above. The Calculated Field Properties screen will open:  

 

2 Enter a unique name for the field in the Name field.  

3 If you would like to include the name with the field on the display, mark the Show 
Name on Display check box. Unmark it if you do not want the name to display. If this 
is unmarked, the name will not appear on the display, but will be used to identify the 
field in list view windows and anywhere else the field is referenced. 

4 In some cases, you may need a calculation, but not actually want to show it on the 
display. For example, you may set up a calculation that is exclusively used in reports, 
or you may set up a calculation that is just required for a second calculation that you 
do want to display. The Show Field on Display check box lets you add a field without 
placing it on your display outside of the designer. (The field will continue to be 
visible in the designer so you can edit or delete it.) It will be available everywhere 
you have a field list, but will not appear on the display itself when you work with 
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records. Leave this check box marked to display the field, or unmark it to hide the 
field. 

Hint 

 To save space on your display when working in the 
designer, consider sizing the field as small as possible 
and placing it at the edge of the display. 

5 If you are displaying the name, the Font for Name setting controls the font that will 
be used for the name on the display. If you would like to change the font, click on the 
button to select a font from the Font selection screen. The sample text will display the 
font that will be used. 

6 The Font for Data setting controls the font that will be used for the results of the 
calculation that appear in the field. If you would like to change the font, click on the 
button to select a font from the Font selection screen. The sample text will display the 
font that will be used. 

7 The Background Color field lets you control the background color of the calculated 
field. (This is the area where the results of the calculation will appear.) The default 
color is white. If you would like to use a different color, click the button to open the 
Windows Color picker. The box on the screen will display the selected color. 

8 The Select the type of calculation list contains the types of calculations that you can 
set: 

Math Calculation Using Two Numeric Fields - This option will allow you to 
perform a calculation based on the values in two numeric fields. 

Math Calculation Using a Field and Another Number - This option will allow you 
to perform a calculation based on the value in a numeric field and a fixed value. 

Combine Two Fields - This option lets you take the information in two fields and 
have them appear together in one field.  

Combine a Field and Another Value - This option allows you to add something to 
the beginning or end of one of your fields. 

Sum Numeric Fields - This option allows you to add together the values in a 
selection of multiple numeric fields. 

Date Calculation - Date Before or After – This option will return a date that is X 
number of days before or after the date contained in a date field. 

Date Calculation - Days Since – This option will return the number of days that 
have passed since the date in a date field.  

9 Follow the instructions below for each type of calculation. 
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SETTING A MATH CALCULATION USING TWO NUMERIC FIELDS 

1 Add a calculated field following the instructions above and select the Math 
Calculation Using Two Numeric Fields option from the Select the type of calculation 
list. The screen will expand to include the settings for this type of calculation: 

  

2 The First Numeric Field list will contain any numeric fields that you have added to 
your display. Select the first field you would like to use in your calculation from the 
list. 

Note 

 The calculation will be analyzed in the order of the 
fields. If you are performing a calculation using 
subtraction or division, make sure you select the field 
you want the second number subtracted from or 
divided into in this first field. 
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3 Select the type of calculation you would like to perform from the list of math 
operators. Select: 

+ (Add) to add the numbers contained in the fields; 

- (Subtract) to subtract the number contained in the Second Numeric Field from 
the number contained in the First Numeric Field; 

* (Multiply) to multiply the numbers contained in the First and Second Numeric 
Fields; 

/ (Divide ) to divide the contents of the First Numeric Field by the contents of 
the Second Numeric Field. 

4 Select the second numeric field you would like to use in the calculation from the 
Second Numeric Field list. 

Example:  You have a display that tracks sales of a widget. You would like to be 
able to calculate sales tax on the price of the widget. Sales are made to people in 
different states, so each customer could have a different tax rate.  

Solution:  Add a numeric field to contain the price, and a second numeric field to 
contain the tax rate. Add a calculated field using the Math Calculation Using Two 
Numeric Fields option. Use the following setting: 

From the First Numeric Field list, select your price field. 

From the Operator list, select * [multiply]. 

From the Second Numeric Field list, select your tax rate field.  

When you add records, enter the price of the widget in the price field and the 
appropriate tax rate in the tax rate field as a decimal. For example, if your tax rate is 
7.5%, enter .075 in the field; if your tax rate is 6%, enter .06. If you enter $10.00 as 
your price, and .075 as your tax rate, the system will calculate sales tax and display 
$0.75 in the calculated field. 

5 The decimal places radio buttons let you configure how many decimal places will 
display in the calculation results. Select Use Variable Number of Decimal Places if 
you would like to display the number of decimal places found in the data for the 
selected numeric fields. To specify the number of decimal places, select Use Fixed 
Number of Decimal Places and enter the number (up to six) in the field. 

6 When you are satisfied with your settings, click OK to save the field and return to the 
display. 
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SETTING A MATH CALCULATION USING A FIELD AND ANOTHER 

NUMBER 

1 Add a calculated field following the instructions above and select the Math 
Calculation Using a Field and Another Number option from the Select the type of 
calculation list. The screen will expand to include the settings for this type of 
calculation: 

  

2 The radio buttons on the screen control the order in which the values will be 
calculated. This is useful in the case of a calculation using subtraction or division as it 
allows you to control whether the numeric field should be subtracted from or divided 
into the fixed number, or vice versa. If you would like your calculation to use the 
field first, leave the Numeric Field First radio button selected. If you would like your 
calculation to use the fixed number first, select the Number First radio button. 

The Number and Numeric Field fields on the screen will change position based on 
your selection. 

3 The Numeric Field list will contain any numeric fields that you have added to your 
display. Select the field you would like to use in your calculation from the list. 
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4 Select the type of calculation you would like to perform from the list of math 
operators. Select: 

+ (Add) to add the number contained in the field and the constant value; 

- (Subtract) to subtract either the constant value from the number contained in 
the field, or vice versa, depending on your selection for the order radio buttons, 
below; 

* (Multiply) to multiply the number contained in the field and the constant 
value; 

/ (Divide ) to divide either the number contained in the field by the constant 
value, or vice versa, depending on your selection for the order radio buttons, 
below. 

5 Enter the number that will be used in the calculation in the Number field. 

Example:  You have a display that tracks sales of a widget. You would like to be able 
to calculate sales tax on the price of the widget. Sales are only made to people locally, 
so each customer will have the same tax rate.  

Solution:  Once you have created the numeric field that will contain the price, add a 
calculated field using the Math Calculation Using a Field and Another Number 
option. 

Use the following setting: 

From the Numeric Field list, select your price field. 

From the Operator list, select * [multiply] 

In the number field, enter your tax rate. The tax rate should be entered as a 
decimal. 

For example, if your tax rate is 7.5%, enter .075 in the field; if your tax rate is 6%, 
enter .06. 

Make sure the Numeric Field First Radio button is selected. 

When you add records, enter the price of the widget in the price field. The system will 
calculate the sales tax based on your fixed value and display the tax in the calculated 
field. For example, if you enter $10.00 as your price and your sales tax was .08, the 
system will display $0.80 in the calculated field. 

6 The decimal places radio buttons let you configure how many decimal places will 
display in the calculation results. Select Use Variable Number of Decimal Places if 
you would like to display the number of decimal places found in the data for the 
selected numeric fields. To specify the number of decimal places, select Use Fixed 
Number of Decimal Places and enter the number (up to six) in the field. 

7 Click OK to save your calculated fields and return to the display. 
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COMBINING TWO FIELDS  

1 Add a calculated field following the instructions above and select the Combine Two 
Fields option from the Select the type of calculation list. The screen will expand to 
include the settings for this type of calculation: 

  

2 The First Field list will contain all of your text and numeric fields. Select the first 
field you would like to use from the list. 

3 Use the Separator field to place a separation between the two fields. If is no separator 
entered, the contents of the two fields you select will be directly next to each other in 
the calculated field. By default, this will contain a space. If you would like the fields 
right next to each other with no space between them, remove the space from this 
field. If you would like a different separator, enter it in this field. 
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Hint 

 The separator text can be used to further expand on 
the relationship between the data in the two fields. 
For example, if your fields contain a due date and an 
amount due, you could place " is due on " as the 
separator text. The calculated field will then display: 
[amount] is due on [date]. 

4 Select the second field you would like from the Second Field list. 

Example:  You have a display that tracks membership information for your club, 
including dues payments. You have a field that contains the date when the next 
payment is due for each member, and a second field for the amount of the dues. You 
would like to have a field that displays the amount and due date together.  

Solution:  Once you have created a text field to contain the due date and a numeric 
field to contain the amount, add a calculated field using the Combine Two Fields 
option. Use the following settings: 

From the First Field option, select the amount due field. 

In the separator, enter " is due on " (without the quotation marks). Notice that 
there are spaces before and after the text. It's important that you include spaces 
around the "is due on" so that the words aren’t right up against each other. 

From the Second Field option, select the due date field. 

When you add records, enter the due date and the amount due for each member. If the 
amount due is $30.00 and the due date is 5/23/07, the calculated field would display: 
30.00 is due on 5/23/07. 

5 Click OK to save your calculated fields and return to the display. 
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COMBINING A FIELD AND ANOTHER VALUE 

1 Add a calculated field following the instructions above and select the Combine a 
Field and Another Value option from the Select the type of calculation list. The 
screen will expand to include the settings for this type of calculation: 

  

2 The Field list will contain all of your text and numeric fields. Select the field you 
would like to use from the list. 

3 Enter the text you would like to combine with your field value in the Text field. 
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4 The order radio buttons on the screen control the order in which the field data and text 
value will appear. If you would like your calculated field to display the field, then the 
text, leave the Field Value First radio button selected. If you would like to display the 
text, then the field value, select the Text Value First radio button. The Field and 
Value fields will change positions on the screen, based on your selection. 

Example:  You have a display that tracks donations for your non-profit organization. 
You have a field that contains the date of the last donation for each contributor. You 
would like a large message at the top of the screen that contains "The last donation 
was received on [date]."  

Solution: Once you have created your date of last donation field, add a calculated 
field using the Combine a Field and Another Value option. Use the following 
settings: 

From the Field list, select the date of last donation field. 

In the Text field, enter "The last donation was received on " (without the 
quotation marks. Notice that there is a space after "on". It is importation that you 
include the space so the date isn't right up against the text. 

Select the Text Value First radio button. 

When you add records, enter the last payment date for each contributor. If the last 
date was 6/12/06, the calculated field would read "The last donation was received on 
6/12/06".  

5 Click OK to save your calculated fields and return to the display. 
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SUM OR AVERAGE NUMERIC FIELDS 

1 Add a calculated field following the instructions above and select the Sum or Average 
Numeric Fields option from the Select the type of calculation list. The screen will 
expand to include the settings for this type of calculation: 

  

2 Specify whether you wish to add the fields together, or create an average. Select the 
Sum radio button to produce a total of the values in the fields, or the Average radio 
button to produce an average (total divided by the number of fields). 

3 The Select Fields to Sum/Average list will contain all of the numeric fields that have 
been added to your display. Click in the check box next to each numeric field that you 
would like to include in your calculation. All fields with a mark next to them will be 
added together and either the total or the average will appear in your calculated field. 

Example:  You have created a display for keeping track of your calorie intake for the 
day. You have fields to contain the calories of breakfast, lunch, dinner, and two 
snacks. You would like a field that shows the total calories for the day.  

Solution:  Once you have created numeric fields for each of the meals and snacks, 
add a calculated field using the Sum Numeric Fields option. Use the following 
setting: 

In the Select Fields to Sum list, place a check mark in each of the calories fields. 
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When you add your records, enter the calories in each of the appropriate fields and a 
sum will be automatically calculated when you save the record. For example, if you 
had 300 calories for breakfast, 520 calories for lunch, one snack of 150 calories, no 
second snack, and 730 calories for dinner, the calculated field will display 1700. 

4 The decimal places radio buttons let you configure how many decimal places will 
display in the calculation results. Select Use Variable Number of Decimal Places if 
you would like to display the number of decimal places found in the data for the 
selected numeric fields. To specify the number of decimal places, select Use Fixed 
Number of Decimal Places and enter the number (up to six) in the field. 

5 Click OK to save your calculated fields and return to the display. 

RETURNING A DATE BASED ON ANOTHER DATE  

1 Add a calculated field following the instructions above and select the Date 
Calculation - Date Before or After option from the Select the type of calculation list. 
The screen will expand to include the settings for this type of calculation: 

  

  



  Adding Objects to a Display 

Chapter 6 – Building and Editing Displays  ♦  Page 152 

2 In the Number of Days field, enter the number of days before or after the date in a 
date field you would like to calculate. The field can only contain whole numbers. 
Enter the date by typing in the field, or use the up and down arrow buttons to the right 
of the field (also known as spinner buttons) to increment the number up or down by 
one. 

3 In the Before / After field, select whether you would like to return a date that is the 
specified number of days before or after the date in the date field. Select Before to 
return an earlier date. Select After to return a later date.  

4 The Date Field list will show all of the date fields in your display. Select the date field 
that should be used as a basis for this calculation from the list. 

Example:  You have a display for keeping track of warranties. Products are under 
warranty for the first 30 days after purchase. You would like a field that shows the 
warranty expiration date.  

Solution:  Once you’ve set up a date field for the purchase date, add a calculated field 
using the Date Calculation – Date Before or After option. Use the following setting: 

In the Number of Days field, enter 30. 

In the Before / After field, select After.  

In the Date Field field, select Purchase Date. 

When you add your records, enter the date of purchase in the Purchase Date field. 
The calculated field will automatically show the warranty expiration date. 

5 Click OK to save your calculated fields and return to the display. 
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RETURNING THE NUMBER OF DAYS SINCE A DATE  

1 Add a calculated field following the instructions above and select the Date 
Calculation – Days Since option from the Select the type of calculation list. The 
screen will expand to include the settings for this type of calculation: 

  

2 The Date Field list will show all of the date fields in your display. Select the date field 
that should be used as a basis for this calculation from the list. 

Example:  You have a display that keeps track of payment due dates. You would like 
to send a reminder to any customer who are more than five days past due on their 
payments.  

Solution:  Once you’ve set up a date field for the payment date, add a calculated field 
using the Date Calculation – Days Since option. Use the following setting: 

In the Date Field field, select Payment Due Date. 

When you add your records, enter the customer’s due date in the Payment Due Date 
field. The calculated field will automatically show the number of days since the 
payment was due. You may then set a filter where the value in the calculated field is 
greater than five. 
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Note 

 If the current date is before the date in the selected 
date field, the calculation will show as a negative 
number. 

Hint 

 If you would like to calculate years, for example to 
return a person’s age from his or her birth date, you 
can create a second calculated field that divides the 
number in the number of days by 365.  

3 Click OK to save your calculated fields and return to the display. 

 Using Auto Incrementing Fields on Your Display 
Auto incrementing fields are numeric fields that increment by 1 for each new record that you add. 
These are commonly used to create a unique number, such as a customer number or invoice number. 

Hint 

 You can use an auto incrementing field in a calculated 
field to add a prefix or suffix to the number.  

ENTERING AUTO INCREMENTING FIELD PROPERTIES 

1 Add an auto incrementing field to your display using one of the methods detailed in 
the Using the Toolbox section, above. The Auto Incrementing Field Properties screen 
will open: 
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2 Enter a unique name for the field in the Name field.  

3 If you would like to include the name with the field on the display, mark the Show 
Name on Display check box. Unmark it if you do not want the name to display. If this 
is unmarked, the name will not appear on the display, but will be used to identify the 
field in list view windows and anywhere else the field is referenced. 

4 If you are displaying the name, the Font for Name setting controls the font that will 
be used for the name on the display. If you would like to change the font, click on the 
button to select a font from the Font selection screen. The sample text will display the 
font that will be used. 

5 The Font for Data setting controls the font that will be used for the number that is 
automatically populated in the auto incrementing field. If you would like to change 
the font, click on the button to select a font from the Font selection screen. The 
sample text will display the font that will be used. 

6 The Background Color setting controls the background color of the auto incrementing 
field. (This is the area where the number will appear.) The default color is white. If 
you would like to use a different color, click the button to open the Windows Color 
picker. The box on the screen will display the selected color. 

7 The Start the numbering at field controls the starting number for the first record that 
you add. For example, if you start the number at 1000, the first record will be 
numbered 1000, the second 1001, the third 1002, etc. The default starting number is 
1. 
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Note 

 If you are adding an auto incrementing field to a 
display that already contains records, the starting 
number will be applied to the first record in your 
display.  

8 Click OK to save your field and return to the display. 

 Using Child Rollups on Your Display 

  If you have a child display set up in Professional Edition, you can have multiple child 
records associated with each parent record in this display. Child rollups allow you to view a table 
with information from the child level. 

For information on using child rollups, refer to the Adding Child Information to the Parent Level 
heading in the Creating Child Displays section, later in this chapter. 

Working with Objects on the Display 

Once you have added the desired items to the display, you will need to arrange them in a way that makes 
the display as easy to use as possible. Here are some basic design principals you may find useful, 
especially if other people will be using your display: 

• Pay attention to the order of the fields. Most people will look at a computer screen the way 
they look at a book. For most English speaking people, this means they will read the 
display from left to right, top to bottom. As you place items on the display, think about the 
order that the information should be entered and place the fields in that order where 
possible.  

• Make sure the edges of the fields line up as much as possible. If the fields aren’t aligned, 
the screen will have a jumbled look that can make it appear confusing, even when the order 
of the items is perfectly logical. 

• Make sure that fields are sized so they are large enough to display the text that will be 
entered into the field. If the field can accommodate more data that the frame you’ve drawn 
for the field, users will have to click in the field and scroll to view the rest of the data. 
Aside from being inconvenient, this can be confusing as it may not be immediately evident 
that there is more data than displayed. 

When putting the finishing touches on your display, you will no doubt need to know how to move and 
change the size of objects. You may also need to access an object’s properties again to change the font, 
prompt, or other settings. 
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Selecting Objects 
Before working with objects on your display, you first need to know how to select them. 

SELECTING ITEMS IN A DISPLAY 

1 Make sure the pointer is selected in the toolbox, then click with your mouse on a 
single item to select it. A selected item will have a box around it: 

 

2 To work with multiple objects at the same time, hold down the SHIFT key on your 
keyboard while clicking on the objects. Boxes will appear around each object that is 
selected. 

 

3 If you would like to deselect one of the objects, simply click on it a second time while 
holding down the SHIFT key. The box will disappear from just that object.  

4 If you would like to deselect all objects, click off of them. 

5 Another way to select objects is to draw a box around the objects you would like to 
select by dragging with your mouse. To do this, click on any area of the display that 
does not currently have an object on it. (Make sure you click outside of any boxes 
you have on the display.) Hold down the mouse button while you drag toward the 
items you would like to select. A bounding box will appear, indicating the area that 
you are selecting: 

 

When you release your mouse, any item that is all or partially within the box will be 
selected. Using the above example, the Employee Name, Address, City, State, ZIP 
and Home Phone fields will be selected, as well as the Employees box. The prompts 
for the fields, the Cell Phone and Social Security Number fields, and the buttons 
will not be selected.  



  Working with Objects on the Display 

Chapter 6 – Building and Editing Displays  ♦  Page 158 

6 To add or remove items from the selection, hold down the SHIFT key while you drag 
a second time. Anything within the new box that was not previously selected will be 
added to the selection. Anything within the new box that was previously selected will 
be deselected. 

Note 

 SHIFT acts as a toggle when selecting items. It will 
select anything that was not selected, or deselect 
anything that was previously selected.  

Moving Objects by Dragging 
Once you have the desired items selected, use the following instructions to move the items on the 
display. 

DRAGGING ITEMS ON A DISPLAY 

1 Click on the item you would like to move and hold down the left mouse button while 
moving the mouse to drag the item into another position. When the object is in the 
desired position, release your mouse button. This method is called drag and drop. 

As you drag the item, the system will automatically line items up with other items 
that are near it. Blue snap lines will appear, allowing you to select which items you 
wish to align:  

 

In the above picture, the blue snap lines show that the << button is being snapped to 
align vertically with the Add button and horizontally with the <, >, and >> buttons.  

2 If you do not want to snap the item you are moving to another item, hold down the 
ALT key on your keyboard while dragging the item to turn off the snap lines.  

3 If you have multiple items selected and would like to move them as a group, simply 
click and drag on any of the objects. All selected items will move together as a group, 
keeping their relative positions to each other. 
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Moving Objects with the Keyboard 
Selected objects can also be moved using the arrow keys on your keyboard. This lets you nudge the 
object one pixel at a time. 

Note 

 A pixel is a single dot in an image. 

MOVING OBJECTS WITH THE KEYBOARD 

1 Click on the item you would like to move. 

2 Use the up, down, left, and right arrow keys on your keyboard to move the object one 
pixel. 

3 If you would like to jump the object to the next snap line, hold down the ctrl key on 
your keyboard while pressing the arrow key. 

Moving Objects Using the Alignment Tools 
A quick way to move objects into position is to use the alignment options. This allows you to have 
objects automatically moved into a position relative to another object. For example, you can center 
an item on the display, or have an item moved so that its edges align with another item. 



  Working with Objects on the Display 

Chapter 6 – Building and Editing Displays  ♦  Page 160 

Center Objects on the Display 
This option allows you to align objects based on the dimensions of the display. For example, you 
may have a page title that you would like to have centered horizontally: 

 

It is also useful if you want to make sure that a group of objects appears in the very center of the 
display with equal space around the edges. 

CENTERING OBJECTS ON THE DISPLAY 

1 Select the object or objects you would like to center using any of the methods under 
the Selecting Objects heading. 

2 If you would like move the object(s) to the horizontal center of the display, do one of 
the following: 

• Select Center Horizontally on Display from the Layout menu. 

• Select Center Horizontally on Display from the Work with Selected Object 
section of the Tools pane.  

• Right click on the object, or any one of the selected objects in a group, to open 
small menu to the right of the object. Select Center Horizontally from the right 
click menu. 

3 If you would like to move the object(s) to the vertical center of the display, do one of 
the following: 

• Select Center Vertically on Display from the Layout menu. 
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• Select Center Vertically on Display from the Work with Selected Object 
section of the Tools pane.  

• Right click on the object, or any one of the selected objects in a group, to open 
small menu to the right of the object. Select Center Vertically from the right 
click menu. 

4 If you have multiple objects selected, the objects will keep their positions relative to 
each other and the block will be centered either across the width of the display if you 
have selected to center horizontally, or across the height of the display if you have 
selected to center vertically.  

5 If you want the object(s) placed dead center, use both centering options one after the 
other. 

Aligning the Edges of Objects 
If you have groups of objects, having the edges aligned will generally make for a more visually 
pleasing display. As you click and drag items, the software will automatically provide snap lines to 
help you align the objects. It may be faster just to use one of the alignment options, especially if 
you’re working with a group of objects. 

ALIGNING OBJECTS 

1 Select the object to which you would like the other objects aligned by clicking on it. 

2 Hold down the SHIFT key and select the object or objects you would like to move 
into alignment with the object selected in step 1. 

3 From the Layout menu, select the desired alignment option using the following 
guidelines: 

• Select Align Left Edges to move the objects so that the left edges are perfectly 
aligned in a vertical row.  

• Select Align Right Edges to move the objects so that the right edges are 
perfectly aligned in a vertical row. 

Note 

 When creating a row of fields, it is generally most 
aesthetically pleasing to have all of the fields the 
same size with both the left and right edges aligned. If 
it does not make sense to have the items the same 
size, it is more standard to align the left edges than 
the right.  
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• Select Align Top Edges to move the objects so that the top edges are perfectly 
aligned in a horizontal row. 

• Select Bottom Edges to move the objects so that the bottom edges are 
perfectly aligned in a horizontal row. 

4 When you select the alignment option, the objects will be moved to align with the 
first object you selected. 

Centering Objects with Other Objects 
This option is useful if you would like to align objects that are different sizes. They will allow you to 
have the objects positioned so that their centers are aligned either horizontally or vertically.  

These options are based on either the horizontal or vertical center of the objects being aligned. If you 
drew a vertical line through the center of an object, this is the vertical center: 

 

This option is useful if you want to center objects in a vertical line: 

 

If you drew a horizontal line through the center of an object, this is the horizontal center: 

 

This option is useful if you want to center objects in a Horizontal line: 

 

CENTERING OBJECTS TO OTHER OBJECTS 

1 Select the object to which you would like the other objects aligned by clicking on it. 

2 Hold down the SHIFT key and select the object or objects you would like to move 
into alignment with the object selected in step 1. 

3 From the Layout menu, select the desired alignment option using the following 
guidelines: 

• Select Align Vertical Centers move the objects across the width of the display 
so that their vertical centers are aligned forming a vertical row. The objects 
will retain their relative positions to the height of the display. 

• Select Align Horizontal Centers to move the objects across the height of the 
display so that their horizontal centers are aligned, forming a horizontal line. 
The objects will retain their relative positions to the width of the display. 
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Note 

 If you select to align both the vertical and horizontal 
centers of objects, they will appear on top of each 
other. 

Resizing Objects 
Each item that you can add to a display appears in a default size. Use the following instructions to 
change the size of your objects. 

CHANGING THE SIZE OF OBJECTS 

1 Select the item you would like to resize, following the instructions in Selecting Items 

in a Display, above. 

2 Hover your mouse over the edges of the selected item. The mouse pointer will change 
to a double headed arrow: 

 

When your mouse appears as a double headed arrow, instead of moving an item when 
you click and drag, it will change the size of the item. 

3 To make an item larger, drag away from the center of the object from any edge. To 
make an item smaller, drag toward the center of the object from any edge.  

Note 

 The height of text, numeric, and calculated fields is 
determined by the font used for the field. These will 
automatically be sized to accommodate the height of 
the data. 

4 If you have multiple items selected, dragging on any of the items will size all of them 
at once. 

Layering Objects 
There may be occasions when you want objects to appear on top of other objects. For example, you 
may add a box around a group of objects, or use the logo control to add a graphic you wish to have 
appear behind other objects.  
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In the above example, a graphic of a 3D box appears behind the Song Title field. If one or more 
objects overlap, you can control which appears in front or behind the other objects. 

Note 

 With the exception of boxes, when items are added, 
they are automatically placed in front of any existing 
items. (When boxes are added, they are automatically 
placed behind any existing items.) 

USING BRING TO FRONT AND SEND TO BACK 

1 Select the item you would like to move to the front or back. 

Hint 

 You may want to bring an item in front of another 
item, but you can’t click on it because it is hidden 
behind the other item. In this case, select the item that 
is currently in front and send that to the back instead. 

2 If you would like to bring the item in front of all other items, use any one of the 
following methods: 

• Select Bring to Front from the Work with Selected Object section of the Tools 
pane. 

• Select Bring to Front from the Layout menu. 

• Right click on the object and select Bring to Front from the right click menu. 

3 If you would like to push the item in back of all other items, use any one of the 
following methods: 

• Select Send to Back from the Work with Selected Object section of the Tools 
pane. 

• Select Send to Back from the Layout menu. 

• Right click on the object and select Send to Back from the right click menu. 
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Modifying Object Properties 
Once you have objects on your display, you are able to re-access the same properties that were 
available when you first added the object. 

ACCESSING OBJECT PROPERTIES 

1 Select the object whose properties you would like to access following the instructions 
under Selecting Objects, above. 

Note 

 You cannot access properties with multiple objects 
selected. 

2 Open the object’s properties screen using one of the following methods: 

• Double click on the object on the display. 

• Select Object Properties from the Work with Selected Object section of the 
Tools pane. 

• Select Properties from the Layout menu. 

• Right click on the object and select Modify Object Properties from the right 
click menu. 

3 The object properties screen for the selected object will open.  

Note 

 If you open object properties for a field prompt, the 
field’s object properties screen will open instead of 
the Label Properties. 

If you add an object in error, or determine that you no longer need an object, you can delete it from 
the display. 

Note 

 If you are showing a field name on the display and 
wish to remove it, go into the field’s properties and 
unmark the Show Name on Display check box rather 
than using delete. Deleting the name will also delete 
the field. 
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DELETING AN OBJECT 

1 Select the object you would like to delete following the instructions under Selecting 

Objects, above. 

Note 

 You cannot delete with multiple objects selected. If 
you wish to remove more than one object, you must 
delete them one at a time. 

2 Delete the object using one of the following methods: 

• Select Delete Object from the Work with Selected Object section of the Tools 
pane. 

• Select Delete from the Layout menu. 

• Right click on the object and select Delete from the right click menu. 

• Press the Delete key on your keyboard. 

3 If the object is a label, box, or logo, it will be removed from your display. If it is a 
field type object, a message will appear warning you that deleting the field will also 
delete the data from the field. 

WARNING! 

 If you are deleting a field from a display that already 
contains data, the data in the field will be deleted. 
There is no undo for this action. 

4 Click Yes at the message to delete the field. 
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Tab Order 

Tab order controls how focus moves through fields on the display when you press tab on your keyboard. 
By default, when you press tab, focus will move through the fields from left to right, then top to bottom.  

For example, in the following display, the default tab order would move from the Product field, to the 
User field, then to the Description field: 

 

You may want to customize your display so you tab through fields in a different order. For example, in 
the above display, you may want to tab through the fields in the Product Information box, then move to 
the Location Information box. 

SETTING THE TAB ORDER 

1 Select Set Tab Order from the Work with Designer menu. 
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2 The Set Tab order screen will open with a list of the fields in your display: 

 

3 Highlight the field whose order you would like to change and click the up or down 
arrow key to move the field in the list. Repeat for each additional field you would like 
to adjust. 

4 When you are satisfied with the order of your fields, click OK. 

Note 

 If you have not yet modified the tab order, when you 
add new fields or change the position of existing 
fields on your display, Database Oasis will 
automatically update the tab order based on the field’s 
position. Once you set a custom tab order, Database 
Oasis will set the tab order for new fields based on 
their position, but it will no longer automatically 
change the tab order of fields when they are moved. 
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Creating Child Displays 

   Child displays utilize relational database functionality. Because this is an advanced 
feature, it is only available in Database Oasis Professional Edition. 

A child display is a display that is linked, or related, to another display called the parent. This allows you 
to have multiple sub-records linked to a master parent record.  

For example, if you have a display that captures registrations for an upcoming class, you might have 
class information at the parent level, and registered students at the child level.  

 

 

 

 

 

 

 

 

This type of display is commonly used to track things like contacts at a company, purchases by a 
customer, visits by a patient, etc. 

If multiple records share common information, this allows you to enter that information once and share 
it among the children.  

Before adding a child display, take a moment to plan the best way to structure your data. Any 
information that will be shared by all records should be captured at the parent level. Any information 
that would be unique to each record should be added to the child. 

Adding Child Displays  
Once you’ve set up the common data on the parent level, you can add your child display. Child 
displays are added from within the parent display.  

WARNING! 

 Child displays are only available in Professional 
Edition. Once a display has a child, you will not be 
able to open it in Basic Edition. 

  

Class Information: 
Name of Class 
Date of Class 
Instructor 
Tuition Amount 
Description 

Student Information: 
Name  
Phone Number 
Tuition Paid? 

Student Information: 
Name  
Phone Number 
Tuition Paid? 

Student Information: 
Name  
Phone Number 

Tuition Paid? 
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ADDING A CHILD DISPLAY 

1 Open the parent for which you would like to add a child level. 

2 Use one of the following methods to add a child display: 

• Select Create Child Display from the Child Displays menu. 

 

• Select Create Child Display from the Work with Child Displays section of the 
Tools pane. 

 

3 A warning will appear informing you that displays with children cannot be opened in 
Basic Edition. Click Yes to continue. 

4 Display Properties will open for the new display. Enter the property information 
following the guidelines in the Creating a Display from a Blank Page section, earlier 
in this chapter.  

5 A new designer window will open with your child display. Set up your display 
following the guidelines used to set up the parent display.  
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Adding Parent Information to a Child Display 
For the most part, setting up a child display is very much like setting up a regular display. The one 
exception is that you are able to show fields from your parent level on the child level. 

For example, if you are creating a child display to contain registered students for a class, you may 
want the class name and date to appear on the child records for quick reference.  

Note 

 Parent fields on the child level are similar to 
calculated fields in that they are display-only. Parent 
fields can only be edited on the parent display. 

ADDING PARENT FIELDS TO THE CHILD 

1 In your child display, scroll to the bottom of the toolbox to see a list of the fields on 
your parent level. These will be labeled Parent Fields:  
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2 Add the desired parent field to your display following the guidelines under Using the 

Toolbox, above. Parent Properties will open: 

 

Note 

 These properties only control how the field appears 
on your child display. Changing parent field 
properties on the child level does not affect the 
properties of the same field on the parent level. 

3 Set the properties following the guidelines under Setting Object Properties, earlier in 
this chapter. 

4 Once you have added all desired fields, save and close the designer to return to the 
parent display. (See the Saving Your Work in the Designer section, below, for 
instructions.) 

Adding Child Information to the Parent Level  
Once you’ve added a child display, you are able to include information about the children on the 
parent. You can view a list of all children associated with the current parent in a grid using the Child 
Rollup tool. 

ADDING A CHILD ROLLUP 

1 Add or edit a display with a child level. 
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2 From the Toolbox, select Child Rollup. 

 

3 Add the child rollup to your display following the guidelines under Using the 

Toolbox, above. The Rollup Properties screen will open: 

 

4 Select which child display you would like to represent in this rollup from the Child 
Display field. 

5 The Available Fields box will populate with the list of fields in the selected child 
display. To include a field in the rollup, double click on it or highlight it and click the 
Select button. The field will move from the Available Fields list to the Selected Fields 
list. To select all fields, click Select All. 

6 If you have selected a field and decide you do not want to include it in the rollup, 
double click on it in the Selected Fields list or highlight it and click Remove. It will 
move back to the Available Fields list. If you would like to clear the Selected Fields 
list and start over, click Remove All. 

7 When child records are displayed in the rollup, fields will be shown in the order that 
they appear in the Selected Fields list. The arrow buttons next to the Selected Fields 
list allow you to move fields up or down in the list to change their order in the rollup. 
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Highlight a field in the Selected Fields list and click the appropriate button until the 
field is in the desired position. 

8 When you are satisfied with your selections, click OK to save the rollup. The rollup 
will appear on your display. 

 

9 Position and size the child rollup box following the guidelines under Working with 

Objects on Your Display, earlier in this chapter. 

Note 

 Column widths are adjusted when you work with the 
display outside of the designer. 

Edit a Child Display  
If you’ve closed your child display and returned to the parent, you may re-open it again at any time 
to make additional edits. 

EDITING A CHILD DISPLAY 

1 From the parent display, use one of the following methods: 

• Select Edit/Delete Child Display from the Child Displays menu: 

 

• Select Edit/Delete Child Display from the Work with Child Displays section 
of the Tools pane: 
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2 The Display Maintenance screen will open with a list of the child displays for this 
parent: 

 

3 Highlight the child display you would like to edit and click the Edit button. 

4 The child display will open. 

Delete a Child Display  
If you decide you no longer want a child display you’ve added, it may be deleted. 

DELETING A CHILD DISPLAY 

1 From the parent display, use one of the following methods: 

• Select Edit/Delete Child Display from the Child Displays menu. 
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• Select Edit/Delete Child Display from the Work with Child Displays section 
of the Tools pane. 

2 The Display Maintenance screen will open with a list of the child displays for this 
parent. 

3 Highlight the display you would like to delete and click the Delete button. 

4 A message will appear warning you that this action will permanently delete the 
display and any data contained in the display and asking if you would like to 
continue. 

5 Select Yes to delete the display or No to cancel the deletion.  

WARNING! 

 Once you have deleted a display, it cannot be 
retrieved without a backup. 

Saving Your Work in the Designer 

As you work in the designer, your work is periodically saved for you. When you exit the designer, any 
unsaved work will be automatically saved. You can also manually save work while in the designer. 

SAVING IN THE DESIGNER 

1 Select Save Display from the Work with Designer menu: 
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SAVING AND EXITING THE DESIGNER 

1 You may exit the designer using one of the following methods: 

• From the Tools pane, select Save and Close in the Work with the Designer 
box. 

• Select Save and Close Designer from the Work with Designer menu. 

Editing Displays 

Once you have added your display, placed all of the desired items on the display, and positioned and 
sized everything, you may never need to make modifications to that display. Chances are, however, that 
as you work with the display, you may discover ways that it could be improved.  

You can make modifications to your display at any time. 

Note 

 Child displays are edited by first editing the related 
parent, then selecting Edit/Delete Child Display from 
the Child Displays menu or Tools pane. See Edit a 

Child Display, earlier in this chapter. 

MODIFYING AN EXISTING DISPLAY 

1 Make sure you have a current backup of your displays following the instructions in 
the Backing up Your Data section in Chapter 9. 

2 Use one of the following methods to begin editing your display: 

• From the main screen in Database Oasis, select Edit/Delete Existing Displays 
from the File menu. 

• From the main work area, press Ctrl+E on your keyboard. 

• If you have the Navigation Pane open, select Edit or Delete a Display from the 
Work with Existing Displays box. 
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3 The Display Maintenance screen will open: 

 

4 Highlight the display you would like to edit and click the Edit button. 

Note 

 If you are in Basic Edition, you will not be able to 
edit a display that was created in Professional Edition 
if it includes Professional only functionality. 

5 The display designer will open to the selected display. 

Exporting Design Templates 

If you would like to share the display you have created with another user of Database Oasis, you can 
quickly create a distributable design template file. A design template is a file that contains a description 
of a display. The software will read this file and create a display that matches the description.  
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CREATING A TEMPLATE 

1 Access the Export a Design Template screen using one of the following methods: 

• Select Export Design Template from the Displays menu on the main menu bar. 

• Select Export Design Template from the Navigation Pane: 

 

2 The Export a Design Template screen will open: 

 

3 The Create a Design Template from this Display list will show all of the displays in 
your installation. Select the display on which you would like to base your template 
from the list. 

4 The New Template Path and Filename field will display the path and file name for the 
new template file that will be created. Click the button next to the field to open a 
Windows Save dialog where you can navigate to the desired location and enter a 
name for template file. 



  Deleting Displays 

Chapter 6 – Building and Editing Displays  ♦  Page 180 

Hint 

 Be sure to give your file a descriptive name that will 
help others identify the purpose of the display 
described by template. 

5 Click OK to create a template file with the .mktx extension in the specified location. 

Note 

 Templates created prior to version 3.0 have an 
extension .mkt. 

Note 

 Child displays will be included in the template if you 
export a Professional Edition display that has child 
displays associated with it. 

Deleting Displays 

If you have a display that you no longer need, you can simply delete the entire display. Deleting displays 
is done from the main work area, outside of the designer. 

Hint 

 As you’re learning to work with the designer, you can 
create temporary displays to experiment in. When you 
are done practicing, delete these displays to help keep 
your display list clean. 

Note 

 Child displays are deleted by first editing the related 
parent, then selecting Edit/Delete Child Display from 
the Child Displays menu or Tools pane. See Delete a 

Child Display, earlier in this chapter. 
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DELETING AN EXISTING DISPLAY 

1 Make sure you have a current backup of your displays following the instructions in 
the Backing up Your Data section in Chapter 9. 

2 Use one of the following methods to access your displays for deletion: 

• From the main screen in Database Oasis, select Edit/Delete Existing Displays 
from the File menu. 

• From the main work area, press Ctrl+E on your keyboard. 

• If you have the Navigation Pane open, select Edit or Delete a Display from the 
Work with Existing Displays box. 

3 The Display Maintenance screen will open. 

4 Highlight the display you would like to delete and click the Delete button. 

WARNING! 

5  If there are child displays associated with the display, they will also be 
deleted. A message will appear warning you that this action will permanently delete 
the display and any data contained in the display and asking if you would like to 
continue. 

6 Select Yes to delete the display or No to cancel the deletion.  

WARNING! 

 Once you have deleted a display, it cannot be 
retrieved without a backup. 
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Opening Displays 

The first thing you will need to do in order to work with your data displays is to open them in the main 
work area. There are three ways to open a display: 

• You can open a display from the Navigation pane if it is open. 

• You can open a display from the menu. 

• You can open a display using the keyboard. 

Note 

 If you are in Basic Edition, you will not be able to 
open a display that was created in Professional 
Edition if it includes Professional only functionality. 
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OPENING A DISPLAY FROM THE NAVIGATION PANE 

1 Locate the Open a Display section of the Navigation Pane: 

 

2 Highlight the display you would like to open and do one of the following 

• Double click on the display in the list; 

• Click the Open Highlighted Display button. 

3 The display will open in the main work area. 

OPENING A DISPLAY FROM THE MENU 

1 From the main menu, select the Open Display option on the Displays menu: 
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2 The Open Display screen will open: 

 

3 Highlight the display you would like to open and do one of the following 

• Press the Enter key on your keyboard; 

• Double click on the display in the list; 

• Click the OK button. 

4 The display will open in the main work area. 

OPENING A DISPLAY USING THE KEYBOARD 

1 From the main work area, press Ctrl+O on your keyboard. 

2 The Open Display screen will open. 

3 Highlight the display you would like to open and do one of the following 

• Press the Enter key on your keyboard; 

• Double click on the display in the list; 

• Click the OK button. 

4 The display will open in the main work area. 
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Opening Child Displays 

   Child displays are an advanced feature only available in Database Oasis Professional 
Edition. 

If you are using Professional Edition, you may have displays that include a child level. Child 
displays let you relate multiple related records to one parent record. This can be useful for tracking 
things like visits to a doctor, students in a class, or jobs for a customer. 

OPENING A CHILD DISPLAY 

1 Open the parent display using one of the methods described above. A Child Displays 
option will appear at the far right of the menu: 

 

2 Select Child Displays. A menu will appear with the child displays associated with this 
parent. 

 

3 Select the desired display from the list. 

4 The child display will open.  

Exploring the Display 
Data displays are completely customizable forms where you can add and work with your records. 
The size, shape, color, and objects on the display are completely up to you. For example, you may 
design a very simple display to contain contact information: 
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Of course, at least some of your displays may end up a bit more elaborate: 

 

Whatever design you choose, there are a few items that will be common to every display. 
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Display Menu 
Every display will have a menu at the top that gives you access to options for working with your 
records: 

 

Each display that you have open will have its own menu. Changes made using the options on these 
menus will only affect records in the associated display.  

Display Menu 
The Display menu provides options that impact the display itself. 

Print – This option allows you to create a quick printout of the data in your display. 

 Refresh – If you have multiple users using the display at the same time, this option will check the 
database for recent changes and refresh the data in your copy of the display. Data is 
automatically refreshed as you work in the display, but this option will force a refresh to ensure 
you have the latest changes. You can also press F5 to refresh the data. 

Purge all Records – This option will delete all records in your display.  

WARNING! 

  This will remove all of your records. There is no undo. 
Make sure you have a backup of your database before 
proceeding. 

Close - This will close the current display. If you have any unsaved changes to your records, they 
will be automatically saved. 

Data Menu 
The Data menu provides options for working with your records. 

Find – This option allows you to search for a specific record using a value in a text or notes field. 

List View - This option will allow you to view your records in a tabular format. This is useful 
because it allows you to view multiple records at the same time. This option also gives you 
access to printing your data. 
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Saved Lists – If you have previously saved a list view configuration, this option will allow you to 
bypass the setup screen and go directly into a list view with the fields already selected.   

Import – This option will allow you to bring data from another source into your display. 

Export - This option will allow you to copy your data out to an external file that can be printed or 
viewed in other software applications. 

Copy – This option will create a copy of the current record.   

Links – This option lets you link files, websites, and e-mail addresses to the current record and 
launch the items from Database Oasis. 

Sort Menu 
The Sort menu allows you to work with options to control the order of your records. 

Sort by - This will open the Sort By Field screen where you can control the order in which your 
records appear in the list view and when scrolling. For example, if you are looking through a 
phone book, you may want to set the sort order to the last name field. 

Saved Sorts – If you have previously saved a sort order, this option will allow you to set the 
order without going into the setup screen. 

Clear Sort - If you have a sort set, this option will turn it off. You will go back to viewing 
records in the order in which they were added. 

Filter Menu 
The Filter menu allows you to work with options to control what records are currently available. 

Set Filter - Filters let you limit the records that you are currently viewing to only include a 
specified subset. For example, you may be working with a display that contains recipes and want 
to only view recipes with a preparation time that’s under an hour. 

Saved Filters – If you have previously created and saved a filter, this option will allow you to set 
the filter without going into the setup screen. 

Clear Filter - Selecting this menu item will remove the filter if one is set. You will return to 
viewing all records in your display. 

Reporting Menu 
The Reporting menu provides access to the custom report generator where you can create new 
reports, and allows you to run and maintain previously created reports. 

  This feature is only applicable to Database Oasis Professional Edition. 

Create New Report – This option opens the Custom Report Designer at a new, blank report. 

Run Report – This option opens the Select Report to Run screen, where you can select to print a 
previously created report. 

Delete Report – This option opens the Delete Report screen, where you can select to delete a 
previously created report. 
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Edit Report – This option opens the Edit Report screen. Selecting a previously created report at 
this screen will open that report in the Custom Report Designer. 

Child Displays Menu 
The Child Displays menu appears if you have set up a child display. It allows you to open one or 
more child displays.  

  This feature is only applicable to Database Oasis Professional Edition. 

[List of displays] – Each child display you have set up will appear on the menu. Selecting a 
display from the list will open the child. 

Buttons 
The standard button set will appear on every display: 

 

When you’re designing a display, you have the ability to move these buttons, change the size, 
change the color, and even change the text that appears on the button face. 

Although you can change the appearance, the functionality of each button will remain the same for 
all displays. 

  This button is called the Next button. It is used to scroll to the next record. 

  This button is called the Previous button. It is used to scroll back to the previous record. 

  This button is called the Last button. It will jump to the very last record. 

  This button is called the First button. It will jump to the very first record. 

  This button is used to add a new, blank record to your display. 

  This button will allow you to begin editing a record in your display.  

  This button is used to delete a record from your display. 

  This button is available if you are adding or editing a record. Clicking this will save 
your changes. 

  This button is available if you are adding or editing a record. Clicking this will discard 
your changes. 

The following instructions reference these buttons by their default names. If you have changed the 
text on any of the buttons, please substitute your button names when following the instructions. 
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Adding Records 

Once you have your display set up, you are ready to begin populating it with your data.  

ADDING RECORDS TO A NEW DISPLAY 

1 Open the display to which you would like to add records. 

2 If there are no existing records in a display, you will be at a blank record. All of the 
buttons will be dimmed with the exception of the Add button and the record count on 
the title bar will say (0 of 0): 
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3 Click Add. The Delete, Save, and Cancel buttons will become available: 

 

4 Input your data using the guidelines under Inputting Data, later in this chapter. 

5 When you are satisfied with your changes, click Save. If you wish to discard the new 
record, click Cancel. 

Hint 

 Changes will automatically be saved if you move off 
the record, for example, by scrolling to another 
record, clicking the Add button, or closing the 
display, without canceling. If you will be adding 
multiple records, simply click Add again to save and 
start a new record. 
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ADDING RECORDS TO A DISPLAY WITH DATA 

1 Open the display to which you would like to add records.  

2 When you first open the display, you will be at the first record that was added. The 
Save and Cancel buttons will be dimmed out: 

 

3 Click Add. You will be at a new, blank record. The Save and Cancel buttons will 
become available: 

 

4 Input your data using the guidelines under Inputting Data, below. 
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5 When you are satisfied with your changes, click Save, or click Add to save and start a 
new record. If you wish to discard the new record, click Cancel.  

Adding Records to a Child Display 

   Child displays are only available in Database Oasis Professional Edition. 

If you have a child display set up in Professional Edition, you can have one or more child records 
associated with each parent record in the display. When you open the child level, you are 
automatically viewing the records for the currently open parent. When you add a record at the child 
level, it is automatically added to the current parent.  

For example, if you have a display that stores information about classes offered at a school, you may 
have a child level to capture students in each class. To add a student to a class, you would first 
navigate to the class at the parent level, then add the student at the child level. 

ADDING A RECORD TO A CHILD DISPLAY 

1 Open the display to which you would like to add a record. 

2 Navigate to the parent record to which you would like to add a child record. (For help 
with locating the parent record, see Viewing Records, later in this chapter.) 

3 Select Child Displays from the menu. A sub menu will open with the child display: 

 

4 Select the child display to which you would like to add a record. The display will 
open. 

5 Click Add. You will be at a new, blank record. The Save and Cancel buttons will 
become available: 

6 Input your data using the guidelines under Inputting Data, below. 

7 When you are satisfied with your changes, click Save, or click Add to save and start a 
new record. If you wish to discard the new record, click Cancel.  
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Copying Records 

It is possible that you may have more than one record with very similar data.  The copy feature lets you 
quickly add a new record based on an existing record.  The copy can be edited without changing the 
original record. 

ADDING RECORDS BY COPYING 

1 If you would like to make a copy of an existing record, select Copy from the Data 
menu.  A new record will be added with the exact same information as the original 
record.  You can now edit the new record without affecting the original record. 

Editing Records 

Editing is very similar to adding, with the exception that you are making changes to data that was 
previously added rather than imputing new data. 

EDITING EXISTING RECORDS  

1 Open the appropriate display.  

2 Locate the record you would like to edit. (For help with locating records, see Viewing 

Records, later in this chapter.) 
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3 Press the Edit button, or simply start typing in the field containing the data you would 
like to edit. For example, you may want to change the P.O. Box in the above record to 
a street address. Simply delete the contents of the Address field and type in the 
desired street address: 

 

4 When you are satisfied with your changes, click the Save button. If you would like to 
discard your changes, click Cancel. The record will revert to the original data.  

Inputting Data 

Data is entered into the fields on the display. When you click Add or Edit, your cursor will automatically 
be positioned in the first field at the top of your display: 

 

Simply start typing to enter or edit data. (Refer to the Windows® Basics section of Chapter 1 for help 
with entering data in a field.) To move to another field, click in the field or press the Tab key on your 
keyboard to move through fields in tab order. Unless another tab order was specified in the designer, the 
default tab order is left to right, top to bottom. 
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There are some rules that apply when entering data, depending on the type of field you’re working with. 

Inputting Data in Text Fields  
Text fields are the easiest fields to work with. To input data into a text field, simply start typing. Text 
fields can contain any type of characters, including letters, numbers, and symbols. The only 
limitation is the length of the field that was entered when the field was added. For example, if your 
field has been set up to contain a maximum of 10 characters, you will not be able to type the 11th 
character into the field. 

When the text field was added to your display, a frame was created to display the data. It is possible 
that the length of the field that was entered when the field was added allows more characters than 
can be displayed in the frame. In this case the text will appear cut off: 

 

In order to see the rest of the data in the field, you can either press the right arrow key on your 
keyboard to scroll over: 

 

Or you can click in it with your mouse and drag to the right: 

 

Inputting Data in Numeric Fields  
Numeric type fields are limited to only containing numbers and the symbols related to numbers, such 
as the decimal point, comma, and negative indicator. Numeric fields can be a maximum of 17 digits, 
plus the decimal places. This will allow a number up to 99,999,999,999,999,999.  Commas will 
automatically be placed in the field at the thousands marks. 

The number of decimal places you can put in the field depends on the settings that were selected 
when the field was added. If the field was added to contain a fixed number of decimal places, the 
numeric field will default to the selected formatting when you add a new record. For example, if it is 
set to contain two decimal places, new records will contain 0.00 in the field. When you enter a 
number in the field, pressing the decimal/period (.) key on your keyboard will move your cursor past 
the decimal point so you can enter the decimal place data. 

If the field has been configured to contain a variable number of decimal places, it will allow for a 
variable number of decimal places, up to six. If you press the decimal/period (.) key on your 
keyboard, it will place a decimal point at the cursor position. 

To make a number negative, press the - key on your keyboard from anywhere in the field. The - 
character will appear at the beginning of the number. To return the value to a positive number, delete 
the - character from the field. 
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Inputting Data in Auto-Incrementing Fields 
Auto incrementing fields look like numeric fields, with the exception that you cannot manually enter 
or edit data in the field. When you first add a record, 0 appears in the field; when you save the 
record, the number automatically increments by 1 from last number used. 

Inputting Data in Notes Fields  
Notes fields are very similar to text fields, with the exception that you can wrap to multiple lines in 
the field. You can also press Enter on your keyboard in the field to start a new line of text. A notes 
field will look something like this: 

 

The size of the field was determined when it was added to the display. If you enter more data than 
can be seen, the scrollbar to the right of the field will be enabled, allowing you to scroll down to 
view the hidden data. 

Inputting Data in Date Fields 
Date fields are pre-formatted to contain dates. As soon as you click in a date field, a popup calendar 
opens: 

 

The date at the top of the calendar shows the current day’s date. You can select today’s date at any 
time by clicking on this section. 

The left and right arrows on the top edges of the calendar let you scroll the display. The scroll 
increment is indicated below the current date display. By default, the arrows scroll by one month at a 
time. 
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Click on the scroll increment indicator (in the above example, click on January, 2010) to zoom out 
and scroll by year. Click a second and third time to scroll by decade or century: 

     

When viewing by century, scroll to the desired century and click on the decade you would like. The 
calendar will zoom in to the decade view. When viewing by decade, scroll to the desired decade and 
click on the year you would like. The calendar will zoom into year view. When viewing by year, 
scroll to the year and click on the desired month to return to the default view. 

Once you have located the appropriate month and year, click on the desired date. The date will be 
entered in the field. The date format will default to the format you have set up in Windows. 

You can edit the date by typing in the field, or by selecting a different date from the pop-up calendar. 

To edit the date using the calendar, click on the calendar button to the right of the field to reopen the 
pop-up calendar. 

To edit the date by typing in the field, enter the appropriate value in the first section of the field: 

 

In the example above, you would enter the month. You can also increment the value by pressing the 
up or down arrow key on your keyboard. 

Once you have entered the desired value, use the right arrow key to move to the second section: 

 

You will only be able to enter a valid date value in each section of the field. For example, you cannot 
enter 20 in the month section of the field. 

To remove a date from the field, open the calendar and click Clear. 
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Inputting Data in Check Boxes 
Check boxes are a simple yes/no flag. They appear on the display as a small box, followed by a 
name indicating what the check box is used for: 

 

In the above example, the check box indicates whether or not the customer accepts mailings. Data is 
entered in the check box by clicking in it, or tabbing to the check box and pressing the spacebar on 
your keyboard. Either action will toggle the check mark in the box: 

 

Using the above example, a mark would indicate that the customer does accept mailers. No mark 
would indicate that the customer does not accept mailers. 

Inputting Data in List Fields 
List fields appear with a small arrow next to the field: 

 

When you click on the arrow, a list of options appears: 

 

This list contains the values that were set up for the field. Clicking on an option places that item in 
the field: 

 

When the list field was set up, the person who created the field was given the option to allow users 
to type in the field, or limit it to only allow entries selected from the list. If the field has been 
configured to allow you to type in the field, you will be able to click in the field and a cursor will 
appear. If the field has been configured to only allow selections from the list, when you click in the 
field the list will open. 
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Inputting Data in Picture Fields  
A picture field will initially appear as an empty frame: 

 

In order to enter a picture in the field, you must select the graphic file you would like to use. To 
select the file, simply double click in the field to open a Windows Open dialog.  

Note 

 When you select pictures in Professional Edition, 
make sure that they are stored on a shared network 
drive and that all users are mapped with the same 
drive letter.  

As soon as you select a graphic file, the Picture screen will open: 
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This will display the path to the graphic, as well as a thumbnail of the selected picture. 

Note 

 The proportions of the sample may or may not match 
the proportions of your picture field on the display. 

If you would like to change the picture, click Select Picture to access the Windows Open dialog 
again. When you are satisfied with your picture selection, click Close. The selected picture will be 
displayed in the field: 

 

To change or remove a picture, simply double click again to access the Picture screen. To change the 
picture, click Select Picture. The Windows Open screen will appear. To remove the picture, select 
Clear Picture. The picture field will return to the empty frame. 

Note 

 As you make changes to the picture, they will 
automatically be saved to the picture field. If you 
would like to cancel the changes, click the Cancel 
button on the record. 
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When you add a picture, what is actually saved is the path to the graphic file. If the file is ever 
deleted or moved, the picture in the record will be replaced with a red X: 

 

Double click on the picture field to clear the path reference or select another graphic file. 

Inputting Data in Calculated Fields  
Calculated fields allow you to perform math on numeric fields, or string together two fields or a field 
and another value. (Refer to Using Calculated Fields on Your Display in Chapter 6 for more 
information on the types of calculations that are available.)  

Calculated fields will appear dimmed out on your display: 

 

The data in the field is populated automatically based on the calculation as soon as a record is saved. 
Calculated fields do not require or allow any manual data entry. 

Inputting Data in Child Rollups  

   Child displays are only available in Database Oasis Professional Edition. 

If you have a child display set up in Professional Edition, you can have multiple child records 
associated with each parent record in this display. Child rollups allow you to view a table with 
information from the child level. As you scroll through your records, the information will update to 
reflect the children associated with the current parent record. 
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If you have the child level open, any filter or sort order set at the child level will be reflected in the 
rollup. (Refer to the Sorting Records and Filtering Records sections, later in this chapter, for details.) 

The data that appears in the rollup is pulled from the child level. To modify it, you must open the 
child level and edit the child record directly. (See Opening Child Displays, earlier in this chapter, for 
details.) 

Inputting Data in Parent Fields  

   Child displays are only available in Database Oasis Professional Edition. 

If you have a child display set up in Professional Edition, you can display data from the parent 
record on the child level. Parent fields are display only and must be edited on the parent level. These 
fields will appear like normal fields, except you will not be able to edit them. 
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Viewing Records 

Records can be viewed in two formats: the single record view or the list view. By default, when you first 
open a display, you will be viewing the first record you added in single record view: 

 

Using this example, all of the information on this page belongs to Mary Jones. Any changes that you 
make to this record will only affect Mary Jones. 

The title bar of the display tells you how many records are in your display and what record you are 
currently viewing:  

 

In the above example, you are viewing record 1 of 8 total records in the display. 

Note 

 It is possible to set a filter so you only view a sub-set 
of records in your display. If a filter is set, the record 
count will show the number of records in the filter. 
Refer to Filtering Records, later in this chapter, for 
more information. 



  Viewing Records 

Chapter 7 – Working with Records in Displays  ♦  Page 205 

Scrolling 
You can move to the next record by using the scroll buttons: 

 

Use the Next button  to view the next record that was added to the display: 

 

You are now viewing information related to Joe Smith. Any changes you make here will only affect 

Joe’s record. If you click the Previous button , you will move back to Mary Jones’ record.  

Unless you have a sort set, you will scroll through the records in the order in which they were added. 
(See Sorting Records below for more information.) 

Since Mary Jones’ record was the first record added to the display, clicking the First button  
will automatically take you to her record. (If you are sorting your records, it will take you to the first 
record in order of the sort.) 
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To quickly move to the record that was added most recently (or the last record in order by your sort) 

click the Last button : 

 

If the Next and Last buttons dim out, it means you are at the very last record: 

 

If the Previous and First buttons dim out, it means you are at the very first record: 

 

If you do not have any records in your display, or you have only one record, all four buttons will be 
dimmed out:  
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Sorting Records  
Sorting lets you control the order in which records are presented. For example, if you have a display 
that contains contact information, you may want to sort by last name. Records will appear in order of 
the sort when scrolling, in the list view, when printing, and when exporting. If there is no sort in 
place, such as when you first open the display, records will appear in the order in which they were 
added. 

SORTING RECORDS 

1 Open the display you would like to sort. 

2 From the menu inside the display, select Sort By from the Sort menu: 

 

3 The Sort By Field screen will open: 
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Hint 

 If you have previously set up a sort and saved it, you 
can select it from the Use Saved Sort list. The screen 
will update to show the sort criteria. Refer to Saving 

and Recalling Sorts, later in this section, for details. 

4 Click the arrow next to the list field in the Sort By section and select the field on 
which you would like to sort. For example, if your display contains names and 
addresses and you want to see people in order by last name, you would select the field 
that contains last names. 

5 Select the Ascending radio button if you would like to see records in alphabetical 
order going from A to Z. If your field is a numeric field, this will go from the smallest 
number to the largest.  

Select Descending if you would like to see records in alphabetical order going from 
Z to A, or numbers going from the highest to the lowest. 

If you have a text field that contains numbers (rather than a numeric field type), it 
will sort by the value of each digit in order. So 10 would be seen as 1 and 0 as 
opposed to ten. For example, sorting in ascending order with a character field, the 
numbers 1 through 10 would sort: 

1 
10 
2 
3 
etc... 

To have records sort by the value, make sure your field type is numeric.  

If you are sorting on a check box, records with unmarked check boxes will appear 
first in ascending order, followed by records with marked check boxes. 

If you are sorting on a notes field, the records will be sorted in order of the first 
characters in the field. Numbers in the first position of a notes field will sort 
following the rules for text fields. 

6 Use the second and third sets of sort criteria if you would like to sub-sort. This is 
useful if several records will have the same value in the field you selected as the 
primary sort. This allows you to further sort those matching records based on another 
field.  
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For example, if you have a display that contains names, you could sort on last 
name, then by first name. A display that contains: 

First Name Last Name 

Larry Smith 
Maria Ruiz 
Bob Adams 
Kurt Smith 
Adam Kuznetsov 
April Smith 

Would sort like this: 

First Name Last Name 

Bob Adams 
Adam Kuznetsov 
April Smith 
Kurt Smith 
Larry Smith 
Maria Ruiz 

You could use the third sort criterion to put people with the same first and last name 
in order by ZIP code. 

7 If for any reason you would like to clear your sort and start over, click the New 
button.  The fields blank out so you can start from scratch. 

8 Click Run to set the sort. Now when you scroll through your records, they will appear 
in the order you specified. 

9 When you are done using the sort, select Clear Sort from the Sort menu to return to 
viewing records in the order in which they were added. 

Saving and Recalling Sorts 
Once you have set up a sort, you can save it for quick access in the future. For example, if you 
frequently need to see your address book in order by last name, then first name, you can create a sort 
on those values and recall it, without having to set it up each time. 

In addition to being able to quickly set a previously saved sort, you can access any saved sort in the 
Sort By Field screen where you can modify it if necessary, or quickly create a new sort based on an 
existing one. 

SAVING SORTS 

1 Set up your sort following the instructions under Sorting Records, above. 

2 As soon as you select a field in the Sort By section, the Save button becomes 
available. 



  Viewing Records 

Chapter 7 – Working with Records in Displays  ♦  Page 210 

3 Click Save. 

4 The Save Sort screen opens: 

 

5 Enter a name for your new sort in the Name field. 

6 Click OK. 

7 You will return to the Sort By Field screen with the name of your new sort in the Use 
Saved Sort list: 

 

8 To set the selected sort, click Run. 

USING A SAVED SORT 

1 If you would like to set a saved sort without going back into the Sort By Field screen, 
select Saved Sorts from the Sort menu. 

2 The Saved Sorts screen will open: 
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3 Select the desired sort from the list and click Run.  Your records will be in order by 
the sort. 

MODIFYING A SAVED SORT 

1 Select Sort By from the Sort menu to open the Sort By Field screen. 

2 Select the sort you would like to modify from the Use Saved Sort list. 

3 The Sort criteria fields will update with the settings from the selected sort. 

4 Make any desired changes to the sort.  At this point, you have the option to overwrite 
your existing sort, or save a copy to a new name. 

5 To overwrite your existing sort, just click Save.   

6 To save a new copy, click Save As. The Save Sort screen will open where you can 
name your new sort. When you click OK, both the original sort and the new sort will 
be in the Use Saved Sort list, with the new sort selected. 

7 Toggle between any of the saved sorts by selecting them from the Use Saved Sort list. 

DELETING A SAVED SORT 

1 If you no longer need a sort you previously saved and would like to delete it, select 
Saved Sorts from the Sort menu. 

2 The Saved Sorts screen will open. 

3 Highlight the sort you would like to remove and click Delete.  

Note 

 If you delete the sort that is currently being used in 
the display, it will be cleared. Your records will go 
back to the order in which they were added.  
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Filtering Records 
Filtering your data allows you to only work with a select group of your records. For example, if you 
are working in an advertising campaign display, you may want to only view records for customers 
who accept e-mail solicitations. 

Database Oasis Basic Edition lets you set a filter on one field. Database Oasis Professional Edition 
lets you set a filter on up to 12 fields. 

Note 

 If you are viewing a child display in Professional 
Edition, a filter is automatically applied to show only 
records associated with the current parent. Any filter 
you set at the child level will be applied on top of the 
parent record filter. 

Filters in Basic Edition 

SETTING A FILTER IN BASIC EDITION 

1 From the menu inside the display, select Set Filter from the Filter menu: 

 

2 The Filter screen will open: 

 



  Viewing Records 

Chapter 7 – Working with Records in Displays  ♦  Page 213 

Hint 

 If you have previously set up a filter and saved it, you 
can select it from the Use Saved Filter list. The screen 
will update to show the filter criterion. Refer to 
Saving and Recalling Filters, later in this section, for 
details. 

3 The Field drop-down list will show all of the fields in your display (with the 
exception of picture fields). Select the field that you would like to use in your filter 
from the list.  

4 Comparisons let you specify how the value in a field should compare to the value in 
the filter criterion when determining whether or not the record should be included in 
the filter. The Comparison drop-down list will include all of the comparisons that are 
available for your selected field type. 

• Equal = A record will only be included in the filter if the value in the field in 
your display exactly matches what you enter in the Value field in your filter. 
(The capitalization does not need to match.)  

• On = This option appears if you have selected a date field. It functions the 
same as Equal. 

• Does Not Equal = A record will only be included in the filter if the field does 
not match what you enter in the Value field in your filter. 

• Is Greater Than = If your field is numeric, a record will only be included in 
the filter if the numeric value in the field is higher than what you enter in the 
Value field in the filter. For example, if you have a display for accounts 
receivable, you could use this to only view clients who have a balance over 
$1000. 

If you have a character field, a record will only be included if the first 
characters in the field are later in the alphabet than what is entered in the 
Value field. For example, if you have a display that contains names and you 
would like to work with people whose last name starts with M or later, you 
could use this comparison with L as the value. If you have to stop working 
after just getting through the Mc's, in your next work session, you could enter 
Mc in the Value field and easily pick up where you left off. 

If you have a character field that contains numbers, the software will analyze 
each number in order, rather than the value of the number. For example, if you 
enter Is Greater Than a Value of 9 and have a record with 11 in the field, the 
filter will look at the 1 in the first position and the record will get filtered out. 
If you are working with a numeric field instead, the software will recognize 11 
as being greater than 9 and include the record in the filter. 
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• After = This option appears if you have selected a date field. It functions the 
same as Is Greater Than. 

• Is Greater Than or Equal = This is similar to Is Greater Than, with the 
exception that it includes records that match what is entered in the filter 
Value, whereas Is Greater Than does not. For example, if you have a display 
that contains names and you enter L as the Value using Is Greater Than, you'll 
get everyone with a last name starting with M or higher. If you use Is Greater 
Than or Equal, you'll get everyone with a last name starting with L or higher.  

• On or After = This option appears if you have selected a date field. It 
functions the same as Is Greater Than or Equal. 

• Is Less Than = This work exactly the same as Is Greater Than, only it includes 
records where the number in a numeric field is smaller than the Value, or 
characters in a character field are lower in the alphabet than the specified 
Value. 

• Before - This option appears if you have selected a date field. It functions the 
same as Is Less Than. 

• Is Less Than or Equal = This works exactly the same as Is Greater Than or 
Equal, only with records where the value/character is lower than what is 
specified in the Value field. 

• On or Before = This option appears if you have selected a date field. It 
functions the same as Is Less Than or Equal. 

• Contains = This is similar to Equal, but only requires that the field contains 
the value, rather than requiring that it exactly matches. For example, you may 
have first and last names in a single field. Using Contains with a value of 
Smith will bring up John Smith and Mary Smith. If you used Equal, it would 
only bring up records where Smith was the only thing in the field.  

• Does Not Contain  = This is similar to Contains, but will include records that 
do not have the specified value in the field. 

Notes 

 The Contains and Does Not Contain options are only 
available for text and notes fields. (These are the only 
options available for notes fields). 

 If you have selected a check box field, the only 
available comparison is Equals. 
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 If you have selected a date field for your filter, Not 
Equal, Contains, and Does Not Contain options will 
not be available.  

5 Enter the value that should be compared to the data in the selected field. (See step 4, 
above, for a discussion on how the records will be analyzed against this value with 
each comparison type.) 

• If you have selected a text, numeric, notes, or calculated field for your filter, 
type the value in the field or leave the value blank to search for empty fields. 

• If you have selected a date field, click the icon next to the field to select a date 
from the pop-up calendar. 

• If you have selected a list field, click the icon next to the field to select the 
value from the list. If your list field allows you to type in the field rather than 
just selecting from the list, you can also type in the filter value or leave the 
value blank to search for empty fields. 

• If you have selected a check box field, the Value field provides a list that 
contains Checked or Unchecked. Select the appropriate option from the list. 

6 Click Run to execute your filter. When you scroll through your records, only records 
that meet the filter will be included. Records that do not meet the filter will be hidden. 
The record count on the display’s title bar will update to show the number of records 
in the filter: 

 

7 When you are ready to return to viewing all records, select Clear Filter from the Filter 
menu. 

Filters in Professional Edition 

   Multi-line filtering is an advanced feature that is only available in Professional Edition. 

SETTING A FILTER IN PROFESSIONAL EDITION 

1 From the menu inside the display, select Set Filter from the Filter menu: 
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2 The Filter screen will open: 

 

Hint 

 If you have previously set up a filter and saved it, you 
can select it from the Use Saved Filter list. The screen 
will update to show the filter criteria. Refer to Saving 

and Recalling Filters, later in this section, for details. 

3 Add the first filter line using the guidelines under Setting a Filter in Basic Edition, 
above. 

4 To add the next line, open the And/Or drop down list and make a selection using the 
following guidelines: 

• Select And if you would like the filter to only include records that meet both 
criteria.  

• Select Or if you would like the filter to include record that meet either criteria.  

5 When you make a selection from the And/Or list, a second line will be added to the 
filter screen: 

 

6 Continue adding lines (up to 12) until all of your filter conditions are entered.  
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7 Use the open and close parentheses fields to group your filter criteria. For example: 

 

The above filter will find records where either 

(Under Warranty is checked and Replacement Cost is more than $500) 

Or 

(Under Warranty is not checked and Replacement Cost is less than $500) 

You can select up to three parentheses, which allows you to create up to two sub-
groupings. 

8 If you need to remove a line, select Remove Line from the And/Or list. The lines 
below will move up.  

Note 

 When you remove a line, be sure to check your 
And/Or value on the line above to make sure it is still 
applicable. If you are using groupings, you should 
also check your parentheses to make sure they are 
still valid. 

 

Note 

 If you have the maximum number of lines in a filter, 
the And/Or field is dimmed out. To remove the last 
line, you must first remove one of the lines above. 
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9 When you have finished creating your filter, click the Validate button. This runs a 
check on the filter to make sure that it is valid. If the filter is invalid, check the 
following: 

• Make sure that the Field, Comparison, and Value fields are filled in for all 
lines. 

• Make sure that you have an even number of open and close parentheses, and 
that the open parentheses are before the close parentheses. 

• Make sure that the value is compatible with the field type on all lines. (For 
example, you cannot have a letter in a numeric field.) 

10 Once you are satisfied with your filter, click Run. When you scroll through your 
records, only records that meet the filter will be included. Records that do not meet 
the filter will be hidden. The record count on the display’s title bar will update to 
show the number of records in the filter: 

 

11 When you are ready to return to viewing all records, select Clear Filter from the Filter 
menu. 

Saving and Recalling Filters 
Once you have set up a filter, you can save it for quick access in the future. This is especially useful 
in Professional Edition if you have filters with multiple criteria. 

In addition to being able to quickly set a previously saved filter, you can access any saved filter in 
the Filter screen where you can modify it if necessary, or quickly create a new filter based on an 
existing one. 

SAVING FILTERS 

1 Set up your filter following the instructions under Setting a Filter in Basic Edition or 
Setting a Filter in Professional Edition, above. 

2 Click Save. 

3 The Save Filter screen opens: 

 

4 Enter a name for your new filter in the Name field. 
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5 Click OK. 

6 You will return to the Filter screen with the name of your new filter in the Use Saved 
Filter list: 

 

7 To set the selected filter, click Run. 

USING A SAVED FILTER 

1 If you would like to set a saved filter without going back into the Filter screen, select 
Saved Filters from the Filter menu. 

2 The Saved Filters screen will open: 

 

3 Select the desired filter from the list and click Run. When you scroll through your 
records, only records matching the selected filter will appear. 

MODIFYING A SAVED FILTER 

1 Select Set Filter from the Filter menu to open the Filter screen. 

2 Select the filter you would like to modify from the Use Saved Filter list. 

3 The filter criteria fields will update with the settings from the selected filter. 
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4 Make any desired changes to the filter.  At this point, you have the option to 
overwrite your existing filter, or save a copy to a new name. 

5 To overwrite your existing filter, just click Save.   

6 To save a new copy, click Save As. The Save Filter screen will open where you can 
name your new filter. When you click OK, both the original filter and the new filter 
will be in the Use Saved Filter list, with the new filter selected. 

7 Toggle between any of the saved filters by selecting them from the Use Saved Filter 
list. 

DELETING A SAVED FILTER 

1 If you no longer need a filter you previously saved and would like to delete it, select 
Saved Filters from the Filter menu. 

2 The Saved Filters screen will open. 

3 Highlight the filter you would like to remove and click Delete.  

Note 

 If you delete the filter that is currently being used in 
the display, it will be cleared. You will go back to 
viewing all records.  

Searching for Records 
If you wish to locate a specific record, you can use Find to search your display for a value in a text 
or notes field. For example, you may have a display that contains your customers and wish to locate 
the XYZ company. If you know that the text “XYZ” will be located in the Company field, you can 
use Find to search for the record. 

Note 

 Find at the Professional Edition child level only 
searches the current parent.  

SEARCHING FOR RECORDS 

1 Open the display containing the record you would like to locate. 
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2 Open the Find screen using one of the following methods: 

• From the File menu, select Find: 

 

• Press CTRL+F on your keyboard. 

3 The Find screen will Open: 

 

4 Select the field that contains the data you’re searching for from the In Field list.  
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5 Enter the text that identifies the record you would like to locate in the Find field. For 
example, if you wanted to locate a customer record for the XYZ company, you could 
enter XYZ in the field. 

Note 

 The search will locate whole words, anywhere in the 
field. For example, you may search a field that 
contains first and last names for Sam. It would find 
“Sam Smith”, and “Mary and Sam Jones”, but it 
would not find “Samuel Baker”. Be aware as well that 
differences in punctuation could cause a record not to 
be found. For example, if you are searching for Inc. in 
a company field, a record containing Inc without the 
period would not be located in the search. 

6 Click Find Next or press ALT+F. The first record that matches your search criterion 
will open. If this is not the record for which you are looking, press Find Next again. 
The search will continue to bring up matching records until it has gone through all 
records in your display.  

Note 

 If you have a filter set, Find will only locate records 
that are within the filter. If you wish to locate a record 
that is outside of the current filter, remove the filter 
before searching. 

7 Click Close when you are finished searching.  

Viewing Records in a Child Display 

   Child displays are an advanced feature that is only available in Professional Edition. 

Viewing records in a child display is very similar to viewing records in any other display. You may 
scroll records and set sorts and filters just like you would at the parent level. The one notable 
exception is that when viewing or searching for records at the child level, you will only see the 
records for each parent.  
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The title bar of the display indicates how many child records are associated with the current parent:  

 

In this example, there are four call log records associated with the B&G Auto parent record. In the 
same display, there are only two call logs for the Nancy Winters parent record: 
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If you’ve added a child rollup to the parent level, you can also see details of the child records in the 
rollup, without opening the child level: 

 

If you set a sort or filter at the child level, it will be reflected in the parent level rollup. 

If you have more than one child level associated with your display, you can have multiple child 
rollups and view data from each child independently. 
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Viewing Records in List View 

List View provides a tabular list of your records. This is convenient because it allows you to see 
more than one record at a time and compare data from multiple records side-by-side. 

Lists may be set up for one time viewing, or saved for future access. 

SETTING UP LIST VIEW 

1 Open the display that contains the data you would like to view. 

2 From the Data menu, select Setup List View: 
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3 The Select Fields screen will open: 

 

4 This screen allows you to control what fields are shown in the list and in what order 
they appear. The Available Fields box provides the list of fields in your display. To 
include a field in the list view, double click on it or highlight it and click the Select 
button. The field will move from the Available Fields list to the Selected Fields list. 
To select all fields, click Select All. 

5 If you have selected a field and decide you do not want to view it in the list, double 
click on it in the Selected Fields list or highlight it and click Remove. It will move 
back to the Available Fields list. If you would like to clear the Selected Fields list and 
start over, click Remove All. 

6 When the list view is displayed, fields will be shown in the order that they appear in 
the Selected Fields list. The arrow buttons next to the Selected Fields list allow you to 
move fields up or down in the list to change their order in the list view. Highlight a 
field in the Selected Fields list and click the appropriate button until the field is in the 
desired position. 
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7 Click OK to open the list view with the selected fields:  

 

8 The grid on the screen shows the records in your display. Each row is a separate 
record. Each column is one field in the record. Using the example above, the first row 
contains information about the Ford Mustang. The second row contains information 
about the sliver candlesticks, and so on. 

9 The list view will open at a default size. If you have more columns than can be 
displayed, a horizontal scroll bar will appear at the bottom of the screen. If you would 
like to make the screen wider to accommodate more fields, hover your mouse along 
the right edge of the screen. It will change to a double headed arrow. Click and drag 
to size the screen.  

10 A solid gray area below the grid, as shown in the example above, indicates that the 
default height of the list view is taller than what is necessary to accommodate the 
number of records being displayed. If there are more rows of data than can be 
displayed, the gray area will not be seen and a vertical scroll bar will appear along the 
right edge of the screen. If you would like to make the screen taller to accommodate 
more records, or you would like to make it smaller to remove the space below 
records, hover your mouse along the bottom edge of the screen. When it changes to a 
double headed arrow, click and drag to size the screen. 
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11 If there is more text in the field than can be displayed, it will be followed by an 
ellipsis (...). If you hover your mouse over the field, the full contents of the field will 
be visible in a tooltip.  

12 You can change the size of the columns or the height of the rows by clicking and 
dragging. Simply hover your mouse over the bar between the field names: 

 

13 Or the bar between the rows in the first column:  

 

14 The mouse will change to a double headed arrow. Click and drag to change the size 
of the column or the height of the row: 
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Hint 

 If you double click on the bar between the field 
names, the column will automatically size to 
accommodate the field with the most data. 

15 If you change the height of a row, all of the rows will adjust to the new size. The only 
exception to this is notes fields. The height of records with notes fields will be 
automatically adjusted to display all of the text in the note and cannot be sized 
smaller.  

16 If you have picture fields in your display, the picture will shrink to fit the field in the 
list, but will maintain its relative proportions. For example, if your picture is 4 inches 
tall by 2 inches wide, and you size the field in the list to be 1 inch square, the picture 
will appear 1 inch tall by 0.5 inches wide. If a picture is smaller than the field in the 
list, it will appear centered in the field at its actual size. Rows with picture fields have 
a default minimum height of 50 pixels and cannot be sized smaller. 

17 The list view can be left open while you work in your display, allowing you to work 
with the list and individual records at the same time. This list will be synchronized 
with the records you are viewing in your display. If you have a filter in place, only 
records that match the filter will be shown here. If you have a sort in place, records 
will appear in the order of the sort.  

18 The record that is showing in your display will also be selected in the grid. The gray 
arrow in the first column indicates the current record:  
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19 In the above example, the Ford Mustang is selected, and therefore the record 
currently open in your display: 

 

20 If you change records in your display view, the arrow will move to the appropriate 
line in the list. If you click on a different record in your list view, the arrow will move 
and your display view will update to show that record.  

21 If you would like to save your list view so it may be quickly accessed again later, 
refer to Saving List Views, below. 

22 When you are done working with the list view, click Close to exit the screen. 

Saving and Recalling List Views 
Once you have set up your list view, you can save it for quick access in the future.  This is especially 
useful if you have a particular view that you will need to access and/or print regularly. 

SAVING LIST VIEWS  

1 Set up your list view following the instructions under Setting up List View, above. 

2 Once you have the list how you want it, including the size of the window and 
columns, click Save List. 
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3 The Save List View screen opens: 

 

4 Enter a name for your new list view in the Name field. 

5 Click OK. 

6 You will return to list view with the name of your new list in the Use Saved List field. 

VIEWING SAVED LIST VIEWS 

1 Select Saved Lists from the Data menu to open the Saved Lists screen. 

 

2 Highlight the list you would like to view and click Run. 

3 List View will open to the selected list. 
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4 If you would like to modify the size of the size of the window or columns in the saved 
list, make any necessary changes following the guidelines under Setting up List View, 
earlier in this section. When you are satisfied with your selections, click Save List. 
The next time you open the list view, the changes will be reflected. 

Note 

 If you don’t save the changes, the list view will revert 
to the last saved size the next time it is opened. 

Note 

 If you save changes to the size of the window and 
columns, the changes will be in effect for all users in 
Professional Edition. 

5 If you would like to view a different list, select it from the Use Saved List field. You 
may toggle between any of your saved list views. 

DELETING A SAVED LIST VIEW 

1 If you no longer need a list view you previously saved and would like to delete it, 
select Saved Lists from the Data menu. 

2 The Saved Lists screen will open. 

3 Highlight the list view you would like to remove and click Delete.  

Editing Data in List View 
You can edit and add data directly in the list view. This can be particularly useful if you need to 
make quick changes to multiple records.  

EDITING DATA IN LIST VIEW 

1 Open the list view and size the screen, rows, and columns as desired. 
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2 Click in the field you would like to edit. When you click in a field, a cursor will 
appear in the field and a pencil will appear in the first column:  

 

3 In the above example, the Location in… field for the Nissan Murrano is selected. 
Type at the cursor point to make edits as you would in display view.  

4 Use the following guidelines for editing different field types: 

Text Fields – There are no differences when editing text fields in list view versus 
display view.  

Numeric Fields – There are no differences when editing numeric fields in list view 
versus display view.  

Date Fields – The calendar icon will only appear in the date field when you click in 
the field. Also, the up and down arrow keys will move you to the next and previous 
records, rather than incrementing the date.  
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Check Boxes – Check boxes appear as a box in the column:  

 

You can edit check boxes by either clicking on them, or clicking in the column and 
pressing the spacebar on your keyboard. 

List Fields – The arrow will only appear in the list when the field is selected. Other 
than that, there are no differences when editing a list field in list view versus display 
view. 

Picture Fields – You cannot edit picture fields in list view.  

Notes Fields – Edit data in a notes field by simply typing in the field. If the field is 
sized smaller than necessary to accommodate the text you enter, scroll bars will 
appear to the right of the field: 

 

Click the buttons to scroll up or down to view additional data. 

 

As soon as you click out of the notes field, it will expand to accommodate the data: 

 

5 As soon as you make a change to the data, the pencil will be replaced with an 
insertion cursor, indicating you are editing a record: 

 

6 Changes will be saved as soon as you leave the field. 
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Linking to Records 

Links let you associate files on your computer, websites, and e-mail addresses with a Database Oasis 
record. When you have the record open, you can access the link screen and quickly launch the 
associated item. For example, you may want to be able to view the .pdf file of an unpaid invoice from a 
vendor record, open a software program from the Software Inventory display, or launch your music 
player to listen to a song in the Music Catalog display.   

Links work using your Windows file associations. These associations tell Windows what software to use 
for various types of files. If you can double click on a file in Windows File Explorer and have it launch, 
you can launch it directly from within Database Oasis. Refer to your Microsoft Windows documentation 
for help with Windows file associations. 

Note 

 Linked items remain stored on your hard drive in their 
original location. They are not copied to the database.  

LINKING ITEMS TO A RECORD 

1 Open the display that contains the record to which you would like to link a file. 

2 Locate the desired record and select Links from the Data menu: 
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3 The Manage Linked Items screen will open: 

 

4 Click Add. 

5 The Add Link Item screen will open: 

 

6 Select the Type of Link you would like to create. 

• File Link lets you link to a file on your computer. This enables you to launch the 
file in the associated application. 
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• Internet Website lets you enter a website URL. This enables you to launch your 
web browser at the specified website. 

• E-Mail Address lets you enter an e-mail address. This enables you to launch a 
new piece of mail in your e-mail software with the specified address already 
entered. 

7 Enter the file or address to which you would like to link in the field.  

• If you are linking to a file, enter the full path and file name, or click the ellipse 
button to locate the file using the Windows Open dialog box. 

Note 

 When a user launches the file, it will use the path that 
is entered. If the path from your computer is different 
than the path on the other user’s computer, the file 
will not launch. Make sure that files are stored on a 
shared network drive and that all users are mapped 
with the same drive letter.   

• If you are linking to a website, type the URL in the field. 

• If you are linking to an e-mail address, type the full address. 

8 When you are satisfied with your link, click OK. You will return to the Manage 
Linked Items screen with the new link in the list. 

LAUNCHING LINKED ITEMS 

1 Open the record with the linked item you would like to launch. 

2 Select Links from the Data menu. 
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3 The Manage Linked Items list will open with the links that have previously been set 
up: 

 

4 Highlight the link you would like to open and click Launch. 

5 If you have selected a file link, the file will open in the associated application. If you 
have selected a website, your browser will open to that page. If you have selected an 
e-mail address, a new e-mail will open in your mail software with the address in the 
To field. 

Managing Links 
Once you have created your links, you can maintain them in the Manage Linked Items screen. 

EDITING LINKS 

1 To change link information, open the record with the linked item you would like to 
launch and select Links from the Data menu. 

2 The Manage Linked Items list will open with the links that have previously been set 
up. 

3 Highlight the link you would like to change and click Change. 
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4 The Edit Link Item screen will open: 

 

5 Make any necessary changes to the linked item and click OK. 

DELETING LINKS 

1 From the Manage Linked Items list, highlight the link you would like to remove and 
click Delete. 

Note 

 This only deletes the association between the item 
and the record. If you are deleing a file link, it does 
not delete the file itself. 
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Printing Records 

The print feature allows you to create a printout of the records in your display. In addition to being able 
to send the printout to your printer, you can also print to one of several supported file types, and have the 
file automatically attached to an e-mail to facilitate sharing data. 

Hint 

 If you need to create mailing labels or apply 
additional formatting to your printouts, use the export 
feature, detailed later in this chapter, to create a file 
that can be opened in a word processor. 

There are two types of printout available: 

• You can create a quick printout that lets you print for either the current record, or all 
records in the current filter. 

• You can print records in tabular format using list view. 

Printing Individual Records 
This option allows you to create a quick printout of one or more fields in your data with one field per 
line. You have the option of printing a single record or all records in the current filter. If you select 
to print all records, records will print using the current sort order. 

PRINTING RECORDS 

1 Open the display whose data you would like to print. 

2 If you would like to limit the records that are printed, set a filter using the instructions 
under Filtering Records, earlier in this chapter. 

3 If you would like your records to print in a particular order, set a sort using the 
instructions under Sorting Records, earlier in this chapter. 

4 From the Display menu on the display, select Print. 
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5 A menu will appear giving you the option to print all fields, or select the fields to 
print: 

 

6 If you would like to print all fields, skip to step 12, otherwise, select Select Fields. 

7 The Select Fields screen will open: 

 

8 The Available Fields box provides the list of fields in your display. To include a field 
in the printout, double click on it in this list or highlight it and click the Select button. 
The field will move from the Available Fields list to the Selected Fields list. To select 
all fields, click Select All. 

9 If you have selected a field and decide you do not want to include it in the printout, 
double click on it in the Selected Fields list or highlight it and click Remove. It will 
move back to the Available Fields list. If you would like to clear the Selected Fields 
list and start over, click Remove All. 

10 When the records are printed, the data will be listed in the order that the fields appear 
in the Selected Fields list. The arrow buttons next to the Selected Fields list allow you 
to move fields up or down in the list to change their order in the printout. Highlight a 
field in the Selected Fields list and click the appropriate button until the field is in the 
desired position. 

11 When you have the fields you would like in the order you would like them, click OK. 
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12 The Print screen will open: 

 

13 The Title field allows you to enter a title that will print at the top of the printout.  This 
defaults to the name of your display. Enter a different name if desired, or delete the 
contents of the field if you do not want a title. 

14 The Current Record and All Records radio buttons allow you to specify whether you 
would like to print the only the record that is currently open in the display, or all 
records. Select the desired radio button.  

Note 

 If you have a filter set, the All Records prompt will 
toggle with All Records in Current Filter. If this is 
selected, the printout will include all records in the 
currently set filter only. 

15 If you are printing from a child level in Professional Edition, the Print screen will 
include a Current Parent Only check box: 

 

Selecting Current Parent Only allows you to limit your printout to records associated 
with the current parent. Leave this unmarked to print all child level records, 
regardless of the parent.  
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16 Click Print to open a print preview where you can control the settings for your 
printout.  

 

17 See Print Preview, later in this section for details. 

Printing from List View 
Printing from list view gives you the option of printing your data in tabular format, or printing the 
currently highlighted record.  

Printing a Single Record 
Printing a single record in list view is similar to printing from the File menu and selecting to print 
the current record, described under Printing Individual Records, above. The only difference is that 
you may launch the printout directly from the list view screen. 
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PRINTING A SINGLE RECORD FROM LIST VIEW 

1 Open the display whose data you would like to print. 

2 Open an existing list view, or set up a new one following the instructions in Viewing 

Records in List View, earlier in this chapter. The list view screen will open with your 
selections: 

 

3 Highlight the record you would like to print in the list. 

4 Click Print Current to open a print preview where you can control the settings for 
your printout.  
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5 See Print Preview, later in this section for details. 

Printing the List  
The Print List option allows you to print your data in tabular format. You are able to control the list 
of fields that are printed and the order in which they appear by setting up your list view with the 
desired configuration. 

PRINTING RECORDS FROM LIST VIEW IN TABULAR FORMAT 

1 Open the display whose data you would like to print. 

2 If you would like to limit the records that are printed, set a filter using the instructions 
under Filtering Records, earlier in this chapter. 

3 If you would like your records to print in a particular order, set a sort using the 
instructions under Sorting Records, earlier in this chapter. 



  Printing Records 

Chapter 7 – Working with Records in Displays  ♦  Page 246 

4 Open an existing list view, or set up a new one following the instructions in Viewing 

Records in List View, earlier in this chapter. The list view screen will open with your 
selections: 

 

5 When the records are printed, the width of the columns will match what is displayed 
in list view. If the columns are not wide enough to accommodate the text, the data 
may be cut off. Adjust the size of the columns following the instructions under 
Opening List View, earlier in this chapter. 

6 When records are printed, the height of the rows will match the height of the rows in 
the list. Adjust the height of the rows following the instructions under Opening List 

View, earlier in this chapter. Make sure that your rows are tall enough to 
accommodate pictures, if you are including them in the list. 

7 Click the Print List button. The Print Preview screen will open where you can control 
the settings for your printout. 
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8 See Print Preview, below, for details. 

Print Preview 
The print preview window opens when you select to print your data. This window allows you to 
configure your printout settings, or select to print the data to an alternative file type, such as an Excel 
spreadsheet or an HTML page that can be posted to a website. 

USING PRINT PREVIEW 

1 Access Print Preview by printing from the Display menu or list view, as described 
earlier in this chapter.  

2 When Print Preview opens, it displays the contents of your printout as it will appear 
on paper when printed. Print preview defaults to 8½ x 11 paper in landscape mode 
(i.e., the printout will be 11 inches wide and 8½ inches tall). Use the scrollbars to 
review the records that will be printed to verify that all of the data appears properly.  

3 If you are printing from list view, the width of the columns will maintain the relative 
proportions to each other that were set up in list view, but will expand or contract to 
fill the printable area. You may need to adjust the width of the columns in list view, 
or reduce the number of fields you are displaying.  
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4 If there is more than one page of data, use the scroll buttons to view additional pages 
of data: 

 

If these buttons are unavailable, it means you only have one page of data. 

5 Use the Zoom field on the toolbar to change the size of the preview. 

 

6 If the zoom is set to 100%, the preview will appear the same size as it will print. 
Increasing the number over 100% allows you to zoom in and magnify your preview. 
Decreasing the number allows you to zoom out and view more of your data on the 
screen.  

Note 

 Zooming in or out only impacts the preview screen 
and will not affect your final printout. 

7 Use the Setup tool on the toolbar to change the paper size or orientation. 
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8 The Page Setup screen will open: 

 

9 This screen will automatically detect the default printer you have set up in Windows 
and offer options that are compatible with that printer. If you would like to use a 
different printer, click the Printer… button to open a second Page Setup screen with a 
list of the accessible printers: 

 

10 The Name list will display all of the printers you have set up in Windows. Select the 
desired printer from the Name field.  
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11 If you would like to control any of the printer settings, click the Properties button. 
This will open the printer properties specific to your printer. Refer to the 
documentation that came with your printer for help with these options. 

Note 

 If you are on a network, the Network button will 
allow you to select a printer on the network. Clicking 
this button will bring up the Connect to Printer 
screen. This is an advanced feature that should be 
performed by someone who is familiar with adding a 
network printer. If you are unfamiliar with this 
process, it is recommended that you configure your 
printer using Windows’ Add Printer Wizard instead. 

12 When you are satisfied with your printer selection, click OK to return to the first Page 
Setup screen. 

13 The Paper Size field allows you to specify the type of paper you are using. This will 
default to Letter, which is 8½ x 11 inch paper. If you are using a different size, such 
as A4 or legal sized paper, select your paper from the list. This list will be limited to 
paper sizes that are compatible with your printer. 

14 Depending on your printer, you may be able to load paper in different places. For 
example, some printers have separate trays for different size paper. The Source list 
will display the options that are available for your printer. Select the appropriate 
paper source from the list. 

15 The Portrait/Landscape radio buttons allow you to specify your page orientation. If 
you would like your printout to print in the standard portrait mode, select the Portrait 
radio button. If this is selected and you are using 8½ x 11 inch paper, the printout will 
be 8 ½ inches wide and 11 inches tall. Select the Landscape radio button to have the 
printout print in landscape mode. If this is selected and you are using 8½ x 11 inch 
paper, the printout will be 11 inches wide and 8½ inches tall. 

Hint 

 If you are printing a quick printout from the Display 
menu, consider leaving this set to Portrait. If you are 
printing from list view, unless you are only printing a 
limited number of fields, it is recommended that you 
print in landscape mode to ensure your data will fit on 
the page. 
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16 The margin settings control how much white space is around your printout. Enter the 
margin size, in inches. To enter a size that is less than one inch, use decimal places.  

Hint 

 If you are printing a list and have a large number of 
fields, it is recommended that you reduce the left and 
right margins to allow for the maximum number of 
fields on the page. 

17 Click OK to save your changes and return to the print preview screen.  

18 If you would like to add header or footer information to your printout, click the 
Header And Footer tool on the toolbar: 

 

19 The Header and Footer screen will open: 

 

20 Header information will appear in the top margin of your printout. Footer information 
will appear in the bottom margin. You can control whether the details appear at the 
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top of the margin, centered in the margin, or at the bottom of the margin using the 
location buttons: 

 

• Select the  button to put the header/footer at the top of the margin. For 
headers, this will be at the top of the page. For footers, this will be below the 
data printout.  

• Select the  button to center the text in the margin.  

• Select the  button to place the header/footer at the bottom of the margin. 
For headers, this will be just above the data printout. For footers, this will be 
at the bottom of the page. 

21 Type the information you would like to have appear in the header or footer in the 
boxes. If you would like the information to align at the left margin, place it in the first 
box. If you would like it be centered on the page, place it in the middle box. If you 
would like it aligned at the right margin, place it in the third box. 

Hint 

 You can place information in more than one box. For 
example, you may place a title for the printout 
centered in the header, and have the date it was 
printed appear at the right margin. 

22 The buttons at the bottom of the screen allow you to include variable information in 
the header and footer: 

 

• Select the  button to include the page number on each page. 

• Select the  button to include the page number and the total number of 
pages (for example, Page 1 of 5). 

• Select the  button to include the date of the printout. 

• Select the  button to include the time of the printout. 

• Select the  button to include your user name that was set up in the 
Windows operating system. 
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23 If you would like to change the font of your header and/or footer, click the Font 
button to select the font from a Font dialog. 

24 When you are satisfied with your header and footer, click OK to return to the preview 
screen. 

25 When you are satisfied with the appearance of your data, click the Print button on the 
toolbar: 

 

26 The Print screen will open where you can send the document to your printer. 

Printing Options 
In addition to printing to a printer, you have the option of printing to a file. Database Oasis supports 
printing to the following file types: 

• PDF 

• HTML 

• Microsoft Excel® 

• Rich Text (RTF) 

• Graphic File (BMP) 

PRINTING TO A FILE 

1 Set up your printout following the instructions under Printing Records, above. 

2 From the print preview toolbar, click on the arrow next to the Export Document tool: 

 

This will display the list of compatible file formats. 
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Hint 

 Clicking on the button itself will default to the last 
selected format.  

3 Select the format you would like to use from the list. A Windows Save As dialog will 
open. 

4 Navigate to the location where you would like to save the file, give the file a unique 
name, and click Save. 

5 Once you have saved the file, exit print preview. 

EMAILING PRINTOUTS 

Note 

 You must have an e-mail client configured in 
Windows to use this feature. 

1 Set up your printout following the instructions under Printing Records, above. 

2 Click on the arrow next to the Send Email tool on the toolbar: 

 

This will display the list of file formats that can be sent via e-mail. 

Hint 

 Clicking on the button itself will default to the last 
selected format.  

3 Select the format you would like to use. You can e-mail either .pdf files, or graphic 
files in the .bmp format.  

4 A Windows Save As dialog will open. Navigate to a location where you would like to 
save the file, give the file a unique name, and click Save. 

5 As soon as you save the file, an e-mail will open with the specified file attached. 
Select the recipient, complete the body of the message, and click Send. 
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Deleting Records 

If you have added a record that you no longer want, it is very easy to remove it from your display. 

DELETING A RECORDS 

1 Open the display with the record you want to delete. 

2 Locate the record you will be deleting. 

3 Click the Delete button. A message will appear asking you to confirm your decision 
to delete the record. 

WARNING! 

 Deleting a record is permanent. There is no undo for 
this action. 

Note 

 Deleting a parent record in Professional Edition will 
also delete its children. 

4 Click Yes to delete the record. You will be moved to the next record in the display. 

Importing Data 

The import feature allows you to bring data from another source into one of your displays in Database 
Oasis. Before importing, you should do the following: 

1. Determine the format of your import file. Database Oasis allows you to import either delimited 
files, or Microsoft Excel® spreadsheets.  

If you are importing an Excel spreadsheet, make a note of the worksheet name that contains the 
data you want to import.  
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The second type of file you can import is called a delimited file. This is just a text file where 
each field is separated by a character called a delimiter. The delimiter denotes the end of one 
field and the start of the next. For example, a comma delimited file with basic contact 
information may look like this:  

Mary Jones,P.O. Box 7,Carlsbad,CA,92008,800-555-8986 

Joe Smith,4130 Orange Ave,Oceanside,CA,92056,760-555-1362 

Thanh Nugyen,385 Palm,Del Mar,CA,92109,858-555-9811 

Linda Guterez,53 West Lake Way; Unit 23,Vista,CA,92053,760-555-

9932 

The above example uses commas as the delimiter. Wherever there is a comma, it indicates that it 
is the start of a new field. When importing a delimited file, you should find out in advance what 
the delimiter is. 

2. Make sure your Database Oasis display has fields to contain your import data. If there’s a field in 
your import file that is not in your display, you can add the field to your display. 

Note 

 You don’t necessarily have to import all of the fields. 
If there is a field in your import file that is not in your 
display, and you don’t care about the data in the field, 
you can simply ignore it. 

3. Make sure the fields in your display can contain the data you are importing. You should check 
the following for each of the fields you will be importing into: 

• If you are importing into a text field, make sure the data you’re importing isn't too long to 
be contained in the field. When a field is added, you specify how many characters of data 
it can contain. If you have a field that can only contain 30 characters of data and try to 
import 50 characters, you will receive a warning message that data will be lost if you 
continue with the import. To avoid having data cut off, you should edit the display and 
increase the amount of data the fields can contain so that they are big enough for the data 
you are importing. 

• If you are importing into a numeric field, make sure there are only numbers in the import 
data in all records. Numeric fields can only contain numbers, decimal points, commas, 
and the negative number indicator (-). If you are importing into a numeric field and any 
of your records contain non-numeric data, the import will stop and you will be required to 
fix the data before proceeding. 

• If you are importing into a numeric field, make sure your data doesn't have more decimal 
places than the field allows. For example, if your numeric field is set to contain two 
decimal places and you try to import data that has four decimal places, the import will 
proceed, but the data will be truncated. It is recommended that you verify the decimal 
places prior to import and increase the number of decimal places allowed in your numeric 
field if necessary. 

  



  Importing Data 

Chapter 7 – Working with Records in Displays  ♦  Page 257 

• If you are importing into a check box, your data must be in one of the following formats: 

True / False 

.T. / .F. 

If the data is in any other format, the import will stop and you will be required to fix the 
data before proceeding. 

Note 

 Database Oasis exports check boxes in the format 
True/False. 

• If you are importing into a date field, the date format used for your data must match the 
date format that is configured as the Short Date in Windows (e.g., if the data you are 
importing is 12/30/2010, the Windows date format must be MM/DD/YYYY). If the date 
format does not match, the import will stop and you will be required to fix the data before 
proceeding. To verify your Windows date format, refer to the Regional and Language 
Options settings in the Windows Control Panel. 

4. Verify the integrity of your import file. 

• If you are using a delimited file, make sure the delimiter is not being used in the data. For 
example, if you are using a comma as a delimiter and you have “My Company, Inc.” in a 
field, “My Company” and “Inc.” will be viewed as two fields. This will throw off all of 
the fields following this data for that record. 

• If you are using an Excel spreadsheet, make sure that the file does not contain any non-
text type data in the fields you will be importing. For example, you are able to include 
ActiveX controls such as check boxes and command buttons to an Excel spreadsheet. If 
any of the incoming records contain these data elements, an error will be returned and the 
import will stop. 

• Make sure that all records in your import file contain the fields you are importing. If you 
are using a delimited file, the system will determine how many fields there are by the 
number of delimiters. For example, if you are importing: 

First Name,Last Name,Status 
Mary,Jones,Active 
Pete,Fleming, 
Armando,Ruiz,Inactive 
May,Chung 

The software will expect to find three fields in each record of the data, the First Name 
field, the Last Name field, and the Status field. Although Pete Fleming has nothing in the 
Status field, there is a comma at the end of the last name indicating the start of the next 
field. The software will interpret this as an empty field. May Chung also has nothing in 
the Status field, but there is no comma after her last name. The software will not 
recognize the field and return an error which will stop the import. This is a rare error that 
only occurs if the import file you are using does not follow data standards. If this occurs, 
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you can either edit your data to contain the comma or choose not to import the offending 
field. In the above example, as long as the Status field is not being imported, the import 
will proceed without error. 

Hint 

 This error can also occur if you have blank lines at the 
end of our file. Make sure to delete any blank lines 
prior to running the import. 

If you are not sure if your import data meets these conditions, you can always use the Validate 
button in import to see if it passes the data validation. The system will go through a full check of 
your file against your display and return a list of any errors it finds with details on exactly which 
fields and records had problems. You can use this information to modify your display or 
manually clean up your data file before bringing it into Database Oasis. 

IMPORTING DATA 

1 Open the display you would like to import data into. 

2 From the Data menu inside the display, select Import. 
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3 The Import Data screen will open: 

  

4 Click the button next to the File to Import field to select your import file. A Windows 
Open dialog will open.  

5 Use the Files of Type field at the bottom of the screen to choose the file type of your 
import file: 

 

You can import a standard delimited file with the extension .txt, a comma delimited 
text file with the extension .csv, or an Excel spreadsheet with the extension .xls. 
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Note 

 Comma delimited files frequently have the extension 
.csv, but you can also have .txt files with a comma as 
the delimiter.  

6 Once you have selected the file type, navigate to your import file and click Open. 

7 If you select a delimited file, enter the delimiter used in your import file in the 
Delimiter field. The drop-down list contains the comma, tab, and pipe character 
delimiters, or you can type the delimiter character in the field.  

If you have selected an Excel spreadsheet as your import file, Delimiter will toggle 
with Worksheet. Select the worksheet that contains your data. 

Hint 

 New Excel files default to three worksheets named 
Sheet1, Sheet2, and Sheet3. Most of the time, data is 
found on Sheet1. 

8 In many import files, the first row of data provides a header with the names of the 
fields. If this is the case in your import file, mark the First row is a header (do not 
import) check box. The first row will be available to help identify the fields when 
you’re matching them to fields in your display, but it will not be imported as a record. 
Unmark this check box if your import file does not have a header and the first row 
should be imported. 

9 The Match the Fields section allows you to select the field from your import file that 
should be placed in each field in your display. The Fields In Your Display list will 
show all of the text, numeric, and notes fields you have in your display.  

10 Next to each field in your display is a Select Field to Import field. These fields are 
used to select the field from your import file that will be imported into the 
corresponding field in your display. When you click in the Select Field to Import 
field, a drop-down arrow will appear. Click the arrow to open a list of the fields in 
your import file. 
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11 When you open the list, it will display the first record in your import file. Highlight 
the field that corresponds to the field in your display and click to select it.  

Hint 

 If you know the first letter of the value you are 
selecting in the Select Field to Import list, you can tab 
to the field and press that letter on your keyboard. The 
list of fields will open and only show options that 
start with that letter. 

12 In cases where there is no header row in your import file, it is possible that not all of 
the fields will be populated in the first record. This may make it difficult to identify 
the fields in order to select the appropriate target field from your display. If this is the 
case, you can use the Scroll Records buttons to view other records in your import file 
to help identify your field. You can scroll any of the first 10 records in your import 
file. Click the >> button to view the next record. Click the << button to go back to the 
previous record. 

13 Continue matching fields until all of the fields in the Fields In Your Import File list 
that you want to import have been matched to fields in the Fields In Your Display list. 

Hint 

 You do not necessarily have to import all of the fields 
in your import file. You may also import the same 
field in your import file into more than one field in 
your display, if desired. 
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14 If you select a field in error, select the Clear Selection option at the top of the Fields 
In Your Import File list to remove the selection. 

15 At any time, you may check your field mapping by clicking the Validate button. If 
there are any data mismatches, the Import Issues screen will appear providing the 
field and record number(s) that don’t conform to the rules: 

 

16 Use the data in this screen to resolve any issues with your import mappings. There are 
two classifications of issues that may be displayed: Critical issues must be resolved 
before importing; Warnings will allow you to complete the import, but may have 
undesirable results. (Refer to the introduction of this section for more information on 
the possible errors and their causes.) If you encounter errors with the import, you can 
select another field from your display to contain the data, manually edit your import 
file so it can be contained in the field, or modify the field in the designer so it can 
contain the import data.  

17 If you would like to copy the list of import issues to your clipboard for reference 
outside of import, select Copy to Clipboard. You may then paste the list into a text 
editor or word processor to review the issues. 

18 When you are satisfied with your field selections, click the Import button. 
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19 Database Oasis will analyze your import file against the fields in your display. If 
there are any remaining issues that weren’t resolved during validation, the Import 
Issues screen will appear. If there are critical errors, you will not be able to complete 
the import without resolving them. If there are only warnings, you will be given the 
option to continue with import or go back and correct the issue: 

 

20 To continue with the import, click Import; or to return to the Import screen to correct 
the issues, click Cancel. 

21 Once the import file has passed validation, the import process will begin. There will 
be a pause as new records are created in your display for each of the records in your 
import file.  
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Importing Data at the Child Level 

   Child level displays is an advanced feature. Because of this, it is only available in 
Database Oasis Professional Edition. 

If you are importing data at the child level in Professional Edition, you must associate the records 
you are adding with an existing parent level record. This is done by matching a field in your import 
file to a field at the parent level. For example, you may have a display that is structured like this: 

 

 

 

 

 

 

 

The data you are importing may look similar to this: 

Company First Name Last Name Title  Extension 

A&B Auto Tim Schmidt Owner 201 

Bella’s Diner Lien Yao Accountant N/A 

Bella’s Diner Bella Rosini Owner N/A 

Impact Graphics Saanjh Patel Graphic Artist 43 

A&B Auto Nick McConnel Mechanic 205 

In this case, you would map the Company field in your import data to the Company field in your 
Parent display, and map the First Name, Last Name, Title, and Extension fields to the Child level. 
When you import, two child records will be added to A&B Auto, two child records will be added to 
Bella’s Diner, and one child record will be added to Impact Graphics. 

Hint 

 If your import file contains both parent and child level 
information, you can import once at the parent level 
to create the parent records, then a second time using 
the same file at the child level to create the associated 
child records. 

  

Parent: 

Company 
Address 
City 
State 
ZIP 
Phone 

Child: 

First Name 
Last Name 
Title 
Extension 
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IMPORTING DATA AT THE CHILD LEVEL 

1 Open the child level display into which you would like to import. 

2 From the Data menu inside the display, select Import. 

3 The Import Data screen will open with the addition of a section to identify the parent: 

 

4 Select the import file and delimiter following the instructions under Importing Data 

above. 
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5 In the Identify the Parent section, click on the arrow next to the This field in the 
import file field to open a list of the fields in your import file: 

 

6 Select the field in the data you are importing that corresponds to a field from your 
parent level. 

7 Click on the arrow next to Matches this Parent level field to open a list of fields at the 
parent level: 

 

8 Select the field from the parent that is contained in the data being imported. 

9 Finish setting up your import following the instructions under Importing Data above. 

10 When the import is run, Database Oasis will look at the value in the field selected 
under This field in the import file in your import file. It will search the parent level 
for a record that contains that same value in the field selected under Matches this 
Parent level field. If a match is found, it will add the child record to that parent. If no 
match is found, the child record will not be added. 
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Exporting Data  

The export feature allows you to copy the data in your displays to another file format that can be opened 
by other applications. This can be useful for things like printing mailing labels, viewing data in a 
spreadsheet application, or sharing information with someone who does not have Database Oasis. 

EXPORTING DATA 

1 Open the display containing the data you would like to export. 

2 If you would like to limit the records being exported, set a filter following the 
instructions under Filtering Records, earlier in this chapter.  

3 If you would like the records to appear in a particular order in the exported file, set a 
sort following the instructions under Sorting Records, earlier in this chapter.  

4 From the Data menu inside the display, select Export. 
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5 The Export Data screen will open: 

 

6 The top section of the screen controls what fields should be included in the export. 
The Available Fields box provides the list of fields in your display. To include a field 
in the export, double click on it in this list or highlight it and click the Select button. 
The field will move from the Available Fields list to the Selected Fields list. To select 
all fields, click Select All. 

7 If you have selected a field and decide you do not want to export it, double click on it 
in the Selected Fields list or highlight it and click Remove. It will move back to the 
Available Fields list. If you would like to clear the Selected Fields list and start over, 
click Remove All. 

8 When the export is run, the data will be listed in the order that the fields appear in the 
Selected Fields list. The arrow buttons next to the Selected Fields list allow you to 
move fields up or down in the list to change their order in the output file. Highlight a 
field in the Selected Fields list and click the appropriate button until the field is in the 
desired position. 
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9 The export file will have one record per line with the fields separated by a delimiter. 
A delimiter is simply a character that you have specified to denote the end of one 
field and the start of the next. For example, a comma delimited file with basic contact 
information may look like this:  

1,Mary Jones,P.O. Box 7,Carlsbad,CA,92008,800-555-8986 

2,Joe Smith,4130 Orange Ave,Oceanside,CA,92056,760-555-1362 

3,Thanh Nugyen,385 Palm,Del Mar,CA,92109,858-555-9811 

4,Linda Guterez,53 West Lake Way; Unit 23,Vista,CA,92053,760-555-

9932 

The above example uses commas as the delimiter. Wherever there is a comma, it 
indicates that it is the start of a new field. The most common types of delimiters are 
commas, tabs, and the pipe character: |. These delimiters are available in the drop 
down list. If you would like to use a different type of delimiter, just type the character 
you would like to use in the field. Each field in your output file will be separated with 
exactly the characters you specify. 

WARNING! 

 If you select a delimiter that’s found in your data, the 
application that you use to read the output file may 
view the data as being in two separate fields. If you 
are exporting a notes field, or other fields that contain 
punctuation, make sure you use a delimiter that you 
know won’t be found in the data. 

10 The Location field allows you to set the path and file name of the export file that will 
be created. Click the button to open a Windows Save As dialog box. Navigate to the 
desired location for the file and enter a new file name in the File Name field on that 
screen. When you save at that screen, the path and file name will be displayed in the 
Location field. 

11 The OK button will become available as soon as you enter an output file name in the 
Location field. Click this to proceed with the export. If you have accessed this screen 
from a display, the records will be exported using the filter and sort order that is 
currently active on the display. 

Note 

 If there are Notes field included in the export, 
paragraph breaks will be replaced with two spaces in 
the exported file. 
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Custom Report Designer 

   Custom reporting is an advanced feature. Because of this, it is only available in 
Database Oasis Professional Edition. 

The custom report designer allows you to design reports for your display that can be saved and printed at 
any time. 

STARTING A NEW REPORT 

1 Open the display on which you would like to report. 

2 From the Reporting menu, select Create New Report: 
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Note 

 The Reporting menu will only appear if you are using 
Database Oasis - Professional Edition. 

3 The Custom Report Designer will open. 

Exploring the Screen 

 

The report designer is broken up into five sections, the report bands, the menu, the toolbar, the standard 
controls, and the field list. 
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Report Bands  

 

The report bands represent the areas of the report where the information from your display will 
appear. There are five bands that appear by default: 

Report Header – The report header band appears at the top of the report. It can be used to contain 
a report title or other information such as the name of the person who prepared the report, or the 
date. 

Page Header – The page header band appears at the top of each page of the report. It can be used 
if you would like the page number to appear at the top of the report, or for other information you 
would like on each page. 

Hint 

 If you want to print a report in tabular format and 
would like the field headings at the top of the page 
rather than repeated for each record, put them in the 
page header. 

Detail – The detail band should contain the fields that you want to report on. 

Report Footer – The report footer band appears on the last page of the report. It can be used to 
contain summary information such as report totals. 

Page Footer – The page footer band appears at the bottom of every page of the report. This can 
be used if you want the page number to appear at the bottom of the report, or have other 
information that should appear on each page. 
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There are also four optional bands that can be added to the report: 

Group Header – The group header band allows you to group data in your report based on a 
specific field. Anything entered in the band will be repeated each time the group information 
changes.  

Note 

 Having a group header band is necessary to specify 
report groupings. The band may be left empty if you 
do not need header information at the start of each 
new group. 

Group Footer – If you are using groups in your report, the group footer band will appear at the 
end of each group break. It can be used to contain summary information such as group totals. 

Bottom Margin – The bottom margin band allows you to adjust the size of the page footer band. 
If selected, it adds an additional band below the page footer that may be dragged up or down, 
increasing or decreasing the size of the page footer. The space for the bottom margin band itself 
does not print. 

DetailReport – This band allows you to create a sub report. For example, you may want to 
change the page layout on a section of your report, or if you have a child level, you may want to 
print data from each record’s children. 

For example, you may wish to print out an address list.  

Your report may look something like this: 

 

In the above example, the report header band contains the title of the report. The page header 
contains a notice that the contents are confidential which will appear on every page. The detail band 
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contains the address fields from the display. The footer band contains a page count and the date on 
which the report is printed. The report footer and group bands were not used. 

When this report is printed, the text “Donator List” text will appear on the first page of the report 
only. The text “Confidential – for internal use only” will appear at the top of each page. The page 
number and date will appear at the bottom of each page. The items in the detail band will be repeated 
for each record in your display. 

When printed, this report will look like this: 
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Tool Box/Standard Controls 

 

The Tool Box contains standard controls that can be used to work with the report. You add controls 
to the report by clicking on them in the list, then dragging them to the report surface.  

Depending on how you have the report designer sized, the standard controls may not all fit in the 
box. In this case, a small scroll band will appear at the bottom of the control list. 

 

Click on the arrow to scroll the list. When you scroll down, an arrow will appear at the top of the list, 
allowing you to scroll back up. Alternatively, you can click and drag on the bottom edge of the list to 
make the box bigger.  
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At the top of the box, there are options that allow you to hide or close the tool box. Options include: 

 - This option maximizes the tool box. As long as this is depressed, the Field List box will be 
hidden so the tool box is the only list appearing in the left hand pane. When this is selected, the 

button will toggle to appear like this: . To restore the field list, click the button again. 

 - This option allows you to auto-hide the tool box. It “tacks” the tool box to the side, 
optimizing the space available in the report bands: 

 

The tool box appears as an icon on the side of the report designer window: 

 

When you hover your mouse over the icon, the tool box will reappear until you move your 
mouse off of it. If you select an option on the tool box, the box will stay visible until you click 

off of it. When the tool box is open, the icon will toggle to appear like this: . Clicking this 
will restore the tool box so it is always visible. 

 - This option closes the tool box. The tool box will remain closed until the next time you go 
into the report designer. 

Tool box options include: 

Pointer – If you have clicked on another tool box option and decide you do not wish to add it to 
the report, you can select this option to clear your previous selection. 

Label – This option allows you to add text to the report, such as report titles or field names. It 
can also be used to add summary information such as report totals. 

Line – This option allows you to add a line to your report.  
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Logo Image – This option allows you to add a picture to your report. This is similar to the logo 
control in the display designer. 

Shape – This option allows you to draw a shape, such as a circle or arrow, on your report. 

Box – This option allows you to add a box around items in your report that encompasses 
multiple bands. For example, you may want a box around the entire report, including header and 
footer information. 

Cross Band Line – This option allows you to draw a vertical line that extends across multiple 
bands. 

Page Info – This option allows you to include report information such as the date or the page 
count in your report. 

Page Break – This option allows you to place a page break in your report. For example, you may 
want each record to start on a new page. 

Field List 

 

The field list includes all of the fields in your display that can be included in a report. Fields can be 
dragged from this list to the report bands.  
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If your display contains a child level, the field list may open collapsed:  

 

Click the [+] next to the display name to expand the field list: 

 

Items in the list with a plus mark [+] next to them indicate a child display:  

 

Click the [+] to expand the list and show child fields. 
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At the top of the box, there are options that allow you to hide or close the field list. Options include: 

 - This option maximizes the field list. As long as this is depressed, the Tool Box will be 
hidden so the field list is the only list appearing in the left hand pane. When this is selected, the 

button will toggle to appear like this: . To restore the tool box, click the button again. 

 - This option allows you to auto-hide the field list. It “tacks” the field list to the side, 
optimizing the space available in the report bands. The field list appears as an icon on the side of 
the report designer window. 

When you hover your mouse over the icon, the field list will reappear until you move your 
mouse off of it. If you select a field, the box will stay visible until you click off of it. When the 

field list is open, the icon will toggle to appear like this: . Clicking this will restore the field 
list so it is always visible. 

 - This option closes the field list. The field list will remain closed until the next time you go 
into the report designer. 

Menu and Toolbar 
At the top of the Report Designer screen, you will find the default menu and toolbar.  

 

The menu and toolbar provides access to commands for working with the designer. 

The File menu items include: 

Label / Report Wizard – This option opens the Report Wizard. The wizard gives you the option 
of setting up a label format or creating a quick report layout. 
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Save – This option allows you to save your report as you work. The first time you save, you will 
be asked to name the report. After the first time, the previously saved report will be updated 
when you select this option and you will not be prompted for a name. 

Save As – This option allows you to save your report under a different file name. When you 
select this option, you will be prompted to enter a new name for the report. Your original report 
will remain unchanged under the old file name and a new report will be created with the current 
changes.  

Exit – This option will exit the Report Designer. If you have any unsaved changes, you will be 
prompted to save. If you select not to save, your changes will be discarded.  

The Edit menu items include: 

Undo – This option will reverse the most recent change to the report. If you select this option 
more than once, it will undo the previous change. 

Redo – This option will become available if you have selected Undo. It allows you to remake a 
change that you have undone. 

Delete – This option will delete the selected item. You can also delete an item by pressing the 
Delete key on your keyboard. 

The View menu items include: 

Designer – This option shows the design surface where you build your report. 

Preview – This option shows a preview where you can see how the report will look when 
printed. It also gives access to the page setup option. 

Toolbars – This option allows you to set what toolbars display. When you click on the arrow, 
you have access to a sub-menu that includes: 

Main Toolbar – this toolbar provides undo and redo tools. 

Formatting Toolbar – This toolbar provides formatting options, such as color and font, for 
objects on the report. 

Layout Toolbar – This toolbar provides alignment options for objects on the report. 

Status Bar – This option allows you to toggle the status bar at the bottom of the report 
designer on or off. 

Standard Controls – This option lets you view a toolbar with the options that are available in 
the Standard Controls window in the Toolbox. This is useful if you want to close the 
Standard Controls section of the Toolbox to make more room for your field list. By default, 
this toolbar opens to the left of the Toolbox, but in may be dragged to the top of the page if 
desired.  

Customize – This option opens a toolbar Customization screen that provides options to view 
the available toolbars and commands, and an Options tab that lets you personalize your 
menus and toolbars. 

Window – This option opens a sub-menu that allows you to control what windows display. You 
can toggle the toolbox on or off, the field list on or off, or open up an advanced properties grid. 
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Note 

 The Properties grid provides access to hidden 
properties of the report and objects on the report. 
Unless you are an advanced user or working with 
Database Oasis support, you should not modify these 
properties.  

The Format menu items include: 

Foreground Color – This option allows you to set the text or line color of a selected object. When 
you click on the arrow a color picker opens where you can select a color. 

 

For example, if you set the foreground color of a field to red, it would look like this: 

 

Background Color – This option allows you to set the background color for the selected object. 
When you click the arrow, the color picker described under Foreground Color opens. The 
selected color will fill in the frame of the object. For example, if you set the background color of 
a field to light gray, it would look like this: 

 

Font – This option allows you to make changes to the text of the selected item. When you click 
on the arrow, you have access to a sub-menu with options to set the font to Bold, Italic, or 
Underline. 

Justify – This option allows you to control the alignment of the text for the selected object. 
Clicking on the arrow opens a sub-menu with the following options: 

Left – The text will be aligned to the left edge of the frame:  

Center – The text will be centered within the frame:  
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Right – The text will be aligned to the right edge of the frame:  
Justify – Text will generally be left aligned. If there is more than one line of text, for example 
in a notes field, it will be spaced evenly within the frame so that it aligns to both the right and 
left edges. 

Align – This menu item provides a sub-menu with options for aligning multiple objects to each 
other. Select the objects you wish to align, then select the appropriate menu option. The top three 
items are used for aligning objects in a column. Options include: 

Lefts – This will allow you to align the left edges of the items. 
Centers – This will center objects in the column. 
Rights – This will align the right edges of the items. 

The bottom three items are used for aligning objects in a row. Options include: 

Tops – This will align the top edges of the items 
Middles – This will center the objects in the row. 
Bottom – This will align the bottom edges of the items. 

Make Same Size – This option allows you to adjust one or more selected objects so they are the 
same size. Options include: 

Width – This will match the width of the objects to whichever object was selected last. 
Height – This will match the width of the objects to whichever object was selected last. 
Both – This will match both the height and width of the objects to whichever object was 
selected last. 

Horizontal Spacing – This menu provides options to allow you to control the spacing between 
objects in a row. Options include: 

Make Equal – This will arrange the objects so that there is equal space between each item. 
Increase – This will pad the space between each of the objects, moving them further apart. 
Decrease – This will remove space between each of the objects, bringing them closer 
together. 
Remove – This will remove all space between the selected objects so that they are right next 
to each other. 

Vertical Spacing – This menu provides options to allow you to control the spacing above and 
below objects in a column. Options include: 

Make Equal – This will arrange the objects so that there is equal space above and below each 
item. 
Increase – This will pad the space above and below each of the objects, moving them further 
apart. 
Decrease – This will remove space above and below each of the objects, bringing them closer 
together. 
Remove – This will remove all space above and below the selected objects so that they are 
right on top of each other. 
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Center in Form – This menu provides options for centering objects in the report. Options include: 

Horizontally – This will center the object horizontally within the report margins. 
Vertically – This will center the object vertically within the current band. 

Order – This option allows you to layer objects by moving the selected item either in front of or 
behind other items in the report. 

Bring to Front – This will move the selected object in front of all other objects in the report. 
Send to Back – This will move the selected object behind all other objects in the report. 

The toolbars provide quick access to many of the options that are available on the menu. Options 
include:  

Main Toolbar: 

Undo – This option will reverse the most recent change to the report. If you select this option 
more than once, it will undo the previous change. 

Redo – This option will become available if you have selected Undo. It allows you to remake a 
change that you have undone. 

Formatting Toolbar: 

Font – This option allows you to select the font that you would like to use for the text of the 
selected item. 

Font Size – This option allows you to select the point size of the font that is being used for the 
text of the selected item. A higher number will appear larger; a lower number will appear 
smaller. 

Bold – This option will apply a bold face font to the text in the selected object. 

Italic – This option will italicize the text in the selected object. 

Underline – This option will underline the text in the selected object. 

Foreground Color – This option allows you to set the text or line color of a selected object. When 
you click on the arrow a color picker opens where you can select a color. 

Background Color – This option allows you to set the background color for the selected object. 
When you click the arrow, the color picker described under Foreground Color opens. The 
selected color will fill in the frame of the object. 

Left – The text will be aligned to the left edge of the frame. 

Center – The text will be centered within the frame. 

Right – The text will be aligned to the right edge of the frame. 

Justify – Text will generally be left aligned. If there is more than one line of text, for example in 
a notes field, it will be spaced evenly within the frame so that it aligns to both the right and left 
edges.  
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Format Toolbar: 

Note 

 This toolbar is turned off by default. Most of the 
options are available from the Format menu.  

To Grid – This allows you to align objects by snapping them to the gridlines. When you press 
this tool, any selected objects will snap to the closest top/left gridline. 

The next three tools provide options for aligning multiple objects to each other. They are only 
available if more than one object is selected. Select the objects you wish to align, then select the 
appropriate tool. 

Lefts – This will allow you to align the left edges of the items. 
Centers – This will center objects in the column. 
Rights – This will align the right edges of the items. 

The next three tools provide options for aligning objects in a row. They are only available if 
more than one object is selected. 

Tops – This will align the top edges of the items 
Middles – This will center the objects in the row. 
Bottom – This will align the bottom edges of the items. 

The next four tools provide options for controlling the width and height of objects.  

Width – This will match the width of the objects to whichever object was selected last. 
Size to Grid – This option will increase or decrease the height and width of the selected 
object(s) to align with the grid. 
Height – This will match the width of the objects to whichever object was selected last. 
Both – This will match both the height and width of the objects to whichever object was 
selected last. 

The next four tools provide options for controlling the spacing between objects in a row. They 
are only available if multiple objects are selected. 

Make Equal – This will arrange the objects so that there is equal space between each item. 
Increase – This will pad the space between each of the objects, moving them further apart. 
Decrease – This will remove space between each of the objects, bringing them closer 
together. 
Remove – This will remove all space between the selected objects so that they are right next 
to each other. 

The next four tools allow you to control the spacing above and below objects in a column. They 
are only available if multiple objects are selected. 

Make Equal – This will arrange the objects so that there is equal space above and below each 
item. 
Increase – This will pad the space above and below each of the objects, moving them further 
apart. 
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Decrease – This will remove space above and below each of the objects, bringing them closer 
together. 
Remove – This will remove all space above and below the selected objects so that they are 
right on top of each other. 

The next two options allow you to center objects in the report.  

Horizontally – This will center the object horizontally within the report margins. 
Vertically – This will center the object vertically within the current band. 

The final two tools allow you to layer objects by moving the selected item either in front of or 
behind other items in the report. 

Bring to Front – This will move the selected object in front of all other objects in the report. 
Send to Back – This will move the selected object behind all other objects in the report. 

Standard Controls Toolbar: 

Note 

 This toolbar is turned off by default. The options are 
available from the Standard Controls section of the 
toolbox.  

Pointer – If you have clicked on another tool box option and decide you do not wish to add it to 
the report, you can select this option to clear your previous selection. 

Label – This option allows you to add text to the report, such as report titles or field names. It 
can also be used to add summary information such as report totals. 

Logo Image – This option allows you to add a picture to your report. This is similar to the logo 
control in the display designer. 

Line – This option allows you to add a line to your report.  

Shape – This option allows you to draw a shape, such as a circle or arrow, on your report. 

Box – This option allows you to add a box around items in your report that encompasses 
multiple bands. For example, you may want a box around the entire report, including header and 
footer information. 

Cross Band Line – This option allows you to draw a vertical line that extends across multiple 
bands. 

Page Info – This option allows you to include report information such as the date or the page 
count in your report. 

Page Break – This option allows you to place a page break in your report. For example, you may 
want each record to start on a new page. 
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Using the Report Wizard 

The easiest way to start a new report is using the Report Wizard. The wizard gives you two options: 

Label Report - This option allows you to select the type of label from a list of standard label formats 
and sets the report area to print the labels. 

Standard Report – This option allows you to quickly configure a report by specifying the list of fields 
you would like included and lets you choose from a selection of standard report layouts. 

LAUNCHING THE REPORT WIZARD 

1 Inside the Report Designer, select Label / Report Wizard from the File menu. 

 

2 The Report Wizard will open: 

 

3 Select the desired report type from the Report Type radio buttons. Refer to the 
appropriate section below for instructions. 
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Setting up Labels 
The Report Wizard allows you to configure your report area for one of a selection of standard label 
types. 

CREATING A LABEL REPORT 

1 Launch the report wizard following the steps under Launching the Report Wizard, 
above. 

2 On the first page, select the Label Report radio button. The Label Information page 
will open: 

 

3 Select the brand of your labels from the Label Products list. The Product Number 
field will update with labels by the selected manufacturer.  

4 Select your labels from the Product Number field and click Next. 

Hint 

 In addition to labels, you can select options such as 
business cards, greeting cards, ID badges, and more.  

  



  Using the Report Wizard 

Chapter 8 – Reporting  ♦  Page 288 

5 The Customize the Label page will open: 

 

6 The label size automatically adjusts to the product you selected, and for the most part, 
you should not need to adjust the label options. If for some reason you would like to 
make an adjustment to the size or paper type, you may do so on this screen. 

7 When you are satisfied with your labels, press Finish. 

8 You will be returned to the report designer with the design area adjusted to the label 
settings: 

 

9 The white area provides the space where you should place your fields. The gray area 
is reserved for printing in columns. 
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10 Drag the desired fields into the white area to set up your labels: 

 

The final labels will look like this: 

 

Setting up a Standard Report 
The Standard Report option in the report wizard lets you quickly lay out your report by selecting the 
fields and choosing from a selection of layout options. The fields will be automatically added to the 
report, where you can make any desired adjustments.  

CREATING A STANDARD REPORT 

1 Launch the report wizard following the steps under Launching the Report Wizard, 
above. 
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2 On the first page, select the Standard Report radio button. The Choose Columns page 
will open: 

 

3 The Available Fields box provides the list of fields in your display. To include a field 
in the report, double click on it in this list or highlight it and click the > button. The 
field will move from the Available Fields list to the Fields to display in a report list. 
To select all fields, click the >> button. 
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4 When you are satisfied with your fields, click Next. The grouping page will open: 

 

5 Database Oasis allows you to using groupings in reports to automatically group 
related information and generate summary information for the group. (For more 
information on grouping, see the heading Groups in Custom Reports, later in this 
chapter.)  

  



  Using the Report Wizard 

Chapter 8 – Reporting  ♦  Page 292 

6 If you would like to create a group for the report, select the field on which you would 
like to group from the list on the left and press the > button. To include more than one 
field in the grouping, highlight the second field and press the +> button. For example, 
you may want to group on both city and state. This would allow you to have Paris, IL 
and Paris, TX in different groups. The selected field(s) will move to the list on the 
right: 

 

7 You may continue to add fields to create sub groupings, if desired. Adjust the priority 
of the groupings by highlighting them and clicking the ^ and V arrow buttons. 

8 To remove a grouping, highlight it in the list on the right, and click the < button. 

9 When you are done setting up your groups, click Next >.  
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10 The layout page will open, providing options to control how fields are arranged on 
the page:  

 

11 Select from the Layout radio buttons. The report example on the left will update to 
show an example of the selected layout. The available options will vary, depending 
on whether you’ve included groupings in your report. If you have not included a 
grouping, options are:  

• Columnar – Select this option to have data appear with one field per line, with the 
field label in the first column, followed by the field data. 

• Tabular – Select this option to arrange data in tabular format (similar to list view), 
with the field labels appearing once for all records across the top of the page and 
corresponding data aligned below the labels with one record per row.  

Note 

 Consider changing to landscape orientation when 
using this option. 

• Justified – Select this option to arrange the fields with field labels appearing 
above the data. Fields will be side-by-side so they fill the width of the page. If not 
all fields fit, remaining fields will be placed on the next line, until all of the fields 
have been added.  
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If you have included a grouping, options are: 

• Stepped – This option is similar to the Tabular option with the field labels 
appearing once for all records across the top of the page. The field on which you 
are grouping will appear left aligned below the labels once for all records in the 
group. The remaining fields will appear indented in the detail band below group 
field.  

• Outline 1 – This option will place the field on which you are grouping in the 
group band with the label to the left of the field data. If you have a sub-grouping, 
the label and field will appear indented on the following line. The field labels for 
the remaining fields will appear indented on the following line, with the field data 
in tabular alignment beneath them. 

• Outline 2 – This option is similar to Outline 1, with the exception of the 
arrangement of the separator lines. 

• Align Left 1 – This option is similar to the outline options, with the exception that 
sub-group headings and group details are left aligned rather than indented. 

• Align Left 2 – This option is similar to Align Left 1, with the exception of the 
arrangement of the separator lines. 

12 Select the Adjust the field width so all fields fit on the page option to have the report 
designer automatically size the fields so they all fit. If this option is not selected, the 
fields may run off the edge of the page. You are able to manually adjust the field sizes 
once the wizard is complete.  

Note 

 This option is particularly important with any of the 
tabular layouts. 

13 Select whether you would like to have the report print in Portrait (taller than it is 
wide) or Landscape (wider than it is tall) page orientation.  
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14 When you are satisfied with your layout options, click Next > to open the style page: 

 

15 This page allows you to specify the default font style for the report. The sample on 
the left will update to reflect your selections. Options include: 

• Bold – This option places the report title in Times New Roman, 20 pt. bold font. 
Field labels are in Arial, 10 pt. bold font. Field data is in Times New Roman, 10 
pt. font. The report title and field labels are red. 

• Casual – This option places the report title in Tahoma, 24 pt. bold font. Field 
labels and data are in Arial, 10 pt. font, with the labels bolded. The report title is 
green. 

• Compact – This option places the report title in Times New Roman, 21 pt bold 
font. Field labels and data are in Times New Roman, 10 pt font. 

• Corporate – This option places the report title in Times New Roman, 20 pt. bold 
italic font. Field labels are in Times New Roman, 20 pt. bold italic font. Field data 
is in Arial 8 pt. font. The report title and field labels are blue. 

• Formal – This option places the repot title in Times New Roman, 24 pt. bold font. 
Field labels are in Times New Roman 10 pt. bold font. Field data is in Times New 
Roman 8 pt. font.  
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Note 

 Fonts may be adjusted in the report designer once the 
wizard is complete. 

16 Once you have made a style selection, click Next > to open the report title page: 

 

17 Enter the title you would like to appear at the top of the report. 
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18  Click Finish to exit the wizard. The report design surface will populate with the 
fields and layout you have selected: 

19 Use the guidelines in the remainder of this chapter to add additional objects to the 
report, make any desired changes to the visual elements, and save your report. 

  



  Setting up Your Report 

Chapter 8 – Reporting  ♦  Page 298 

Setting up Your Report 

Before adding fields and other objects to your report, you may wish to set up the report area and 
configure the band properties. This includes setting up any data groupings you want to include, and 
configuring the report to include data from any child level displays you may have. 

Note 

 Margin size and page orientation (portrait or 
landscape) are configured in preview mode. 

Sizing Report Bands 
When a report is printed, each record in the report will be the height of the detail band. The amount 
of space that’s reserved for the headers and footers will also be based on the size of the respective 
bands.  

For example, if you create a report with a detail band that looks like this: 
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Your report will print like this: 

 

You should size each band so that it is tall enough to contain the objects you wish to add to it, but 
does not have a lot of empty space. You can adjust the size of the bands using drag and drop. 
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CHANGING THE SIZE OF A BAND 

1 Hover your mouse over the top of the band. It will change to a double headed arrow: 

 

2 Click and drag the band up or down until it is the appropriate size. 

Band Properties 
Band Properties allow you to select how the report should handle individual records spanning 
multiple pages when printed. 

SETTING BAND PROPERTIES 

1 Click on the band you would like to select. The selected band will be blue and a small 
arrow will appear next to the band name: 

 

2 Click on the arrow. A band properties box appears next to the band name: 

 

3 Mark the Keep Together check box if you would like to keep individual records 
together when printed, if possible. If this is selected, the report generator will 
determine if a record will fit in the space left on the page. If not, it will push that 
entire record to the next page. If this is left unmarked, it will print as much of the 
record as will fit on the first page, and complete the record on the second page. 

4 Click off the band properties box to close it and save your changes.  
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Removing Bands from a Report  
If you are not using a particular band, you may remove it from the report designer. 

REMOVING A BAND 

1 Right click anywhere within the band you would like to remove and select Delete. 
The band will be removed from the report. 

Note 

 You cannot delete the detail band. 

Groups in Custom Reports 
In some reports, it may be desirable to group information based on a particular field. For example, 
you may want to count how many customers you have in each state, or get the total dollar value of 
all inventory you have in each product category.  

Group bands allow you to automatically group related information in your report and generate 
summary information for the group. You can also use the group header to enter a title that will 
appear each time the group value changes. For example, if you group on the city in which your 
customers live, you may place the City field in the group header band to appear as a title for each 
city. 

In order to group data in your report, you must first add the group header band, then specify what 
field should be used for the grouping. 

ADDING A GROUP HEADER BAND TO A REPORT 

1 Right click anywhere on the report surface and select Insert Band. A menu opens with 
the band options: 

 

2 Select GroupHeader. A group header band will be added above the detail band. 

3 Click on the group header band to select it. A small arrow will appear next to the 
band name. 
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4 Click the arrow. A band properties box will appear: 

 

5 Click the ellipsis next to the Group Fields field. The Group Fields Collection Editor 
will open: 
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6 Click the Add button. A new group field will appear in the Members section of the 
screen and properties for the group field will appear in the Group Field Properties 
section: 

 

7 Click in the FieldName field to access a drop down list of the fields in your display. 

8 Select the field on which you would like to group the report from the list. For 
example, if you are creating a productivity report for your sales force that you want 
grouped by sales associate, you would select the field that contains the sales 
associates’ names. 

9 In the SortOrder field, select whether you would like the group to appear on the report 
in Ascending (A to Z, smallest to largest, oldest to newest) or Descending (Z to A, 
largest to smallest, newest to oldest) order. 

Note 

 This selection overrides any sort order set on the 
display; however, data within the group will respect 
the sort order. For example, if you have a display that 
tracks sales, you might group on sales region and sort 
on sale date. In this case, the data will appear on the 
report in order by region with all sales within a region 
sorted by date. 
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10 If you would like to further refine your group using a second field, click Add again 
and repeat steps 7 through 9. For example, if you have first and last name stored in 
separate fields, you would need to select both fields to group on the full name. 

11 If you have added more than one group field, you can adjust the order in which they 
appear in the report using the arrow buttons next to the Members list. Data will 
appear in the report in ascending or descending order by the first value, then sub-
sorted by subsequent values. (Using the above example, if you select last name as the 
first field, groups will appear in alphabetical order by last name, then first name.) 

12 When you are satisfied with your selections, click OK.  

You have the option of including a group footer band in the report. This allows you to include 
summary information such as group totals for each group. 

ADDING A GROUP FOOTER TO A REPORT 

1 Right click anywhere on the report surface and select Insert Band. A menu opens with 
the band options. 

2 Select GroupFooter. A group footer band will be added below the detail band. Refer 
to the Adding Summary Information to Custom Reports heading later in this chapter 
for details on including repot totals. 

3 If you are using multiple group headers, you may repeat steps 1 and 2 to include 
additional group footers. A GroupFooter2 band will be added to the report. 

Sub-Groupings 
In some cases, you may want to use sub groupings in your report. For example, you may want 
records grouped by state, then sub-grouped by the cities in each state. This will allow you to create 
summary totals for all records in the state, plus a separate set of totals for each city to further refine 
your data analysis. 

ADDING A SUB-GROUP TO A REPORT 

1 Right click anywhere on the report surface and select Insert Band. A menu opens with 
the band options. 
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2 Add the group header and footer bands following the instructions under Adding a 

Group Header to a Report and Adding a Group Footer to a Report, above. The 
second group bands will be named GroupHeader2 and GroupFooter2. 

Note 

 GroupFooter1 does not necessarily correspond to 
GroupHeader1. The group header band closest to the 
page header will correspond to the group footer band 
closest to the page footer.  

3 Repeat these steps for each sub level you would like to include in your report. 

When you have finished adding your group header and footer bands, your report may look similar to 
this: 

 

In the above example, there is a major grouping on Client with a secondary grouping on Project. The 
group footer bands also provide the total hours worked on each project and a grand total for each 
client.  
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When run, the report will look something like this: 
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Child Data in Reports 
If you are working in a display with one or more child levels, you can use Detail Reports to include 
information from other levels in your report. This adds a sub-report tied to the child level. 

Detail reports are similar to group bands, except that they are tied to a child display and allow you to 
include data from more than one level in your report. 

ADDING A DETAIL REPORT 

1 Add or edit a report at the parent level. 

2 Right click on the report and select Insert Detail Report. This will bring up a sub-
menu with the child displays for this parent: 

 

3 Select the appropriate child display from the list. A second detail band will be added 
to your report: 

 

4 Click on the Detail1 band to select it. A small arrow will appear next to the band 
name. 
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5 Click the arrow. A band properties box will appear: 

 

6 Repeat these steps for any additional child displays you would like to include in the 
report. 

7 Any child displays you have created will appear in the field list with a plus mark (+) 
next to them: 
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8 Click on the plus mark to expand the list of fields: 

 

9 Create your report following the instructions in the Adding Items to Your Report 

sections below. Fields from the parent level should be added to the main Detail band. 
To add fields from the child level, select them from the display you chose in step 3 
and place them in the Detail1 section under the DetailReport band heading: 
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10 When you preview your report, child records will be grouped under their parents: 
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Adding Items to Your Report 

You build your report by adding fields and standard controls to the report bands.  

Adding Fields to Custom Reports 
Fields are added to the detail band of the report. When the report is printed, the fields in the detail 
band will be populated with the data from your display and repeated for each included record. 

ADDING FIELDS TO A REPORT 

1 Open the report designer. The Field List box on the left side of the screen will contain 
the fields in your display. 

Note 

 Prior to version 3.0, when a picture was selected in a 
picture field, Database Oasis created a link to the 
graphic file on your computer rather than storing the 
picture in the database. Picture fields added to 
displays after version 3.0 embed the graphic file in 
the database. Only embedded picture fields are 
available in reports. 
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2 Click on the field you would like to add: 

 

3 Hold down the left mouse button and drag the field into the detail band on the report. 
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4 Release the left mouse button. The field will appear on the report: 

 

5 Click on the field to select it. A small arrow will appear in the upper right corner of 
the field: 

 

6 Click on the arrow. A properties box will appear: 

 

7 The Auto Width check box determines whether the field should size horizontally to 
fit the data in the field. If Auto Width is selected, the field will increase or decrease to 
fit the text. 

Note 

 The Word Wrap option takes precedence if it is also 
selected so text will wrap rather than expand 
horizontally. 
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Note 

 This option does not change the position of any 
objects placed to the right of the field. 

8 The Can Grow check box works in conjunction with the Word Wrap option to 
determine whether to print the entire contents of the field or limit what prints to a 
specific amount of space. If this is selected, data in the field will wrap to multiple 
lines and the band will expand to accommodate the entire field. Items below the field 
in the report will be shifted down.  

Note 

 Selecting Can Grow is especially useful with notes 
fields.  

If you wish to limit the size the field can expand, but still want the text to wrap to 
multiple lines, leave Word Wrap marked, but unmark Can Grow. The text will wrap 
to multiple lines and fill the frame, but will not expand beyond the space allotted. If 
text exceeds what can fit in the box, it will be truncated. This is useful if you are 
printing on a form with a fixed amount of available space, or want to limit your report 
to a single page. 

If neither Can Grow nor Word Wrap is marked, the text will fill a single line. 

9 The Can Shrink option controls whether the field’s height can shrink if there is less 
data than the space allotted. For example, if you have a notes field on your report, and 
size the field to accommodate multiple lines, the detail band will move up for any 
records where the notes field is empty. Leave this check box unmarked if you would 
like the same amount of space to be allotted to the field, even if the data doesn’t fill it. 

10 Click on the arrow next to the Fore Color field to open a color picker where you can 
select a color for the text. 

11 Click on the arrow next to the Back Color field to open a color picker where you can 
select a color for the background of the field. 

12 Click on the ellipsis next to the Font field to open the Windows Font dialog where 
you can select a font for the field. 

13 Click off the properties to save your changes. 

14 See Working with Objects on the Report, later in this section, for instructions on 
sizing, positioning, and configuring the field. 
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Hint 

 Fields are added to the report without the field name. 
It is recommended that you add a label and enter the 
field name to help identify this data on the report. 

Adding Text to Custom Reports 
In addition to fields, you can add other elements to your report using the Standard Controls list. The 
Text option allows you to add field labels and other information to your report. 

ADDING TEXT TO A REPORT 

1 From the Standard Controls list, click on Label: 

  

2 Hold down the left mouse button and drag the label into the desired band on the 
report: 

 

3 The label will be added with the text Double Click to Edit. Double click on the label. 
The label text will be highlighted: 

 



  Adding Items to Your Report 

Chapter 8 – Reporting  ♦  Page 316 

4 Start typing to enter your label text. Click off the field to save. 

5 To set properties for the text, click on it to select it. An arrow appears in the upper 
right corner of the field.  

6 Click on the arrow to open a properties box: 

 

Note 

 Labels use the same properties box as fields. Not all 
options are applicable to text items. 

7 Click on the arrow next to the Fore Color field to open a color picker where you can 
select a color for the text. 

8 Click on the arrow next to the Back Color field to open a color picker where you can 
select a color for the background of the field. 

9 Click on the ellipsis next to the Font field to open the Windows Font dialog where 
you can select a font for the field. 

10 Click off the properties to save your changes. 

11 See Working with Objects on the Report, later in this section, for instructions on 
positioning and configuring the label. 
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Lines in Custom Reports 
You will often find that reports are much easier to read if you include lines between the sections. 
You may even want to include a line between each record to help clarify where one ends and the 
next begins. Consider adding a line to the bottom of the header band to separate the header from the 
main body of the report, or to the bottom of the detail band to include a line between each record. 

ADDING A LINE TO A REPORT 

1 From the Standard Controls list, click on Line. 

  

2 Hold down the left mouse button and drag the line into the desired band on the report. 
A horizontal line will be added in the default size: 

 

3 When the line is selected, it will have a small arrow in the upper right corner: 
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4 Click on the arrow. Line properties will open next to the field: 

 

5 The Foreground Color option allows you to set the color of the line. Click the drop 
down list to open a color picker: 

 

6 Select the color you would like to use for the line from the options on any of the three 
tabs. 

7 The Line Direction field controls whether it is a horizontal, vertical, or diagonal line. 
Select:  

• Slant to have the line go at a diagonal from the bottom left of the frame to the top 
right of the frame;  

• Back Slant to have it go from the top left to the bottom right;  

• Horizontal to have the line go from the left to the right; or 

• Vertical to have the line go from the top to the bottom of the frame. 
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8 The Line Style setting allows you to control the type of line to use. Options include 
Solid, Dash, Dot, DashDot, DashDotDot, or Custom. 

9 The Line Width allows you to set how thick you would like the line. The higher the 
number, the heaver the line. Type a number in the field or use the spinner arrows to 
increment the number up or down. 

10 The Anchor Vertical controls how the line is anchored if the band is resized. Select: 

• None if you do not want to anchor the line. 

• Top if you want the line to keep its position relative to the top of the band. If you 
resize the band, the space between the line and the bottom of the band will 
increase or decrease. 

• Bottom if you want the line to keep its position relative to the bottom of the band. 
If you resize the band, the space between the line and the top of the band will 
increase or decrease.  

• Both if you want the line to grow or shrink with the band. This is used with 
vertical lines. 

11 When you are satisfied with your settings, click off the properties box to save. 

12 See Working with Objects on the Report, later in this section, for instructions on 
positioning the line. 

Cross Band Lines in Custom Reports 
Cross band lines are vertical lines that can extend over more than one band. For example, you may 
want to display data in tabular format with the field labels in the page header. In this case, you may 
want a line that extends from the header into the detail band: 
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The printed report will look like this: 

 

Hint 

 Standard lines default to horizontal. Rather than going 
into line properties to make a line vertical, you can 
use a cross band line. 

ADDING A CROSS BAND LINE TO A REPORT 

1 From the Standard Controls list, click on Cross Band Line. 

  

  



  Adding Items to Your Report 

Chapter 8 – Reporting  ♦  Page 321 

2 Hold down the left mouse button and drag the line vertically across the desired bands 
on the report. As you drag, adjust the thickness of the box you draw. A vertical line 
will be added in the height and width of your box: 

 

Hint 

 To avoid having a break in the line after each record 
in the detail band, extend the line into the divider for 
the footer band.  

3 When the line is selected, it will have a small arrow in the upper right corner. If 
necessary, adjust the line properties using the guidelines under Adding a Line to a 

Report, above. 

Adding Logo Images to Custom Reports 
Logo Images let you include your logo, a background image, or other static graphics to your repots. 

ADDING A LOGO TO A REPORT 

1 From the Standard Controls list, click on Logo Image. 
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2 Hold down the left mouse button and drag boundary of the picture. The picture frame 
will be added, and automatically selected. When the picture frame is selected, a small 
arrow will appear in the upper right corner.  

3 Click the arrow to open picture box properties: 

 

4 Click on the ellipsis button next to the Image field to open a Windows Open dialog. 

5 Navigate to the picture field you would like to add to the report and click Open. 

6 In the Sizing field, select from the following options: 

• The Normal option places the graphic in the frame without modifying it in any 
way. If the graphic is larger than the frame, it will be trimmed along the 
bottom and right edges. You can resize the frame to fit the graphic. 

• The Stretch Image option will fit the picture to the frame. If the picture is 
larger than the frame, it will be shrunk to fit. If the picture is smaller than the 
frame, it will be stretched to fit. If the dimensions of the picture are not 
proportional to the frame, the picture could be distorted when resized. 

• The Auto-Size option will adjust the size of the frame to fit the graphic file. 
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• The Center Image option is similar to Normal, except that the picture will be 
centered within the frame and trimmed on all four edges. 

• The Zoom option will resize the picture to fit the frame, while using padding 
to maintain the height to width ratio of the image so it does not distort the 
picture. The edge (horizontal or vertical) of the picture that is proportionally 
the largest in comparison to the frame will be stretched or shrunk to fit within 
the frame. The proportionally smaller edge will be padded. 

7 Anchor Vertically allows you to anchor your picture to the top or bottom of the band 
to prevent it from moving when the band height changes.  

• Select Top to anchor the picture to the top of the band. If the height of the 
band changes, the picture will not move. This is the default position. 

• Select Bottom to anchor the picture to the bottom of the band. If the height of 
the band changes, the picture will shift down to maintain its distance from the 
bottom of the band while padding at the top.  

• Select Both to anchor the picture to the top and bottom of the band. If the 
height of the band changes, the height of the picture frame will also be 
increased. 

8 See Working with Objects on the Report, later in this section, for instructions on 
positioning the logo. 

Adding Shapes to Custom Reports 
The shape tool lets you draw a variety of shapes on your report, such as circles, arrows, stars, and 
more.  

ADDING A SHAPE TO A REPORT 

1 From the Standard Controls list, click on Shape. 
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2 Hold down the left mouse button and drag the shape into the desired band on the 
report. A circle will be added in the default size: 

 

3 Click on the arrow to open shape properties: 

 

4 Set the Foreground Color, Line Width, and Anchor Vertically settings following the 
guidelines under Adding a Line to a Report, above. 

5 If your shape will have a center area (i.e., anything other than a line, bracket, or 
brace), set the color you would like for the center fill from the Fill Color field. 
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6 If you would like your shape to appear at an angle, enter an angle between 0 and 359 
in the Angle field. For example, an oval set to a 45○ angle would appear like this:  

 

7 Select the shape you would like to use from the Shape list.  

8 A Fillet option will appear if you select Rectangle, any of the Arrow options, any of 
the Polygon options, any of the Star options, Brace, or Cross. This allows you to 
round the corners on your shape. (If you select Brace, this applies to the curve of the 
horizontal line.) Enter how much rounding you would like on a scale from 1 to 100.  

9 Arrow Height and Arrow Width fields will appear if you select Arrow. Arrow Height 
controls the height of the arrow head in relation to the base. A higher number will 
result in a taller arrow head; a lower number will result in a longer base. Arrow Width 
controls how wide the base of the arrow is. A higher number results in a fatter base; a 
lower number results in a narrower base.  

10 If you select Triangle, Square, Pentagon, Hexagon, or Octagon, the selection will be 
replaced in the list with Polygon (i.e., many sided). A Number of Sides field appears 
where you can change the number of sides on your shape. Enter a number of three or 
more in the field. 

11 A Count of Star Points field appears if you select any of the Star options. Enter a 
number of three or more in the field.  

12 A Concavity field appears if you select any of the Star options. This controls the 
angle between the center of the star and the tip of the points. A higher number will 
result in a sharper angle; a lower number will result in a softer angle with a larger 
center area. 

13 Horizontal Line Width and Vertical Line Width options appear if you select Cross. 
These control the width of the horizontal and vertical lines. Enter a number between 0 
and 100 in each field. 

14 A Tips Length field appears if you select the Bracket or Brace options. This controls 
the length of the horizontal tip at the top and bottom of the shape. Enter a number 
between 1 and 100. The higher the number, the longer the tip. 

15 A Tail Length field appears if you select Brace. This controls the length of the 
horizontal line in the center of the brace. Enter a number between 1 and 100. A higher 
number will result in a longer tail. 
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16 See Working with Objects on the Report, later in this section, for instructions on 
positioning the shape. 

Adding Boxes to Custom Reports 
Boxes let you draw a frame around objects in the report. The box tool can extend across multiple 
bands, if desired. 

ADDING A BOX TO A REPORT 

1 From the Standard Controls list, click on Box. 

 

2 Hold down the left mouse button and drag boundary of the box. The box will be 
added, and automatically selected. When the box is selected, a small arrow will 
appear in the upper right corner.  

3 Click the arrow to open box properties: 
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4 Click on the Borders list to control which edges of the box display: 

 

5 A window will open with four thin boxes around the edges, depicting the borders of 
the box, and larger boxes in the center for All or None. 

6 By default, All is selected, which displays all four borders. If you would like to limit 
the borders, click on the box(es) on the edges corresponding to the lines you would 
like to turn off. 

7 Set the Border Color, Border Width, and Anchor Vertically settings following the 
guidelines under Foreground Color, Line Width, and Anchor Vertically, respectively, 
in Adding a Line to a Report, above. 

Adding Page Information to a Custom Report 
The Page Info option allows you to include information that will be gathered at the time the report is 
printed. For example, you can put a page number on each page of the report, or include the date and 
time that the report is printed. Page information is generally placed in the page header or page footer 
band. 

ADDING PAGE INFO TO A REPORT 

1 From the Standard Controls list, click on Page Info. 
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2 Hold down the left mouse button and drag the line into the desired band on the report.  

Hint 

 Unless you want the page information to print with 
every record, it is recommended that you put it in the 
header or footer of the report. 

3 The Number of Total value will be added to the report: 

 

4 When the page info is selected, it will have a small arrow in the upper right corner: 
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5 Click on the arrow. Page Info properties will open next to the field: 

 

6 The Page Info list provides the available information that can be included in the 
report. Options include: 

• Number – The page number. 

• Number of Total – The current page number next to the total pages in the report 
(e.g., page 2 of five would appear as 1/5.) 

• RomLowNum – The current page number in lowercase Roman numerals. 

• RomHiNum – The current page number in uppercase Roman numerals. 

• DateTime – The date and time the report is printed. 

• UserName – The name of the user printing the report. The user name is taken 
from the user’s Windows login. 

7 Enter the page number where you would like the information to start in the Start Page 
Number field. For example, if you do not want to print the page number on the first 
page of the report, enter 2 in the field. 

8 Click on the ellipsis next to the Format field to open the FormatString Editor. 
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9 This screen lets you control how your data will be formatted. If you have selected to 
print the date and time when the report is run, select the DateTime option and select 
the date format from the options that appear in the Standard Types list. 

10 Click OK to save your changes. You will be returned to the properties box. 

11 If you would like to anchor the page information so that it keeps is position relative to 
the top or bottom of the band if the band is resized, select Top or Bottom from the 
Anchor Vertical list. 

12 When you are satisfied with your settings, click off the properties box to save. 

13 See Working with Objects on the Report, later in this section, for instructions on 
positioning the page info. 
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Adding Summary Information to Custom Reports 
Summary information allows you to include totals in your report. They are generally added to the 
report footer band so that they will provide a summary of a selected field for all records in the report. 
Optionally, they may be added to the page footer to provide subtotals on each page. 

ADDING A SUMMARY TO YOUR REPORT 

1 Add a label to your report following the instructions under Adding Text to Your 

Report. 

2 Click once on the label. A small arrow will appear in the upper right corner of the 
label: 

 

3 Click on the arrow. A properties box will open: 
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4 Click the ellipsis next to the Summary field. The Summary Editor will open: 

 

5 Click on the arrow next to the Bound field field. A list of the fields in your display 
will open. For example, if you are creating a report on the Donations display, you 
may want to sum the Total fields for all records.  

6 Click on the arrow next to the Summary function field. A list of available 
mathematical functions that can be performed on the selected field from your display 
will open.  

7 Select the desired mathematical function. For example, to sum the Total fields for all 
records, select Sum. 
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8 If desired, click the ellipsis next to Format string to open the FormatString Editor: 

 

9 The FormatString Editor allows you to control how your data is printed. Select the 
type of data from the Category list. For example, if you are summing total donations, 
you would select Currency. The Standard Types section will update with formatting 
options that applicable to the selected category. Select the desired option from the list. 

10 Click OK to return to the Summary Editor. The Preview will update to display your 
selections. 

11 If you are performing a calculation on a numeric field, mark the Ignore Null Values 
check box. 

12 From the Summary Running radio buttons, select from the following options: 

• Select Page to have a running summary for each page of the report. When 
selected, the total will include all records on the current page. For best results, 
when selecting this option, the summary field should be in the page header or 
page footer band of the report. 

• If you are using a group band in your report, select Group to calculate the 
summary each time the group changes. For best results, when selecting this 
option, the summary field should be in the group header or group footer band of 
the report. 
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• Select Report to include all records in the report in the summary. For best results, 
when selecting this option, the summary field should be in the report header or 
report footer band of the report. 

13 Click OK to return to the properties box. 

14 Click off the properties box to save your changes.  

Working with Objects on the Report 

Once you have added your fields and standard controls to the report, you can adjust their properties and 
fine tune the size and placement of the objects. 

Sizing and Moving Objects in the Report Designer 
Sizing and moving objects in the custom report designer is very similar to sizing and moving objects 
in the display designer. You select the objects by clicking on them with your mouse, then drag to 
resize or move the object. 

There are also options on the Format menu to move and size objects in relation to each other.  

SIZING AND MOVING OBJECTS WITH THE MOUSE 

1 If you would like to change the size of an object, click on it to select it. Bounding 
boxes will appear around the edges of the field: 

 

2 Hover your mouse over the box.  It will change to a two headed arrow.   

3 Click and drag to resize the object. 

4 If you would like to move the object, click on the object to select it.  

5 Hover your mouse anywhere over the object other than the bounding box. The mouse 
will change to a four headed arrow: 

 

6 Click and drag the object to the desired position. 
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SIZING AND MOVING OBJECTS FROM THE MENU 

1 If you would like to align the edges of multiple objects in the report, select the objects 
and select Align from the Format menu. Select the desired option following the 
guidelines under Menu in the Exploring the Screen, earlier in this chapter. 

2 If you would like to resize objects in relation to other objects (for example, make all 
of your fields the same width), select the objects and select Make Same Size from the 
Format menu. Select the desired option following the guidelines under Menu in the 
Exploring the Screen, earlier in this chapter. 

3 If you would like to adjust the spacing of objects so they are either closer together or 
further apart, select the objects and select either Adjust Horizontal Spacing or Adjust 
Vertical Spacing from the Format menu. Select the desired option following the 
guidelines under Menu in the Exploring the Screen, earlier in this chapter. 

4 If you would like to center an object in the report, select the object and select Center 
in Form from the Format menu. Select the desired option following the guidelines 
under Menu in the Exploring the Screen, earlier in this chapter. 

Changing the Appearance of Objects in the Report 
The menu and toolbar give you options for changing the appearance of objects on your report. You 
can select the font, fore ground and background color, and alignment of text from the menu or 
toolbar. Refer to the Exploring the Screen section, earlier in this chapter, for details on the available 
options.  
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Previewing Reports in the Designer 
As you work with the objects in your report, you can preview the report to verify that the report is 
easy to read and that the settings are having the desired effect. 

PREVIEWING A REPORT 

1 In the report designer, click on the Preview button below the bands: 
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2 The preview page will open: 

 

3 This will display the report exactly as it would print. 

4 To return to design mode, click the Designer button next to the Preview button.  
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Saving and Exiting Your Report 
You should periodically save your report while working in it. You also have the option to save or 
cancel the report when you exit. 

SAVING A REPORT WHILE YOU WORK 

1 From the File menu within the report designer, click Save. The first time you save the 
report, a Save Report screen will open: 

 

2 Enter a unique name for the report and click OK. You will be returned to the designer 
where you can continue working on the report. 

SAVING AND EXITING A REPORT 

1 From the File menu within the report designer, click Exit. 

2 You will be asked if you would like to save your report. Click Yes to save the 
changes or No to exit and cancel all changes. 

3 If you have clicked Yes to save the report and you have not yet named your report, 
the Save Report screen will open. 

4 Enter a unique name for the report and click OK. You will be returned to your 
display.  

Working with Existing Reports 

Once you have created your report, you can edit, delete, or print the report from the Reporting menu. 

Editing and Deleting Reports 
You can use the Manage Reports option on the Reporting menu to edit or delete an existing report. 
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EDITING REPORTS 

1 Open the display that contains the report you would like to manage. 

2 From the Reporting menu, select Manage Reports. 

3 The Manage Reports screen will open with a list of all existing reports: 

 

4 Highlight the report you would like to modify and click Edit. The report designer will 
open to the selected report. 

SAVING A COPY OF A REPORT 

1 Open the report you would like to copy. 

2 From the File menu, select Save As. The Save Report screen will open with the 
current report name. 

3 Enter a unique name for the copied report. 

DELETING A REPORT 

1 Open the display that contains the report you would like to manage. 

2 From the Reporting menu, select Manage Reports. The Manage Reports screen will 
open. 

3 Highlight the report you would like to delete and click Delete. 

4 You will be asked to confirm your decision to delete the report. 

5 Click Yes. The report will be deleted. 
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6 Click Close to exit the Manage Reports list.  

Printing Reports 
Once you have created your custom report, it can be printed from the Reporting menu. 

PRINTING A REPORT 

1 Open the display containing the report you would like to print. 

2 From the Reporting menu, select Run Report. 

3 The Run Report screen will open with a list of reports for this display: 

 

4 Select the report you would like to print and click Run. 

5 Print Preview will open for the selected report. Follow the guidelines under Printing 

Records in the previous chapter for help with printing from print preview. 
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Backing up Your Data 

It is very important that you schedule and perform regular backups of your data. This will allow you to 
restore your installation of Database Oasis in the event something happens to your computer or your 
software. Backups can be thought of a little bit like accident insurance. Chances are you will never have 
to use it, but in the event of a problem, you’ll be very happy you have it. The backup process is 
extremely easy and takes only a few seconds.  

Following are some suggestions on when to make backups: 

• You should make a backup if you are having any problems with your computer. The most 
common cause of data loss is a hard drive crash. If your computer begins to respond 
differently than usual or is making any unusual noises, you should immediately make a 
backup and copy it to an external medium, such as a CD or another computer. 

• Make a backup as you add data to your system. As you work in Database Oasis, think 
about the last time a backup was made and then think about the impact if something were 
to happen and you lost the work you’ve done since then. Many people choose to make 
daily backups. If you don’t make changes to your data every day, you may want to perform 
a backup weekly, or even less frequently. On occasions where you are adding a large 
volume of records or making a lot of changes, you may even want to make more than one 
backup in a single day. 



  Backing up Your Data 

Chapter 9 – System Maintenance  ♦  Page 342 

• You should make a backup prior to making major design changes to a display. In the event 
that you do not like the changes you have made, you can simply restore from backup to 
return to the previous version. 

Note 

 If you are using Database Oasis - Professional 
Edition, make sure that all other users are logged out 
of Database Oasis before proceeding. 

BACKING UP YOUR DATA 

1 Close out of the designer and any open displays in Database Oasis. 

2 From the Tools menu, select Backup. The Backup Database Oasis screen will open: 
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3 Click the button next to the Backup File: field to open a Windows Save dialog: 

 

4 Navigate to the location where you would like to store the backup. 

5 In the File name: field, enter a name for your backup. This should be something that 
will enable you to identify the backup file in the event you need to locate it again. For 
example, if you would like to keep archives of past backups, you may include the 
date in the name. If you prefer to only keep the latest backup, you may simply name it 
Backup and overwrite it each time. 

6 Click Save. You will return to the Backup Database Oasis screen with your file name 
and path in the Backup File field. 

7 Click okay to run the backup. A file with the name you specified and the extension 
.dat will be created in the selected location. 

Hint 

 Consider keeping a copy of the backup file in an 
external location. This will protect you in the event of 
a hard drive crash.  
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Restoring from Backup 

Once you have created a backup, you can restore that backup file to return your installation of Database 
Oasis to the state it was in when the backup was made.  

Warning! 

 Restoring from backup will overwrite the entire 
installation. If you have made any changes to displays 
or data since the backup was made, they will be lost.  

Note 

 If you are using Database Oasis - Professional 
Edition, all other users must be logged out of 
Database Oasis before proceeding. 

RESTORING A BACKUP 

1 Close out of the designer and any open displays in Database Oasis. 

2 From the Tools menu, select Restore. The Restore Database Oasis screen will open: 
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3 Click the button next to the Backup File: field to open a Windows Open dialog: 

 

This will default to the location where you stored the last backup file you created. 

4 If you have moved the backup file, or you wish to select a different backup, navigate 
to the location of the backup file. 

5 Double-click on the backup file in the box. The file name will appear in the File 
name: field. 

6 Click Open. You will return to the Restore Database Oasis screen with your file name 
and path in the Backup File field. 

7 Click okay to restore the backup. Depending on how many displays and how much 
data you have, this may take several minutes.  

8 When it is done restoring from your backup, a message will appear informing you 
that the restore from backup was completed successfully. Click OK to close the 
message. 
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Moving a Data File 

In some circumstances, you may need to change the location of your Database Oasis data file. For 
example, you may run out of space on a particular drive and need to move data to a secondary drive. 

When relocating data files, you must first move the data, then update Database Oasis’ internal reference 
to the data location. 

MOVING A DATA FILE 

1 Locate the Database Oasis data file. Database Oasis data is stored in the file 
dbmkSystem.vdb4. When Database Oasis is installed, a default data path is created. 
For operating systems prior to Windows Vista, the data is located in the path 
C:\Documents and Settings\All Users\Application Data\DBOData. In Windows Vista 
and Windows 7, the data is located in the path C:\ProgramData\DBOData\. 

Note 

 If you don't see this folder, it is usually because it is 
hidden in Windows. To unhide the folder, right click 
on your Windows Start button and select Explore 
from the menu to open Windows File Explorer. Select 
Folder Options from the Tools menu, then select the 
View tab. Make sure that the "Show hidden files and 
folders" option is selected. 

Database Oasis data is stored in the file dbmkSystem.vdb4. 

1 To move the data, simply copy the data file to the new location in Windows. 

2 The first time users log into Database Oasis after the file has been moved, the Locate 
Database Oasis Data Path screen will appear: 
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3 Click the button next to the Data Path field to open the Windows Open dialog box 
where you can navigate to the folder where the data is now stored. 

4 Click OK. 

5 Database Oasis will check to make sure there is a valid data file in the specified path. 
If there is, you will receive a message that the connection is successful. You must 
close and reopen the software to complete the connection. 

Note 

 If you are using Database Oasis Professional Edition, 
make sure that the client computers are able to access 
the new path. 
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Rebuild 

The rebuild process automatically corrects any problems that may be found in your database. You do not 
need to manually launch a rebuild. When Database Oasis opens, it scans the database for issues and 
automatically launches a rebuild in the following circumstances: 

• If the version of the software you are using is newer than the database version. In this case, 
rebuild will automatically upgrade the database.  

• If the system was not shut down properly.  

• If Database Oasis detects any other problem with your data file. 

If a rebuild is necessary, you will receive the following prompt: 

 

When you click OK, the rebuild commences. A progress bar displays as the system rebuilds each of the 
tables in the database. 

 

Once the rebuild is complete, you should be able to resume work with your installation.  

If you encounter an error that the rebuild was not able to repair, the Database Repair Needed screen will 
appear again the next time you launch the software. In this case, locate your dbmkSystem.vdb4 file as 
described under Moving a Data File, above, and attach it to an e-mail to Support@DatabaseOasis.com 
so the Database Oasis support technicians may troubleshoot the issue. 
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GGLLOOSSSSAARRYY  
Active Widow:  In Windows, the screen that currently has focus. Any work that you perform will 
impact the active window. 

Align:  To line up two or more objects. In Database Oasis, the alignment options are used to line up 
objects in the designer. 

Application:  A term used to refer to a software product. 

Backup:  (noun) A copy of all information in your software that allows you to restore the application to 
the state it was in at the time the backup was made. (verb) The act of creating a backup file. (See also 

Restore) 

Box:  In Database Oasis, an object type that allows you to draw a square around other objects for the 
purpose of grouping and organizing your display. 

Buttons:  Windows form elements that perform an action when clicked. 

Calculated Field:  An advanced type of field that displays the results of a preconfigured calculation. 
For example, a calculated field may be configured to show the sum of a selection of other fields. You 
cannot type directly in a calculated field. 

Check Box:  A field used to provide a simple true/false flag. It appears as a small square on the form. A 
mark in the box indicates a true condition. No mark indicates a false condition. 

Child Level:  A sub-display that may be added in Professional Edition. The child level allows you to 
have multiple child records linked to a single parent record. Common data may be entered once at the 
parent level instead of on each child record.  

Client Server: A software term describing a system where multiple installations (clients) daccess data 
stored in a central location (the server).  

Database:  A file that stores related information. (See also Field and Record) 

Delimiter:  A character that you have specified to denote the end of one field and the start of the next in 
an export. 

Design Element:  In Database Oasis, the objects that can be added to a display that do not contain data. 
These include boxes, labels, and logos. 
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Design Mode:  In Database Oasis, the mode of the software when you are in the designer, creating and 
modifying your displays. (See also Designer and Working Mode) 

Design Template:  A file that contains a description of the design of a display. This can be used to 
create a new display with the same design. 

Designer:  In Database Oasis, the area of the software where you can create and modify your displays. 

Displays:  A screen that has been created in Database Oasis to contain and display data.  

Double Click:  In Windows, the act of clicking your mouse button twice in rapid succession to perform 
an action. (See also Mouse) 

Drag and Drop:  A method of selecting something with your mouse and moving it to another location. 

Drop-Down Lists:  A type of field that offers a preconfigured list of options. You can populate the field 
by selecting from the list. 

Export:  The process of copying data out of one software application into a file that can be read by 
another software application. 

Field:  A container for a piece of data. For example, in an address, the city, state, and ZIP code 
information would each be stored in a separate field. (See also Record.) 

Filter:  A method defining a criterion records must meet in order to be viewable. This is used to limit 
the data you are working with to a defined subset. 

Focus:  In Windows, the currently active object or form. Interaction with the software with affect the 
item that has focus. 

Form:  In windows, a page that contains options that you interact with. For example, Properties screens 
are forms, as are each of your displays. Forms are also sometimes referred to as screens or windows. 

Horizontal Center:  The center of an object that is the midpoint between the top and bottom edges. 
This can be visualized as a horizontal line drawn through the middle of the object. 

Hot Key:  On a menu or object, the underlined letter in the name that is used to perform the action using 
the keyboard. Pressing the hot key while holding down the ALT key on your keyboard will activate the 
option. 

Hover:  The act of placing your mouse over an object and leaving it there until something occurs. For 
example, hovering over the edge of many objects in the designer will cause the mouse to change to a 
double headed arrow, allowing you to change the size of the object. 

Label:  A piece of text that can be added to a display to provide instructions or additional information. 

Landscape:  A page orientation that prints with the longer edge of the paper at the top. For example, 
with standard paper that is 8½ by 11 inches, landscape mode would print a page that is 11 inches wide 
by 8½ inches tall. (See also Portrait) 

Layering:  A method of controlling which object appears in front when two or more objects overlap.  

List View:  In Database Oasis, a view of your data that presents all of the records in a grid. Each column 
in the grid is a field, each row is a record. 

Logo:  In Database Oasis, a design element that allows you to add pictures to the background of your 
displays. 

Login:  The process of entering a user name and (typically) a password to access software. 
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Maximize Button:  On the title bar, the button that looks like this: . Clicking this will return the 
application to a maximized state. (See also Maximized, Restore Button, and Title Bar) 

Maximized:  In Windows, when a window is at the maximum size, usually filling your monitor. The 
Database Oasis window cannot be moved or sized when maximized. 

Menu:  A list of options that can be performed by clicking on them. For example, the Tools menu 
provides access to the Backup and Restore features. 

Minimize Button:  The button on the title bar that looks like this: . In Database Oasis, this button 
can be found on the main window’s title bar. Clicking this will remove Database Oasis from view. It can 
be accessed again from your Window taskbar. (See also Title Bar) 

Mouse:  In Windows a tool that allows you to manipulate a pointer:  on the screen in order to interact 
with visual elements on the screen. 

Navigation Pane:  In Database Oasis, a bar that appears on the left side of your screen in working 
mode. It is used to provide quick access to commonly used features. 

Numeric Field:  A type of field that can only contain numbers. 

Parent Level:  A display that may be added in Professional Edition that has one or more child levels. 
Data from records at the parent level is shared with any linked child records. 

Picture Field:  A type of field that allows you to have record-specific pictures. 

Pointer:  In Windows, a visual representation of the mouse that is used to interact with software.  

Portrait:  When printing, the standard page orientation that prints with the shorter edge of the paper at 
the top. For example, with standard paper that is 8½ by 11 inches, portrait mode would print a page that 
is 8½ inches wide by 11 inches tall. (See also Landscape) 

Properties:  Settings that allow you to control the look or behavior of an object or area of the software. 

Radio Buttons:  A set of options represented by small circles. A mark in a circle indicates it is selected. 
Only one radio button can be selected at a time. 

Record:  A collection of related fields. In Database Oasis, each page of a display represents one record. 
(See also Fields) 

Relational Databases: A database that links tables together by a common value. This is used when 
multiple records share common information. The common data is stored in what is known as a “Parent” 
record and shared across one or more related “Child” records.  

Restore Button: This button will appear on the title bar when a window is maximized: . Clicking it 
will enable you to move and size the window. (See also Title Bar, Maximize Button, and Maximize) 

Restore:  The act of overwriting an installation with a previously backed up copy of the data. (See also 

Backup) 

Screen:  See Form 

Server:  The installation of Database Oasis where the data is installed. 

Size:  (noun) The dimensions of an object. (verb) The act of changing the size of an object by clicking 
and dragging. 

Sort:  An option to define the order in which records should be presented. 



  Glossary 

Glossary  ♦  Page 352 

Tab Order:  The order in which your cursor will move through objects when you press the Tab button 
on your keyboard. In displays, the default tab order is left to right, top to bottom unless otherwise 
specified in the designer. 

Taskbar:  In Windows, the bar at the bottom of the screen that contains the Start button and buttons for 
any software applications that are currently open. 

Template:  See Design Template 

Text Field:  The most common type of field. Text fields can contain any type of data. (See also Field) 

Tiled:  An object that is repeated within a particular space. For example, a graphic used as wallpaper in 
Database Oasis will repeat to fill the display. 

Title Bar:  The band at the very top of a form. This contains the name of the form and gives you options 
for sizing, moving, and closing the form. (See also Maximize Button, Minimize Button, and Restore 

Button) 

Tools Pane:  In the Designer, the pane at the left side of the screen that gives you quick access to the 
most commonly used functionality. 

Tooltips:  In Windows, text that appears when you hover your mouse over an object providing 
additional information about the option. (See also Hover and Mouse) 

Vertical Center:  The center of an object that is the midpoint between the left and right edges. This can 
be visualized as a vertical line drawn through the middle of the object. 

Wallpaper:  In Database Oasis, a tiled picture that appears as the background of a display. (See also 

Tiled) 

Window:  See Form 

Windows®:  The Microsoft operating system that provides a graphical interface for working with your 
software. 

Working Mode:  In Database Oasis, the mode of the software where you interact with the data in your 
displays. This includes all areas of the application with the exception of the designer. (See also Design 

Mode) 
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